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1 Introduction
1 Introduction

1.1 Target group

This documentation is aimed at users with the following knowledge and skills:

 Advanced knowledge of the robot controller system

 Advanced knowledge of bus technologies

1.2 Representation of warnings and notes

Safety These warnings are relevant to safety and must be observed.

This warning draws attention to procedures which serve to prevent or remedy 
emergencies or malfunctions: 

Hints These notices serve to make your work easier or contain references to further 
information.

1.3 Trademarks

Windows is a trademark of Microsoft Corporation.

Pentium is a trademark of Intel Corporation.

Step 7 is a trademark of Siemens AG.

PC WORX is a trademark of Phoenix Contact.

 

t

t

For optimal use of our products, we recommend that our customers 
take part in a course of training at KUKA College. Information about 
the training program can be found at www.kuka.com or can be ob-

tained directly from our subsidiaries.

These warnings mean that it is certain or highly probable 
that death or severe injuries will occur, if no precautions 

are taken.

These warnings mean that death or severe injuries may 
occur, if no precautions are taken.

These warnings mean that minor injuries may occur, if 
no precautions are taken.

These warnings mean that damage to property may oc-
cur, if no precautions are taken.

These warnings contain references to safety-relevant information or 
general safety measures. 
These warnings do not refer to individual hazards or individual pre-

cautionary measures.

Procedures marked with this warning must be followed 
exactly.

Tip to make your work easier or reference to further information.
9 / 185Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



10 / 185

WorkVisual 4.0
1.4 Licenses

This KUKA software product uses open-source software. The licensing terms 
are displayed during installation of the KUKA software product.

1.5 Terms used

Term Description

CK Customer-built Kinematics

DTM Device Type Manager

KCP KUKA Control Panel

General name for KUKA teach pendants

KLI KUKA Line Interface

The KLI is the Ethernet interface of the robot 
controller for external communication. It is a 
physical interface and can contain multiple 
virtual interfaces. The KLI is configured in the 
KUKA System Software.

KRL KUKA robot programming language (KUKA 
Robot Language)

KSI KUKA Service Interface

Interface on the CSP on the control cabinet

The WorkVisual PC can either connect to the 
robot controller via the KLI or it can be 
plugged into the KSI.

KSS KUKA System Software

KUKA smartHMI Name of the graphical user interface for the 
(V)KR C4 robot controller

KUKA smartPAD Name of the KCP for the (V)KR C4 robot con-
troller

OPS Offline Programming System

Also called “Office PC”.

Safety options Generic term for options which make it possi-
ble to configure additional safe monitoring 
functions in addition to the standard safety 
functions. 

Example: SafeOperation
Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



2 Product description
2 Product description

2.1 Overview of WorkVisual

The WorkVisual software package is the engineering environment for KR C4 
controlled robotic cells. It offers the following functionalities:

 Configuring and connecting field buses

 Programming robots offline

 Configuring machine data

 Configuring RoboTeams offline

 Editing the safety configuration

 Editing TOOL and BASE coordinate systems

 Defining robot cells online

 Transferring projects to the robot controller

 Loading projects from the robot controller

 Comparing a project with another project and accepting differences where 
necessary

 Managing long texts

 Managing option packages

 Diagnostic functionality

 Online display of system information about the robot controller

 Configuring traces, starting recordings, evaluating traces (with the oscillo-
scope)

 Editing the file system of the robot controller online

 Program debugging

2

 

t

 

s

Fig. 2-1: WorkVisual graphical user interface
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2.2 Intended use of WorkVisual

Use The WorkVisual software package is intended exclusively for the configura-
tion, programming and diagnosis of a KUKA industrial robot or customer-spe-
cific kinematic system.

Each version of the WorkVisual software package may be operated exclusive-
ly in accordance with the specified system requirements.

Misuse Any use or application deviating from the intended use is deemed to be imper-
missible misuse. KUKA Roboter GmbH is not liable for any damage resulting 
from such misuse. The risk lies entirely with the user.

Examples of such misuse include:

 Configuration of a kinematic system that is neither a KUKA industrial robot 
nor a customer-specific kinematic system

 Operation of WorkVisual not in accordance with the specified system re-
quirements
Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



3 Safety
3 Safety

This documentation contains safety instructions which refer specifically to the 
software described here. The fundamental safety information for the industrial 
robot can be found in the “Safety” chapter of the Operating and Programming 
Instructions for System Integrators or the Operating and Programming Instruc-
tions for End Users.

 

f

t

y

The “Safety” chapter in the operating and programming instructions 
of the KUKA System Software (KSS) must be observed. Death to per-
sons, severe injuries or considerable damage to property may other-

wise result.

WorkVisual can be used with write access to modify out-
puts in the robot controller, without this being noticed by 

any persons located inside the system.
In the test modes, such access is not permitted. Outputs of the robot control-
ler must not be modified using WorkVisual (“Single Point of Control” princi-
ple)! Death to persons, severe injuries or considerable damage to property 
may otherwise result.

WorkVisual can be used with write access to modify pro-
grams, I/O assignments, signal declarations and other 

parameters in the robot controller. The following applies here:
New or modified programs must always be tested first in Manual Reduced 
Velocity mode (T1). 
After modifications to the industrial robot, existing programs must always be 
tested first in Manual Reduced Velocity mode (T1). This applies to all com-
ponents of the industrial robot and includes modifications to the software and 
configuration settings. In particular, this also applies when a WorkVisual proj-
ect has been activated on the robot controller. 

After importing a safety configuration or parts thereof, the 
safety configuration must be checked! If this is not done, 

this can lead to the possibility of the robot being operated with incorrect data 
when the project is transferred to the real robot controller. Death to persons, 
severe injuries or considerable damage to property may result.

When activating a project on the KUKA smartHMI, an 
overview is displayed of the changes which will be made 

in comparison to the project that is still active on the robot controller.
If changes are listed in the overview under the heading Safety-relevant 
communication parameters, this means that the behavior of the Emergen-
cy Stop and “Operator safety” signal may have changed compared with the 
previous project. 
After activation of the project, the Emergency Stop and the “Operator safety” 
signal must be checked for safe functioning. If the project is activated on sev-
eral robot controllers, this check must be carried out for every robot control-
ler. Failure to carry out this check may result in death to persons, severe 
injuries or considerable damage to property.

After activation of a project on the robot controller, the 
safety configuration must be checked there! If this is not 

done, the robot will possibly be operated with incorrect data. Death, injuries 
or damage to property may result.
 (>>> 13.6 "Checking the safety configuration of the robot controller" 
Page 144)
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If the activation of a project fails, an error message is dis-
played in WorkVisual. In this case, one of the following 

measures must be carried out:

 Either: Activate a project again (the same one or a different one).

 Or: Reboot the robot controller with a cold restart.
Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



4 Installation
4 Installation

4.1 PC system requirements

Hardware Minimum requirements

 PC with Pentium IV processor, min. 1500 MHz

 2 GB RAM

 200 MB free hard disk space

 DirectX-compatible graphics card with a resolution of 1024x768 pixels

Recommended specifications

 PC with Pentium IV processor or higher and 2500 MHz

 4 GB RAM

 1 GB free hard disk space

 DirectX-compatible graphics card with a resolution of 1280x1024 pixels

Software  Windows 7

Both the 32-bit version and the 64-bit version can be used.

If Multiprog is to be interfaced with WorkVisual:

 KUKA.PLC Multiprog 5-35 4.1 must be installed.

 Multiprog must be licensed.

4.2 System requirements, robot controller

Software  KUKA System Software 8.2, 8.3 or 8.4

 Or VW System Software 8.2 or 8.3

4.3 Installing WorkVisual

Precondition  Local administrator rights

Procedure 1. Start the program setup.exe.

2. If the following components are not yet installed on the PC, an installation 
wizard opens:

 .NET Framework 2.0, 3.0 and 3.5

Follow the instructions in the installation wizard. .NET Framework is in-
stalled.

3. If the following component is not yet installed on the PC, an installation 
wizard opens:

 SQL Server Compact 3.5

Follow the instructions in the installation wizard. SQL Server Compact 3.5 
is installed.

4. If the following components are not yet installed on the PC, an installation 
wizard opens:

 Visual C++ Runtime Libraries

 WinPcap

Follow the instructions in the installation wizard. Visual C++ Runtime Li-
braries and/or WinPcap is installed.

5. The WorkVisual […] Setup window opens. Click on Next.

6. Accept the license agreement and click on Next.

7. Click on the desired installation type. 

4

 

s

t

t
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 (>>>  "Installation types" Page 16)

8. The Custom Setup window opens.

a. If required, select a different installation directory with Browse.... If 
Browse… is grayed out: select the level WorkVisual Development 
Environment in the tree. Browse… is then enabled. 

b. Select the desired languages in the tree. Only those languages that 
are installed here are available later for switching languages on the 
user interface.

c. Continue with Next.

9. Click on Install. WorkVisual is installed.

10. Once installation is completed, click on Finish to close the installation wiz-
ard.

Installation types

Only those languages that are installed are available later for switching lan-
guages on the user interface. 

Default directory: C:\Program Files (x86)\KUKA\WorkVisual […]

Only carry out step 8 if the type Custom has been selected.
Otherwise, continue with step 9.

Fig. 4-1: Custom Setup window

Icon Description

Will be installed.

Will be installed, including subelements (not relevant 
for language selection)

Will not be installed.

Type Installation directory Languages

Typical Default directory English and the language 
of the operating system 
are installed. 

Custom Selectable Selectable from list

Complete Default directory All are installed
Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



4 Installation
4.4 Uninstalling WorkVisual

Precondition  Local administrator rights

 The setting Show hidden files, folders and drives is activated in Win-
dows Explorer.

Procedure 1. In the Windows Start menu, delete the entry WorkVisual […] under Con-
trol Panel > Remove Program.

2. Delete the WorkVisual Projects folder in the directory C:\Us-
er\Username\My Documents.

3. In the directory C:\ProgramData\KUKA Roboter GmbH, delete the folders 
DeviceDescriptions and WorkVisual.

It is advisable to archive all relevant data before uninstalling a soft-
ware package.

The remaining steps are only necessary if the entire user configura-
tion is to be deleted.
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5 Graphical user interface

5.1 Overview of the graphical user interface

Not all elements on the graphical user interface are visible by default, but they 
can be shown or hidden as required.

There are other windows and editors available in addition to those shown here. 
These can be displayed via the Window and Editors menus.

 

 

s

Fig. 5-1: Overview of the graphical user interface

Item Description

1 Menu bar

2 Button bars

 (>>> 5.5 "Displaying/hiding buttons" Page 23)

 (>>> 5.6 "Button bar" Page 23)

3 Editor area

If an editor is open, it is displayed here. More than one editor can 
be open simultaneously – as shown here in the example. In this 
case, they are stacked one on top of the other and can be selected 
via tabs.

4 Help button

5 Project structure window

 (>>> 5.8 "Project structure window" Page 26)
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5.2 Displaying/hiding windows

Procedure 1. Select the menu item Window. A list of available windows opens.

2. Click on a window in the list in order to display or hide it on the graphical 
user interface.

5.3 Repositioning the windows

Precondition  The desired window is displayed on the graphical user interface.

Procedure Free positioning of windows:

1. Right-click in the title bar of the window. A context menu is opened.

2. Select the option Floating.

3. Grip the window by the title bar and move it to the desired position on the 
graphical user interface.

If the mouse pointer is positioned over the edges or corners of the window, ar-
rows appear which can be dragged to make the window larger or smaller.

Fixed positioning of windows:

1. Right-click in the title bar of the window. A context menu is opened.

2. Select the option Dockable.

3. Grip the window by the title bar and move it to the desired position on the 
graphical user interface. 

 Anchor points are displayed at the right, left, top and bottom of the user 
interface.

 If the window is moved over another fixed window, an anchor cross is 
displayed.

 (>>>  "Anchor cross" Page 21)

4. Drag the window onto an anchor point or the cross. The window is now an-
chored.

Automatic hiding and displaying of anchored windows:

1. Right-click in the title bar of the window. A context menu is opened.

2. Select the option Auto-Hide. The window is hidden. A tab with the name 
of the window remains at the edge of the user interface.

6 Catalogs window

All inserted catalogs are displayed in this window. The elements in 
the catalogs can be inserted on the Hardware or Geometry tabs 
in the Project structure window.

7 Workspaces window

 (>>> 5.4 "Displaying different views of the user interface" 
Page 22)

8 Messages window

 (>>> 5.7 "Messages window" Page 26)

9 Properties window

If an object is selected, its properties are displayed in this window. 
The properties can be changed. Individual properties in gray boxes 
cannot be changed.

10 WorkVisual project analysis icon

 (>>> 14.1 "Project analysis" Page 149)

Item Description
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3. To show the window again, move the mouse pointer over the tab.

4. To hide the window again, move the mouse pointer off the window. If nec-
essary, click on an area outside the window.

The Auto-Hide option creates more space for working in other areas of the 
user interface. Nonetheless, the window can still be quickly shown again at 
any time.

There is a pin symbol in the title bar of the window.

 Alternatively, Auto-Hide can also be activated or deactivated by clicking 
on this pin symbol. 

Anchor cross If a window is moved over another fixed window, an anchor cross is displayed.

Depending on which side of the anchor cross the window is dragged, it is then 
anchored on this side of the previously window.

If the window is dragged over to the center of the anchor cross, both windows 
are anchored one on top of the other. Tabs are displayed underneath the win-
dows, making it possible to switch between windows.

Fig. 5-2: Pin symbol

Fig. 5-3: Anchor cross
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To move windows that are anchored one on top of the other:

 Dragging on a tab moves only the corresponding window.

 Dragging on the title bar moves the whole stack of windows.

5.4 Displaying different views of the user interface

Description The WorkVisual user interface can be displayed in 2 different views. These 
can be selected via the menu item View or via the Workspaces window.

The views are tailored to different types of work:

Each view can be adapted separately to the needs of the user. Examples:

 Position the button bars differently in each view.

 Hide the message window in one view and not in another.

Procedure To display the Workspaces window:

 Select the menu sequence Window > Workspaces.

To reset the current view to the default settings:

 Select the menu sequence Window > Reset active workspace.

To reset all views to the default settings:

 Select the menu sequence Window > Reset all workspaces.

Fig. 5-4: Windows anchored on top of each other

View Type of work

Configuration and 
start-up

Area for project-related work

e.g. cell configuration, I/O mapping and work 
with the KRL Editor.

Programming and 
diagnosis

Area for project-independent work

e.g. monitoring, recording and work with the 
KRC Explorer.

The functions in this view are only available 
when there is no project opened.

Fig. 5-5: “Workspaces” window
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5.5 Displaying/hiding buttons

Description The individual buttons can be added or removed. In this way, the button bar 
can be tailored to the needs of the user.

Procedure 1. Click on the arrow on the right of the button bar.

2. The menu item Add or Remove Buttons is displayed. Click on this, and 
then on the submenu item [BarName].

3. An overview of all the buttons in this bar is displayed. Click on a button in 
the overview in order to add or remove it.

5.6 Button bar

Fig. 5-6: Example: File button bar: Click on the arrow on the right

Fig. 5-7: Example: File button bar: Overview

Button Name / description

New…

Opens a new, empty project.

Open project

Opens the Project Explorer.

Save project

Saves the project.

Cut

Deletes the selected element from its original position and 
copies it to the clipboard.

Copy

Copies the selected element to the clipboard.

Paste

Inserts the cut or copied element at the selected position.

Delete

Deletes the selected element.
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Opens the Add Point dialog.

Opens a window in which an element can be selected and 
added to the tree structure. Which element is available de-
pends on what is selected in the tree structure. 

The button is only active if an element is selected on the Proj-
ect structure or Hardware tab in the Files window.

Set as active controller / Reset active controller

Sets a robot controller to active/inactive.

The button is only active if a robot controller is selected in the 
Project structure window.

Configuration proposal...

Opens a window in which WorkVisual proposes complete 
hardware configurations that match the existing kinematic sys-
tems. The user can select which proposal matches the real 
configuration and apply this configuration to the project

Undo

Undoes the last action.

Restore

Redoes the action that was undone.

Settings…

Opens a window with the hardware data.

The button is only active if a device is selected on the Hard-
ware tab in the Project structure window.

Connect with device

Establishes a connection with a field bus device.

The button is only active if the field bus master is selected on 
the Hardware tab in the Project structure window.

Disconnect from device

Terminates the connection with a field bus device.

Scan Topology…

Scans a bus.

Abort last action

Cancels certain actions, e.g. a bus scan.

The button is only active if a cancelable action is running.

Monitor

Currently without function.

Diagnosis…

Currently without function.

Perform network capture...

WorkVisual can record communication data from interfaces of 
the robot controller. This button opens the corresponding win-
dow.

Deploy…

Transfers the project to the robot controller.

Button Name / description
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Only in the Programming and diagnosis workspace:

Generate code

 (>>> 13.1 "Generating code" Page 137)

Tool/base management

Opens a graphic editor for managing the TOOL and BASE co-
ordinate systems.

 (>>> 6.24.1 "Opening tool/base management" Page 47)

Mapping editor

Opens the I/O Mapping window.

The local safety configuration of the controller

Opens the local safety configuration of the current robot con-
troller.

Drive configuration

Opens a graphic editor for adapting the drive channels.

KRL Editor

Opens the selected file in the KRL Editor.

The button is only active if a file is selected on the Files tab in 
the Project structure window which can be opened with the 
KRL Editor.

Symbol Table Editor

Opens the Symbol Table Editor window.

Cell configuration

Opens the Cell configuration window.

Help

Opens the Help.

Button Name / description

Opens the Online system information window.

 (>>> 14.6 "Displaying online system information" Page 170)

Opens the Diagnostic monitor window.

 (>>> 14.5 "Displaying diagnostic data about the robot control-
ler" Page 166)

Opens the Trace configuration window.

 (>>> 14.2.4 "“Trace configuration” window" Page 152)

Opens the Trace Analysis (Oscilloscope) window.

 (>>> 14.2.7 "“Trace Analysis” window" Page 158)

Opens the Cell definition window.

 (>>> 6.25.1 "Opening the cell definition" Page 53)

Opens the Log view window.

 (>>> 14.4 "Displaying messages and system logs of the robot 
controller" Page 163)

Establishes a connection to the working directory of the real 
robot controller.

 (>>> 12.6.1 "Opening the working directory in the KRC Ex-
plorer" Page 126)

Button Name / description
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The following buttons are only available when an OPS is used:

 (>>> 12.7.1 "Overview of the debugging mode" Page 132)

5.7 Messages window

Description Messages are displayed here. The following options can be set in the mes-
sage window:

Language:

The desired language can be selected here.

Category:

 Message history: Displays all messages except errors relating to KRL 
code.

Messages are not automatically deleted, even if they refer to a temporary 
state that is no longer active. Messages can be deleted by right-clicking on 
them and selecting the option Delete all.

 KRL Parser: Display of errors in the KRL code of the file currently open in 
the KRL Editor window.

5.8 Project structure window

The Project structure window contains the following tabs:

Hardware The Hardware tab shows the relationship between the various devices. Here, 
the individual devices can be assigned to a robot controller.

Geometry The Geometry tab displays all the geometrical objects used in the project in a 
tree structure (kinematic systems, tools, base objects). The properties of the 
objects can be edited. 

Restores the state of the working directory of the real robot 
controller.

 (>>> 12.6.8 "Restoring the state of the robot controller" 
Page 130)

Transfers the changes in the working directory from WorkVisu-
al to the real robot controller.

 (>>> 12.6.6 "Transferring changes to the robot controller" 
Page 129)

Loads changes from the robot controller.

 (>>> 12.6.7 "Loading changes from the robot controller" 
Page 130)

Starts the debugging mode.

 (>>> 12.7.2 "Starting the debugging mode" Page 133)

Ends the debugging mode.

 (>>> 12.7.4 "Ending the debugging mode" Page 135)

Button Description

Starts the program.

Stops the program.

Resets the program.

Button Name / description
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If objects need to be linked geometrically, e.g. if a robot is to be assigned to a 
KUKA linear unit: this must be done here on the Geometry tab (Drag&Drop).

Files The Files tab contains the program and configuration files belonging to the 
project.

Coloring of file names:

 Files generated automatically (with Generate code function): gray

 Files inserted manually in WorkVisual: blue

 Files transferred to WorkVisual from the robot controller: black

5.9 Cell configuration window

Call  Select the menu sequence Editors > Cell configuration.

Description The Cell configuration window displays graphically certain geometric objects 
that are present in the project (robot controllers and kinematic systems). The 
objects can be linked together, e.g. a robot can be assigned to a robot control-
ler. This is done by clicking on one of the objects and holding down the mouse 
button. The mouse pointer is then dragged to the other object and released 
there.

If a robot is linked to a different kinematic system, the type of link to be made 
can be selected via a pop-up window, e.g. whether the robot is to stand on the 
flange of the other kinematic system (geometric relationship) or whether the 
robot is to be able to track the other kinematic system (kinematic relationship).

Fig. 5-8: Objects in the Cell configuration window

Item Description

1 The dotted blue frame indicates that the object is selected.

2 The connecting line indicates that the KL is assigned to the robot 
controller.

3 The connecting line indicates that the robot is mounted on the KL.
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5.9.1 Repositioning objects

Procedure 1. Move the mouse pointer onto the text over the object.

2. When the mouse pointer turns into a cross, click on it and drag the object 
to the desired position.

5.10 Resetting the graphical user interface

Description All the settings affecting the graphical user interface and its behavior that the 
user has made in WorkVisual can be reset to the default state (as after instal-
lation).

This includes changes to the button bars, windows that have been displayed 
or hidden, and settings made in the Options window.

Procedure 1. Select the menu sequence Window > Reset configuration.

2. Close WorkVisual and restart it.
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6.1 Starting WorkVisual

Procedure 1. Double-click on the WorkVisual icon on the desktop.

2. When WorkVisual is started for the first time, the DTM Catalog Manage-
ment is opened. Here a catalog scan must be carried out.

 (>>> 6.9.1 "Updating the DtmCatalog (Catalog Scan)" Page 32)

6.2 Opening a project

Description This procedure is used to open a project.

Projects can also be opened from older versions of WorkVisual. WorkVisual 
creates a backup copy of the older project and then converts the project. Be-
fore this happens, a dialog is displayed requesting the user to confirm the con-
version. 

Procedure 1. Select the menu sequence File > Open project. 

Or: Click on the Open project button.

2. The Project Explorer is opened. On the left, the Open project tab is se-
lected. A list of projects is displayed.

Select a project and click on Open. The project is opened.

3. Set the robot controller as the active controller.

Alternative 

procedure

1. Select the menu sequence File > Recent projects. A submenu containing 
recently opened projects is opened.

2. Select a project. The project is opened.

3. Set the robot controller as the active controller.

Projects which are located on a robot controller and have not yet been saved 
on this PC can be loaded in WorkVisual and opened there. To do this, a differ-
ent procedure must be used:

 (>>> 13.7 "Loading the project from the robot controller" Page 144)

 

t

Fig. 6-1: Project Explorer
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6.3 Creating a new project

6.3.1 Creating a new empty project

Procedure 1. Click on the New… button. The Project Explorer is opened. On the left, 
the Create project tab is selected.

2. Select the Blank project template.

3. Enter a name for the project in the File name box.

4. The default directory for projects is given in the Location box. If required, 
select a different directory.

5. Click on the New button. A new, empty project is opened.

6.3.2 Creating a project with a template

Procedure 1. Click on the New… button. The Project Explorer is opened. On the left, 
the Create project tab is selected. 

2. Select the desired template in the Available templates area of the tab.

3. Enter a name for the project in the File name box.

4. The default directory for projects is given in the Location box. If required, 
select a different directory.

5. Click on the New button. The new project is opened.

Templates The templates available for selection include:

For templates with controller:

If the real robot controller is a VKR C4 retrofit, or if certain options are used, 
this must be activated in WorkVisual.

 (>>> 6.16 "Activating additional controller settings" Page 37)

6.3.3 Creating a project on the basis of an existing project

Procedure 1. Click on the New… button. The Project Explorer is opened. On the left, 
the Create project tab is selected.

2. Select the desired project in the Available projects area of the tab.

3. Enter a name for the new project in the File name box.

4. The default directory for projects is given in the Location box. If required, 
select a different directory.

5. Click on the New button. The new project is opened.

6.4 Saving project information

Description If required, the user can assign information to the project. The following infor-
mation can be saved:

 A description

 A preview image (screenshot)

Template Description

Blank project Blank project

KR C4 project This project contains a KR C4 controller and the 
catalog KRL Templates.

VKR C4 project This project contains a VKR C4 controller and 
the catalog VW Templates.
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The following information is saved and displayed by default:

 The version

 The creation date and change date

 The current file location

 The project ID

Precondition  A project is open.

Procedure 1. Select the menu sequence Extras > Project info. The window Project 
info for ... is opened. 

2. Enter a description in the Description box (optional).

3. Click on the Insert image from file button (optional). Select an image and 
confirm with Open.

4. Click on OK. The window Project info for ... is closed and the project in-
formation is saved.

6.5 Saving the project

Description Projects have the file format WVS ("WorkVisual Solution").

A project can be saved with one of the following functions:

 Save: Saves the open project.

 Save as: This function is used to save a copy of the open project.

The open project itself is closed and remains unchanged.

Procedure for 

Save

 Select the menu sequence File > Save.

Or click on the Save project button.

Procedure for 

Save as

1. Select the menu sequence File > Save as.

The Save as window is opened. A file location for the project can be se-
lected here.

2. Enter a name in the File name box and click on the Save button.

6.6 Closing the project

Procedure  Select the menu sequence File > Close.

If changes have been made, a request for confirmation is displayed, ask-
ing if the project should be saved.

6.7 Closing WorkVisual

Procedure  Select the menu sequence File > Exit.

If a project is open, a request for confirmation is displayed, asking if the 
project should be saved.

6.8 Importing device description files

Description To be able to use a device in WorkVisual, WorkVisual requires the device de-
scription file for this device. 

Precondition  There is no project open.

The device description files must be obtained from the manufacturer 
of the devices.
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Procedure 1. Select the menu sequence File > Import / Export. A window opens.

2. Select Import device description file. and click on Next >.

3. Click on Browse… and navigate to the directory where the files are locat-
ed. Confirm with Next >. 

4. Another window opens. Select the required type in the File type box.

For devices for KUKA buses, the type EtherCAT ESI must be selected.

5. Select the file to be imported and confirm with Open.

6. Click on Finish.

7. Close the window.

The imported file is now available in the DtmCatalog.

6.9 Catalogs

6.9.1 Updating the DtmCatalog (Catalog Scan)

Description This procedure is used to update the DtmCatalog. As a rule, it only needs to 
be carried out when WorkVisual is started for the first time after installation or 
after an update.

An exception is EtherNet/IP if an EDS file was imported. After this, the catalog 
scan must be carried out.

Precondition  There is no project open.

Procedure 1. The DTM Catalog Management window opens automatically.

If necessary, it can also be opened via the menu sequence Extras > DTM 
Catalog Management....

2. Click on Search for installed DTMs. WorkVisual searches the PC for rel-
evant files. The search results are displayed.

3. Under Known DTMs, select the required files and click on the Right ar-
row button. 

If all files are to be accepted, click on the Double right arrow button.

4. The selected files are displayed under Current DTM Catalog. Click on 
OK.

Fig. 6-2: DTM Catalog Management
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6.9.2 Inserting a catalog in a project

Description The catalogs contain all the elements that are required to generate programs. 
In order to be able to use a catalog, it must first be inserted in the project.

Procedure 1. Select the menu sequence File > Catalog management.... A window 
opens. 

2. Double-click on the desired catalog in the Available catalogs area. The 
catalog is now displayed in the Project catalogs area.

3. Close the window.

The catalog has been inserted in the project. It is now available in the Cat-
alogs window.

6.9.3 Adding a catalog

Description Catalogs created using the WorkVisual catalog editor can be added to the cat-
alogs in WorkVisual.

Procedure 1. Select the menu sequence File > Catalog management.... A window 
opens. 

2. Click on the  button in the bottom left-hand corner. A window opens.

3. Select the desired catalog and click on Open.

4. Close the window. The catalog is now available in the Catalogs window.

6.9.4 Removing a catalog from the project

Procedure 1. Select the menu sequence File > Catalog management.... A window 
opens.

2. Double-click on the catalog to be removed in the Project catalogs area. 
The catalog is now displayed in the Available catalogs area.

3. Close the window.

6.9.5 Catalog descriptions (8.2)

Which catalogs are available depends on whether a robot controller with ver-
sion 8.2 or 8.3 is used.

Catalog Catalog contains ...

DtmCatalog Device description files

Note: The robot controller must already have 
been set once as the active controller in order for 
this catalog to be used.

KRL templates KRL program templates

KukaControllers Robot controllers, hardware components for 
robot controllers, safety options, PROCONOS 
option

KukaExternalAxes KUKA linear units, KUKA turn-tilt table

External Kinematics Templates:

Templates for external kinematic systems that 
are not supplied by KUKA. These templates can 
be used if the machine data belonging to the 
kinematic system are only available in the form 
of XML files.
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6.9.6 Catalog descriptions (8.3)

Which catalogs are available depends on whether a robot controller with ver-
sion 8.2 or 8.3 is used.

6.10 Inserting an element in the project

Description The procedure for inserting an element, e.g. a robot controller, is described 
separately for each individual element in this documentation. The Drag&Drop 
procedure is described.

In addition to Drag&Drop, the elements can usually also be inserted via the 
context menu. This procedure is not additionally mentioned in the individual 
descriptions, but is described here in general terms.

An element can be inserted into a project via the Project structure or Cell 
configuration window.

Procedure: 

Project structure

1. Right-click on the node in the tree structure under which the element is to 
be inserted. The type of node depends on the specific element concerned. 
The context menu is opened.

2. Select the Add… option from the context menu. A window opens. 

3. Select the desired element in the window and accept it with Add or OK.

KUKARobots[…] KUKA robots

KukaSpecialRobots KUKA robots for special applications

 Food, Foundry, Clean Room

MGU_Motor-Gear-
Unit

KUKA motor/gear units

An element from this catalog is used if a non-
KUKA external axis fitted with a KUKA motor/
gear unit is used with the real controller.

Motor_als_Kinematik KUKA motors

An element from this catalog is used if a non-
KUKA external axis fitted with a KUKA motor is 
used with the real controller.

VW Templates VW program templates

Catalog Catalog contains ...

Catalog Catalog contains ...

Options All options that are installed in WorkVisual

DtmCatalog Device description files

Note: The robot controller must already have 
been set once as the active controller in order for 
this catalog to be used.

KRL Templates KRL program templates

KukaControllers Robot controllers, hardware components for 
robot controllers, safety options, PROCONOS 
option

KukaExternal-
Kinematics[…]

KUKA linear units, KUKA positioners

KukaRobots[…] KUKA robots

VW Templates VW program templates
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Procedure: Cell 

configuration

1. Right-click in the empty area in the Cell configuration window. The con-
text menu is opened.

2. Select the Add… option from the context menu. A window with catalogs 
opens.

3. Select the catalog in which the desired element file is located.

4. Select the element and confirm with Add.

6.11 Removing an element from the project

Description Inserted elements can be removed again from all tabs in the Project structure 
window. It is also possible to remove some – but not all – of the default ele-
ments there. The tree structure itself cannot be removed.

All elements can be removed again from the Cell configuration window.

Procedure  Right-click on the element. Select Delete from the context menu.

Or:

 Select the element. Select the menu sequence Edit > Delete. 

Or:

 Select the element. Click on the Delete button in the toolbar, or press the 
Delete key on the keyboard.

6.12 Inserting a robot controller

Description One or more robot controllers can be inserted in a project.

Precondition  The catalog KukaControllers is available.

Procedure: 

Project structure

1. Select the Hardware tab in the Project structure window.

2. Select the required robot controller in the KukaControllers catalog.

3. Drag the robot controller to Cell: Hardware view on the Hardware tab.

Procedure: Cell 

configuration

1. Select the required robot controller in the KukaControllers catalog.

2. Drag the robot controller into the Cell configuration window by means of 
Drag&Drop.

If the real robot controller is a VKR C4 retrofit, or if certain options are used, 
this must be activated in WorkVisual.

 (>>> 6.16 "Activating additional controller settings" Page 37)

6.13 Setting the robot controller to active/inactive

Description Most settings, actions and configurations performed in the Configuration and 
start-up workspace are only possible if a robot controller is active. Further-
more, they apply to the currently active robot controller (e.g. settings in the 
safety configuration and I/O mappings).

Precondition  A robot controller has been added.

Procedure Setting the robot controller as the active controller:

1. Double-click on the inactive robot controller on the Hardware tab in the 
Project structure window.

If a project contains more than one robot controller, ensure that the 
correct robot controller is active.
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Or: Double-click on the inactive robot controller in the Cell configuration 
window.

2. Only if the robot controller is set to active for the first time: A window opens. 

 Firmware version box: Enter the version of the KUKA/VW System 
Software that is installed on the real robot controller: e.g. “8.2.15”.

 Number of I/Os box: Select the maximum number of inputs/outputs 
used on the robot controller.

The values can be changed subsequently. The correct values are neces-
sary for code generation and project deployment.

 (>>> 6.14 "Changing the values “Firmware version” and/or “Number of I/
Os" Page 36)

3. Click on OK to save.

Instead of double-clicking, it is also possible to right-click on the robot control-
ler. A context menu is opened. Select the option Set as active controller.

Setting the robot controller to inactive:

For a small number of actions in WorkVisual, it is necessary to set the robot 
controller to inactive. If these actions are started, a message is displayed to 
inform the user that the robot controller must first be set to inactive.

1. Save the project.

2. Double-click on the active robot controller on the Hardware tab in the 
Project structure window.

Or: Double-click on the active robot controller in the Cell configuration 
window.

Instead of double-clicking, it is also possible to right-click on the robot control-
ler. A context menu is opened. Select the option Reset active controller.

6.14 Changing the values “Firmware version” and/or “Number of I/Os

Description When the robot controller is set to active for the first time, the values Firmware 
version and Number of I/Os must be adapted or confirmed.

 (>>> 6.13 "Setting the robot controller to active/inactive" Page 35)

The values can be changed subsequently. The correct values are necessary 
for code generation and project deployment.

Procedure 1. Save the project.

2. Right-click on the robot controller on the Hardware tab in the Project 
structure window.

Or: Right-click on the robot controller in the Cell configuration window.

3. Select Controller options from the context menu. The Controller op-
tions window opens.

4. Enter the new value in the Firmware version box: e.g. “8.2.16”.

And/or: In the Number of I/Os box, select a different number.

5. Click on OK to save.

6.15 Assigning a robot to the robot controller

Precondition  The catalog containing the required robot has been inserted in the Cata-
logs window.

 The robot controller has been set as the active controller.

Procedure: 

Project structure

1. Select the Hardware tab in the Project structure window.
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2. Select the required robot in the KukaRobots[…] catalog in the Catalogs 
window.

3. Drag the robot onto the robot controller in the Hardware tab. (Not onto the 
node Unassigned active devices.)

The robot is now displayed underneath the robot controller.

Procedure: Cell 

configuration

1. Select the required robot in the KukaRobots[…] catalog in the Catalogs 
window.

2. Drag the robot onto the robot controller in the Cell configuration window. 
The robot is inserted and assigned to the robot controller.

6.16 Activating additional controller settings

Description If one of the following options is used, it must be activated and set in WorkVi-
sual:

 Transformer ((V)KR C4)

 Air conditioner ((V)KR C4)

 Fast Measurement inputs ((V)KR C4)

 Retrofit interface E2/E7 (VKR C4)

 Braking mode settings

 (>>> 6.16.1 "Braking mode settings" Page 37)

 Transfer application

 (>>> 6.16.2 "Setting the cycle time of the Transfer application" Page 38)

 Force brake test

 (>>> 6.16.3 "Force brake test" Page 39)

 Tools and bases

 (>>> 6.16.4 "Changing the number of TOOL and BASE coordinate sys-
tems" Page 39)

Precondition  The project contains a robot controller.

 Only for Fast Measurement inputs ((V)KR C4): A robot has been as-
signed to the robot controller.

Procedure 1. Select the menu sequence Editors > Additional controller settings. The 
Additional controller settings window opens.

2. Activate the check boxes for the options used or set the desired values.

3. Save the project.

6.16.1 Braking mode settings

Description The behavior of the robot’s axis brakes is defined in the Braking mode set-
tings.
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6.16.2 Setting the cycle time of the Transfer application

Description The Transfer application is used to transfer data from one field bus to anoth-
er. The cycle time of this data transfer can be set manually or automatically.

Option Description

Brakes of robot axes 
are closed at the end 
of the command

 Activated: The axis brakes of the robot are applied when the jog 
key is released.

 Deactivated: The axis brakes of the robot are not applied when the 
jog key is released.

Default setting: Activated

Brakes of all axes are 
opened/closed indi-
vidually

 Activated: The axis brakes of the robot are released and applied 
individually in axis-specific jogging.

 Deactivated: The axis brakes of the robot are released and ap-
plied together. (All the brakes are connected to a single channel.)

Default setting: Deactivated

Brakes close during 
motion pauses

 Activated: The axis brakes of the robot are always applied togeth-
er during motion pauses in programs.

 Deactivated: The axis brakes of the robot are not applied during 
motion pauses in programs.

Default setting: Activated

Brakes of external 
axes are closed/
opened indepen-
dently of robot axes

 Activated: Mathematically coupled external axes behave like the 
robot axes.

External axes that are not mathematically coupled function inde-
pendently of the robot axes if they are controlled separately.

 Deactivated: The external axes behave like the robot axes accord-
ing to the other braking mode settings.

Default setting: Deactivated

The larger the number of mappings and the shorter the cycle time, the 
higher the CPU load will be. The maximum number of possible map-
pings and the minimum possible cycle time have been chosen to en-

sure that the maximum possible CPU load resulting from the transfer 
application only places a minor load on the system. With certain system vari-
ants and configurations, however, it is nonetheless possible for the system to 
become overloaded. It is therefore recommended at start-up to use the diag-
nostic monitor to check the CPU load arising from the transfer application.
 (>>> 14.5.3 "Diagnostic data for the transfer application module" Page 169)
If the CPU load is greater than 5%, it is recommended to activate automatic 
adaptation of the cycle time.

Fig. 6-3: Transfer application
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6.16.3 Force brake test

6.16.4 Changing the number of TOOL and BASE coordinate systems

6.17 Inserting a safety option and/or PROCONOS

Description If a safety option (e.g. SafeOperation) and/or PROCONOS is used on the real 
robot controller, these options must also be inserted into the WorkVisual proj-
ect.

Precondition  The catalog KukaControllers is available.

Procedure: 

Project structure

1. Select the Hardware tab in the Project structure window.

2. Expand the Options node in the KukaControllers catalog. 

3. Drag the option onto the Options node on the Hardware tab.

When the option has been inserted, the version number is also displayed to 
the right of the name. It is always the compatible version for the robot control-
ler.

Procedure: Cell 

configuration

1. Right-click on the robot controller in the Cell configuration window and 
select the option Add… from the context menu.

2. Select the option on the KukaControllers tab and accept it with Add. The 
option is inserted into the Project structure window.

Item Description

1 Automatic adaptation of cycle time

 Activated: The cycle time is automatically adjusted by the ro-
bot controller, but is not faster than 4 ms.

 Deactivated: The cycle time can be entered manually in the 
Cycle time box.

2 Manual setting of the cycle time

 4 … 1000 ms

Option Description

Force brake 
test

 Activated: The brake test is active.

 Deactivated: The brake test is activated if a safety op-
tion is installed and the safe monitoring is activated. In 
all other cases, the brake test is deactivated.

Option Description

Number of tools Number of TOOL coordinate systems

 16 … 128

Default value: 16

Number of bases Number of BASE coordinate systems

 32 … 128

Default value: 32
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6.18 Inserting hardware components

Description The default hardware components for the robot controller are automatically 
present under the Controller components node. 

If further components are present in the real robot controller, these must be 
added here. This can be done in one of the following ways:

 The components can be inserted individually.

 Or, for 8.3 only: WorkVisual can propose complete hardware configura-
tions, one of which can be selected. The proposal always includes the 
hardware for all robots and external kinematic systems assigned to the ro-
bot controller.

Precondition  The catalog KukaControllers is available.

Procedure Inserting an individual component

1. Select the Hardware tab in the Project structure window.

2. Select the desired component in the KukaControllers catalog.

3. Drag the component onto the Controller components node on the Hard-
ware tab.

For 8.3 only: Selecting a configuration proposal

1. Select the Hardware tab in the Project structure window.

2. Select the Controller components node and click on the Configuration 
proposal... button.

The Configuration proposal window opens. The commonest configura-
tion for this controller and the associated kinematic systems is displayed.

3. If this configuration corresponds to the real configuration, confirm with Ac-
cept. The configuration is inserted in the Controller components node.

If not, expand the Further proposals area and click on the matching con-
figuration. It is now displayed in the upper part of the window and can be 
accepted.

Configuration 

proposal

Fig. 6-4: “Configuration proposal” window
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6.19 Inserting an external axis

Preparation In order for an external axis to be inserted into the project, the file structure of 
the robot controller must be present on the Files tab in the Project structure 
window. This can be achieved as follows:

 Do not create a new project in WorkVisual, but load the initial project from 
the robot controller.

(Via File > Browse for project.)

 (>>> 13.7 "Loading the project from the robot controller" Page 144)

 Or: Transfer the project to the robot controller. Then transfer it back to 
WorkVisual via the menu sequence Extras > Comparing projects. 

 (>>> 13.8 "Comparing projects (and accepting differences)" Page 145)

Precondition  The required catalog has been inserted in the Catalogs window.

 The robot controller has been set as the active controller.

Procedure 

Project structure

1. Select the Hardware tab in the Project structure window.

2. Select the external axis in the catalog in the Catalogs window.

3. Drag the external axis onto the robot controller in the Hardware tab. (Not 
onto the node Unassigned active devices.)

The external axis is now displayed underneath the robot controller. 

4. Double-click on the external axis. The Machine data configuration editor 
is opened.

5. For 8.2 only:

In the Axis ID box in the area General axis-specific machine data, spec-
ify which drive the external axis is assigned to in the real cell.

6. If required: edit the other parameters.

 (>>>  "Editor (8.2)" Page 43)

 (>>>  "Editor (8.3)" Page 44)

7. If the external axis needs to be linked geometrically to a kinematic system: 

a. Select the Geometry tab.

b. Assign the kinematic systems to each other as required by means of 
Drag&Drop.

Example 1: If a KUKA linear unit has been added, drag the robot onto 
the linear unit.

Example 2: If a servo gun (KUKA.ServoGun package) has been added 
that is to be used on the robot flange, drag the gun onto the Flange 
Base node of the robot.

Item Description

1 The selected proposal is displayed here.

 Black text: Component that is already present under Control-
ler components and which would remain present if the pro-
posal is accepted.

 Green text: Component which would be inserted.

 Crossed-out component: Component which would be re-
moved.

2 Items 3 and 4 can be displayed or hidden by clicking on the arrow.

3 Here the proposals displayed under item 4 can be filtered. If no fil-
ter is entered, all possible configurations for this controller and the 
associated kinematic systems are displayed.

4 This box can be expanded to display the list of proposals. Click on 
a proposal to select it.
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Procedure Cell 

configuration

1. Select the catalog for the external axis in the Catalogs window.

2. Select the desired external axis.

3. Drag the external axis onto the robot controller in the Cell configuration 
window. The external axis is inserted and assigned to the robot controller.

4. Double-click on the external axis. The Machine data configuration editor 
is opened.

5. For 8.2 only:

In the Axis ID box in the area General axis-specific machine data, spec-
ify which drive the external axis is assigned to in the real cell.

6. If required: edit the other parameters.

 (>>>  "Editor (8.2)" Page 43)

 (>>>  "Editor (8.3)" Page 44)

7. If the external axis needs to be linked to a kinematic system:

a. Click on a kinematic system and hold down the mouse button.

b. Drag the mouse pointer to the other kinematic system and release the 
mouse button. A pop-up window opens. The type of link is defined 
here:

{Kinematic1} should follow {Kinematic2}: kinematic relationship

Place {Kinematic1} on flange of {Kinematic2}: geometric relation-
ship

The geometry is adapted automatically.

6.20 Editing machine data for external axes (8.2)

Description If a robot controller with version 8.2 is part of the project, only the machine data 
of external axes can be edited. 

Precondition  The robot controller has been set as the active controller.

Procedure 1. Double-click on any kinematic system on the Hardware tab in the Project 
structure window. The editor is opened.

Or: Double-click on any kinematic system in the Cell configuration win-
dow. The editor is opened.

2. In the editor, select the kinematic system that is to be edited.

3. Edit the machine data as required.

4. Save the project to accept the changes.

Depending on the firmware version of the robot controller (8.2 or 8.3), 
a different editor opens for editing machine data. If the robot controller 
has not yet been assigned a firmware version, the editor for 8.3 

opens.

The machine data must be edited using the procedure described 
here, i.e. via the editor. Direct editing of files, e.g. $machine.DAT, is 
not permitted in WorkVisual. The files are overwritten with the data 

from the editor during code generation.
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Editor (8.2)

6.21 Editing machine data (8.3)

Description Each kinematic system and each subordinate element belonging to it has its 
own editor with the respective data. A subordinate element can be an axis or 
a motor, for example. More than one editor can be open simultaneously.

Fig. 6-5: Machine data configuration editor (8.2)

Item Description

1 Here, select the kinematic system that is to be edited.

2 The product name of the selected kinematic system is displayed 
here. The box cannot be edited.

3 With one exception, this button never needs to be pressed. If an 
import is necessary, WorkVisual performs this automatically at the 
relevant time. 

Exception: If an XML file with machine data for a non-KUKA kine-
matic system has been added on the Files tab using Add exter-
nal file, then the machine data must subsequently be imported 
manually from the XML file in a second step. This is done using 
this button.

4 These boxes have no effect.

5 The machine data of the selected kinematic system are displayed 
here, sorted by axis.

6 The data belonging to each heading can be displayed or hidden by 
clicking on the arrow.

7 Motor data

The data can be displayed by clicking on the box.

Depending on the firmware version of the robot controller (8.2 or 8.3), 
a different editor opens for editing machine data. If the robot controller 
has not yet been assigned a firmware version, the editor for 8.3 

opens.
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Procedure 1. On the Hardware tab in the Project structure window, double-click on the 
element to be edited. The editor is opened.

Or: In the Cell configuration window, double-click on the element to be 
edited. The editor is opened.

2. Edit the machine data as required.

3. Save the project to accept the changes.

Editor (8.3)

The machine data must be edited using the procedure described 
here, i.e. via the editor. Direct editing of files, e.g. $machine.DAT, is 
not permitted in WorkVisual. The files are overwritten with the data 

from the editor during code generation.

Information about the individual machine data can be found in the 
documentation Configuration of Kinematic Systems.

Fig. 6-6: Machine data configuration editor (8.3)

Item Description

1 The name of the kinematic system is displayed here.

2 The parameter groups for this kinematic system are displayed 
here. Clicking on one group shows this group in the parameter dis-
play and hides all other groups. 

3 This selection box indicates which groups are currently shown in 
the parameter display. The selection list contains all the existing 
groups. The groups can be displayed or hidden using the check 
boxes.
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6.22 Comparing kinematic systems (and accepting differences)

Description A kinematic system in WorkVisual can be compared with another kinematic 
system. This may be a kinematic system in a catalog or in a different project. 
The differences are clearly listed. The user can decide for each individual dif-
ference whether to retain the state of the current kinematic system or to adopt 
the state of the other kinematic system.

Precondition  The kinematic system that is to be compared is contained in the open 
WorkVisual project.

Procedure 1. Expand the tree structure of the robot controller on the Hardware tab in 
the Project structure window.

2. Right-click on the kinematic system and select Compare kinematic ma-
chines. Then select the desired option:

 From open Catalog: if the kinematic system to be compared is in an 
open catalog. The kinematic systems are compared and the differenc-
es are displayed in an overview  (>>> Fig. 6-7 ). Continue with step 5.

 Select catalog: if the kinematic system to be compared is in a catalog 
that is not open. Continue with step 3.

 Select project: if the kinematic system to be compared is in a different 
project. Continue with step 3.

3. A window opens. Select the catalog or project in which the kinematic sys-
tem is located and click on Open.

4. Open the tree structure, select the kinematic system and click on Com-
pare. The differences between the kinematic systems are displayed in an 
overview  (>>> Fig. 6-7 ).

5. For each difference, select whether to retain the state of the current kine-
matic system or to adopt the state of the comparison kinematic system. 
This does not have to be done for all the differences at one go.

If suitable, the default selection can also be accepted.

6. Click on Merge to accept the changes.

7. Repeat steps 5 to 6 as required. This makes it possible to work through 
the different areas bit by bit.

8. Close the Compare kinematic machines window.

4 The parameter display can be filtered here. The filter refers to the 
parameter name. No distinction is made between uppercase and 
lowercase letters.

Example: If a1 is entered, only those parameters are displayed 
which have a1 or A1 in their names.

5 Parameter display (area with gray background)

The parameters are sorted by group. They can be edited. If a pa-
rameter is changed, the value is displayed in blue until the change 
is saved. In addition, the tab of the editor is then marked with an 
asterisk (not shown) until the change is saved.

6 Graphics files can be loaded here. Once a file has been loaded, a 
minus symbol is also displayed, which can be used to delete it 
again.

The graphic is shown here. Only one graphic is displayed at a time. 
If several files are loaded, a selection box is displayed for toggling 
between the graphics.

Formats: JPG, JPEG, PNG, BMP

Item Description
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Comparison The differences between the kinematic systems are displayed in an overview. 
For each difference, the user can select which state to accept. The default set-
ting is as follows:

 For all elements that are present in the kinematic system in the open proj-
ect, the state of this kinematic system is selected.

 For all elements that are not present in the kinematic system in the open 
project, the state of the comparison kinematic system is selected.

Fig. 6-7: Example: overview of differences

Item Description

1 The node for the kinematic system. The different areas are represented by subnodes. 
The nodes can be expanded to display the comparisons.

 In each line, place a check mark in the box for the value that should be transferred. 

 A check mark next to Not available means that the element will not be transferred, 
or that it will be deleted from the kinematic system if already present.

 If a check box is activated for a node, the check boxes for all subordinate elements 
are also automatically activated.

If a check box is deactivated for a node, the check boxes for all subordinated ele-
ments are also automatically deactivated.

The subordinate elements can also be edited individually, however.

 A filled-in box means: at least one of the subordinate elements is selected, but not 
all.

2 State of the kinematic system in the project that is open in WorkVisual

3 State of the comparison kinematic system
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6.23 Exporting kinematic systems to a catalog

Description This procedure can be used to export kinematic systems to a catalog. In this 
way, the kinematic systems can be used in different projects.

Precondition  A project is open.

Procedure 1. Right-click on (any) kinematic system on the Hardware tab in the Project 
structure window and select Export kinematic system from the context 
menu. A window opens.

2. All controllers and kinematic systems in the project are displayed in a tree 
structure. Activate the check boxes next to the kinematic systems that are 
to be exported. Confirm with Next >.

3. Select a file location for the catalog. The catalog ExportedKinematics-
Catalog.afc is selected by default.

4. If required, deactivate the check box next to Replace already existing ki-
nematics in catalog..

5. Click on Finish. The kinematic systems are exported.

6. If the export was successful, this is indicated by the following message in 
the Export kinematics to catalog. window: Catalog export successful.

Close the window.

6.24 Editing TOOL and BASE coordinate systems

6.24.1 Opening tool/base management

Description The Tool/base management editor can be used to create, edit and delete 
TOOL and BASE coordinate systems. The coordinate systems can also be as-
signed to a different number by means of Drag&Drop.

Objects can be created, edited and deleted in the Available tools and bases 
area. An object can contain one or more elements. These elements can be as-
signed to a number in the area of the TOOL and BASE coordinate systems by 
means of Drag&Drop.
Objects can be exported to a catalog, enabling them to be used in other proj-
ects and on other controllers.

4 Back arrow: The focus in the display jumps to the previous difference.

Collapsed nodes are automatically expanded.

5 Forward arrow: The focus in the display jumps to the next difference.

Collapsed nodes are automatically expanded.

6 Activated: Only the areas containing differences are displayed. All other areas are hid-
den.

7 Transfers the selected changes to the kinematic system in the open project.

8 Click on a marking. The focus of the display jumps to the corresponding difference.

Item Description

Changes to the TOOL and BASE coordinate system 
numbers have no effect on programs that have already 

been created and positions that have already been taught. Changing the 
number of a TOOL coordinate system can thus result in unexpected robot 
motions. If TOOL and BASE coordinate system numbers are changed, it 
must be noted that all programs containing these TOOL and BASE coordi-
nate systems must also be modified.
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Procedure  Select the menu sequence Editors > Tool/base management.

Editor

6.24.2 Configuring tool/base management

Here it is possible to set whether the message displayed when deleting TOOL 
and BASE coordinate systems should be suppressed.

Fig. 6-8: Tool/base management editor

Item Description

1 Assigned BASE coordinate system

 (>>> 6.24.3 "TOOL and BASE coordinate systems" Page 49)

2 Assigned TOOL coordinate system

 (>>> 6.24.3 "TOOL and BASE coordinate systems" Page 49)

3 The groups of TOOL and BASE coordinate systems that exist in 
this project are displayed here. Clicking on one group shows this 
group in the display and hides all other groups. 

4 This selection box indicates which groups are currently shown in 
the display. The selection list contains all the existing groups. The 
groups can be displayed or hidden using the check boxes.

5 Creates a new TOOL coordinate system on this controller.

6 Number of available TOOL coordinate systems

The number can be changed:  (>>> 6.16.4 "Changing the number 
of TOOL and BASE coordinate systems" Page 39)

7 Creates a new BASE coordinate system on this controller.

8 Number of available BASE coordinate systems

The number can be changed:  (>>> 6.16.4 "Changing the number 
of TOOL and BASE coordinate systems" Page 39)

9 Creates a new object.

An object can contain one or more elements.

10 Objects that have been created or imported in this project

The objects can be edited or deleted here.

 (>>> 6.24.4 "Objects" Page 49)
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Procedure 1. Select the menu sequence Extras > Options.... The Options window is 
opened.

2. On the left of the window, in the Tool and base management folder, se-
lect the subitem ToolBaseEditor.

The corresponding settings are now displayed on the right of the window.

3. Make the desired setting.

4. Click on OK to confirm. The setting is applied.

6.24.3 TOOL and BASE coordinate systems

Description

Procedure Create TOOL or BASE coordinate system:

1. Click on the  button. A window opens.

2. Enter a name for the coordinate system in the Name box.

3. If the data are known: open the Details box and enter the measurement 
data. In the case of TOOL coordinate systems, enter the load data as well.

4. Click on OK. The data are saved.

Edit TOOL or BASE coordinate system:

1. Double-click on the coordinate system. A window opens.

2. Modify the name and data as required.

3. Click on OK. The data are saved.

Delete TOOL or BASE coordinate system:

 Click on the  button and confirm the message with Yes. The coordinate 
system is deleted.

6.24.4 Objects

Description Elements of type FRAME (for bases and workpieces on the robot flange) and 
TCP (for tools on the robot flange and fixed tools) can be created in an object.

Fig. 6-9: TOOL coordinate system in the Tool/base management editor

1 Displays the coordinate system data

2 Deletes the coordinate system
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The type of element as well as its geometric context determine the area to 
which the element can be assigned.
Tools on the robot flange and fixed tools are assigned to the area of the TOOL 
coordinate systems. Bases and workpieces on the robot flange are assigned 
to the area of the BASE coordinate systems.

Fig. 6-10: Objects

1 Object

2 Element of type TCP

3 Element of type FRAME

4 Buttons for creating and deleting elements

5 Creates a new object

Geometric 

context

Element type 

TCP 

Element type 

FRAME 

Area assigned 

to

FLANGE Tool on the 
robot flange

Workpiece on 
the robot flange

TOOL

WORLD Fixed tool Base BASE

Fig. 6-11: Geometric context
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Procedure Create object:

1. Click on the  button. A window opens.

2. Enter a name for the object in the Object box.

3. Click on OK. The object is created.

Add an element to the object:

1. For elements of type TCP: Click on the  button. A window opens.

For elements of type FRAME: Click on the  button. A window opens.

2. Enter a name for the element in the Name box.

3. If the data are known: open the Details box and enter the measurement 
data. In the case of elements of type TCP, enter the load data as well.

4. Click on OK. The data are saved.

Delete object:

 Click on the  button. The object is deleted.

Edit element:

1. Double-click on the element. A window opens.

2. Modify the name and data as required.

3. Click on OK. The data are saved.

Delete element:

 Click on the  button. The element is deleted.

6.24.5 Exporting objects to a catalog

Description This procedure can be used to export objects to a catalog. In this way, the ob-
jects can be used in different projects and on different controllers.

Precondition  A project is open.

Fig. 6-12: Assigning the elements

Item Description

1 The icon indicates that the element is from an object. Hovering with 
the mouse over the icon displays a tool tip with the path to the ob-
ject.
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Procedure 1. Right-click on (any) object on the Geometry tab in the Project structure 
window and select Export tool from the context menu. A window opens.

2. All cells and objects in the project are displayed in a tree structure. Activate 
the check boxes next to the objects that are to be exported. Confirm with 
Next >.

3. Select a file location for the catalog. The catalog ExportedKinematics-
Catalog.afc is selected by default.

4. If required, deactivate the check box next to Replace already existing ki-
nematics in catalog..

5. Click on Finish. The objects are exported.

6. If the export was successful, this is indicated by the following message in 
the Export tool to catalog window: Catalog export successful.

Close the window.

6.24.6 Importing objects from a catalog

Precondition  The catalog with the object is inserted in the project.

Procedure 1. Select the Geometry tab in the Project structure window.

2. Depending on the desired geometric context, drag the object either onto 
the node World or onto the Flange Base on the Geometry tab.

3. Some of the elements it contains are added directly to the area of the 
TOOL and BASE coordinate systems. They are, however, not assigned 
and are thus displayed in red. Assign these elements to the desired num-
bers by means of Drag&Drop.

6.24.7 Copying and pasting measurement data

Description The measurement data of a tool or base can be copied and pasted elsewhere. 
Data can also be copied to the clipboard or pasted from it.

The data structure can be created by the user, e.g. on the basis of data from 
CAD systems. The required layout of the data structure can be seen by copy-
ing the data of a coordinate system and pasting it into a text editor.

Example

Procedure for 

copying

 Right-click on the TOOL or BASE coordinate system and select Copy 
measurement data. The data are copied to the clipboard.

Procedure for 

pasting

 Right-click on the TOOL or BASE coordinate system and select Paste. 
The data are pasted from the clipboard.

The source and target type can be different. For example, the mea-
surement data from a TOOL coordinate system can be inserted into 
a BASE coordinate system. Only the data also present in the target 

type are inserted.

{X 100.0,Y 0.0,Z 200.0,A 0.0,B 0.0,C 0.0}

{M 3.0,CM {X 200.0,Y 0.0,Z 150.0,A 0.0,B 0.0,C 0.0},J {X 0.05,Y 
0.0325,Z 0.0625}}
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6.25 Defining cells online

6.25.1 Opening the cell definition

Description Cells can be edited online in the Cell definition editor. Cells can be created, 
edited and deleted. Robot controllers can be assigned to a cell. Furthermore, 
robot controllers can also be moved to different cells by means of Drag&Drop.

Robot controllers can also be deleted from cells. In this case, the robot con-
trollers are moved back to their original cell. The same applies if a cell contain-
ing one or more robot controllers is deleted.

Precondition  Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

 Programming and diagnosis workspace

Procedure 1. Select the desired cells in the Cell view window.

2. Select the menu sequence Editors > Cell definition. The Cell definition 
window opens. The selected cells are displayed and can now be edited.

Editor

6.25.2 Configuring a cell definition

Here it is possible to set whether certain messages displayed during the defi-
nition of cells should be suppressed.

Procedure 1. Select the menu sequence Extras > Options.... The Options window is 
opened.

2. On the left of the window, in the Online workspace folder, select the subi-
tem Cell definition editor.

Deleted cells cannot be restored. If a deleted cell is required again, it 
must be created again.

Fig. 6-13: Cell definition editor

Item Description

1 Cell with robot controller

2 Buttons for editing the cell
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The corresponding settings are now displayed on the right of the window.

3. Make the desired settings.

4. Click on OK to confirm. The settings are saved.

6.25.3 Editing cells

Precondition  The Cell definition editor is open.

Procedure Create new cell:

1. Select a robot controller in a cell and drag it into the empty area. A window 
opens.

2. Enter a name for the cell and confirm it with OK. A new cell with this robot 
controller is created.

Add a robot controller to the cell:

1. Click on the  button in the cell. A window opens.

2. In the list, select the robot controller that is to be added.

3. Click on OK. The robot controller is added to the cell.

Rename cell:

1. Click on the  button in the cell. A window opens.

2. Change the name of the cell and confirm with OK. The cell is renamed.

Delete cell:

 Click on the  button in the cell. The cell is deleted and the robot control-
lers in this cell receive a new cell of their own. These cells are named by 
default with the Windows name of the robot controller.

Delete a robot controller in a cell:

1. Position the mouse pointer on the robot controller in the cell. The  button 
is displayed.

2. Click on the  button. The robot controller is deleted from the cell and re-
ceives a new cell of its own. This cells is named by default with the Win-
dows name of the robot controller.

6.26 Option packages

6.26.1 Installing an option package in WorkVisual

Description Option packages can be installed in WorkVisual. This makes it possible to in-
sert the catalog of the option package in the individual projects, if required. The 
option package is then available for use in this project.

Advantage: if a project is transferred to a number of robot controllers, the set-
tings relevant to the package only need to be carried out once in WorkVisual 
and not on each individual robot controller.

On installation, the option package is checked for compatibility and dependen-
cies. If there are conflicts, a message is displayed.

Precondition  The option package is available as a KOP file.

The KOP file is located on the CD of the option package.

 There is no project open.
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Procedure 1. Select the menu sequence Extras > Option package management.... 
The Option package management window opens.

2. Click on the Install... button. The Select the package to be installed win-
dow opens.

3. Navigate to the path where the option package is located and select it. 
Click on Open.

4. The package is installed. If the KOP file contains device description files, 
the Update catalog window opens and closes during this operation.

Once the operation has been completed, the package is displayed in the 
Installed option packages area of the Option package management 
window.

5. Only if the message The application must be restarted for the changes to take 
effect is displayed:

 Either: click on the Restart button. WorkVisual restarts.

 Or: close the Option package management window and restart 
WorkVisual later.

6. Only if the message stated in the previous step is NOT displayed: Close 
the Option package management window. 

The catalog of the option package is now available under File > Catalog man-
agement.... 

If the KOP file contains device description files, these are now available in 
WorkVisual. It is not necessary to perform a catalog scan.

6.26.2 Updating an option package

Description Only option packages which do not contain an expansion for WorkVisual (e.g. 
an additional editor) can be updated. Other option packages must first be un-
installed before the new version can be installed.

For the user, it is not apparent beforehand whether a package is updatable or 
not. The update process can be started nonetheless. If the previous version 
has to be uninstalled first, WorkVisual displays a message to this effect.

Precondition  There is no project open.

Fig. 6-14: Installed option packages
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Procedure 1. Select the menu sequence Extras > Option package management.... 
The Option package management window opens.

2. Click on the Install... button. The Select the package to be installed win-
dow opens.

3. Navigate to the path where the option package is located and select it. 
Click on Open.

4. One of the following messages is displayed. 

 Update of {0} (version: {1}) is not possible, as option package 
contains a WorkVisual add-in.
- Uninstall the option package {0} (version: {1})
- Restart WorkVisual
- Install the option package {2} (version: {3})

Confirm the message with OK. Do not continue with step 5, but unin-
stall the package. Then install the new version.

 The package is already installed. Would you like to update/down-
grade to the package "{0}" with the selected version {1}?

Confirm the message with Yes.

The package is installed. If the KOP file contains new device descrip-
tion files, the Update catalog window opens and closes during this op-
eration.

5. Close the Option package management window. 

6.26.3 Uninstalling an option package

Precondition  There is no project open.

Procedure 1. Select the menu sequence Extras > Option package management.... 
The Option package management window opens.

2. In the Installed option packages area, click on the red “X” to the right of 
the name of the package. 

3. Only if the option package is now hidden in the Installed option packag-
es area: Close the Option package management window. 

Uninstallation is now complete. No further steps are necessary.

4. Only if the message The application must be restarted for the changes to take 
effect is displayed:

 Either: click on the Restart button. WorkVisual restarts.

 Or: close the Option package management window and restart 
WorkVisual later.

If an option package that is used in a project is uninstalled and this project is 
opened again, the user is prompted to open the catalog for the option pack-
age.

If the catalog is not opened, WorkVisual displays the following warning in the 
message window: The following option packages of the project are not in-
stalled in WorkVisual: {Name}

6.26.4 Inserting an option package in a project

Description In order to be able to use an option package on the real robot controller, it must 
be inserted into the project in WorkVisual.

This action is not necessary if a device is added to the project from 
the option package. In this case, the option package is also inserted 
automatically.
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On insertion, the option package is checked for compatibility with the set con-
troller version. If the project already contains option packages, the dependen-
cies in relation to these option packages are also checked. If conflicts are 
detected during the check, a message is displayed and the insertion is abort-
ed.

Precondition  The catalog of the option package has been added to the project.

Procedure 

Project structure

1. Select the Hardware tab in the Project structure window.

2. Right-click on the Options node and select Add….

3. A window opens. Select the catalog Options.

4. Select the option package and click on the Add button.

5. A window opens. The files being added or modified are indicated in the 
window.

6. Click on OK. The window closes and the project is saved.

The option package is now displayed in the Options node.

Procedure Cell 

configuration

1. Right-click on the robot controller in the Cell configuration window and 
select Add….

2. A window opens. Select the catalog Options.

3. Select the option package and click on the Add button.

4. A window opens. The files being added or modified are indicated in the 
window.

5. Click on OK. The window closes and the project is saved.

The option package is now displayed in the Options node in the Project 
structure window.

6.26.5 Removing an option package from the project

Description Before an option package is removed, a check is carried out to see if there are 
dependencies on other option packages. If there are, a message is displayed. 
Dependent option packages will also be removed automatically.

Precondition  The robot controller has not been assigned any devices from this option 
package.

Any devices assigned must first be removed.

Procedure 1. Select the Hardware tab in the Project structure window.

2. Expand the Options node. All the option packages contained in the proj-
ect are displayed.

3. Right-click on the package to be removed and select Delete.

4. A window opens. The files being removed or modified are indicated in the 
window.

5. Click on OK. The window closes and the project is saved.

The option package is removed from the Options node.

6.26.6 Adding a device from an option package to the robot controller

Description In order to be able to use devices from the option package on the real robot 
controller, the devices must be inserted into the project in WorkVisual.

If a project containing an option package is transferred to the robot 
controller, the procedure differs from the normal deployment proce-
dure. Further information can be found in the section on project de-

ployment. 
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A device is a catalog element to which the following configurations can be as-
signed:

 Configuration of the device

 Bus configuration

 I/O connections

 Long texts

A device is e.g. a weld power source from KUKA.ArcTech.

Precondition  The catalog of the option package has been added to the project.

 Only if a device with a bus configuration and/or I/O connections is to be 
inserted:

No robot controller has been set to active.

Procedure 1. Select the Hardware tab in the Project structure window.

2. Right-click on the robot controller and select Add….

3. A window opens. Select the catalog of the option package.

4. Select the required device from the list and click on the Add button.

5. If there are already configurations assigned to the device, a message is 
displayed asking if these configurations are to be transferred to the project.

Select Yes or No as appropriate.

6. If I/O connections were transferred together with the device, the Adjust 
signal connections window is opened. 

If the signals to which the device is to be connected in accordance with its 
default settings are already mapped in the current project, this is shown in 
the Current conflicts area.

 (>>> Fig. 6-15 )

7. If signals are displayed in the Current conflicts area:

If desired, change the start addresses for the different I/O types until no 
further conflicts are displayed.

8. Either: Click on OK. Any signals remaining in the Current conflicts area 
are now overwritten with the new connections.

A message is displayed in the message window for each overwritten con-
nection. This makes it easier in the case of later changes.

Or: Click on Cancel. The device is inserted in the Project structure win-
dow, but no signal connections are adopted.

The device is now displayed underneath the robot controller.

If bus configurations have been accepted together with the device, the device 
is also displayed under the Bus structure node when the robot controller is 
set back to active.
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Adjust signal 

connections

6.26.7 Exporting a subproject

Description This procedure enables parts of projects to be exported, e.g. a device and/or 
I/O connections. Subprojects can be processed further with the KUKA.Option-
PackageEditor. The KUKA.OptionPackageEditor is a software product for 
manufacturers of technology packages and system integrators for the creation 
of option packages.

Subprojects have the file format WVPS (“WorkVisual Partial Solution”).

Precondition  A project is open.

 The robot controller has not been set as the active controller. 

Procedure 1. Select the menu sequence File > Import / Export. A window opens.

2. Select the entry Export subproject. The window is now called Export 
subproject.

Click on Next.

3. All the controllers of the project are displayed. Select the controller from 
which data is to be exported and confirm with Next.

4. A tree structure is displayed. In the tree structure, activate the check boxes 
for the elements that are to be exported. Confirm with Next.

5. Select a path for saving the subproject and click on Finish. The subproject 
is exported.

6. If the export was successful, this is indicated by the following message in 
the Export subproject window: Partial export successful.

Close the window.

6.27 Changing predefined properties of WorkVisual

6.27.1 Configuring booting and saving characteristics

Procedure 1. Select the menu sequence Extras > Options.... The Options window is 
opened.

2. On the left of the window, in the Project handling folder, select the subi-
tem Project handling.

The corresponding settings are now displayed on the right of the window.

Fig. 6-15: Adjust signal connections – Current conflicts
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3. Make the desired settings.

4. Confirm the changes made with OK.

Description Subitem Project handling:

6.27.2 Configuring keyboard shortcuts

Procedure 1. Select the menu sequence Extras > Options. The Options window is 
opened.

2. On the left of the window, in the Environment folder, select the subitem 
Keyboard. 

The corresponding settings are now displayed on the right of the window.

3. In the Commands box, select the command for which a keyboard shortcut 
is to be defined or changed.

The contents of the Command box can be filtered: 

Enter a term in the box List only commands with the following content. 
Only commands whose names contain this term are now displayed in the 
Command box.

4. Place the cursor in the New shortcut box and confirm the desired key 
combination (or individual key) on the keyboard. Examples: F8 or Ctrl+W

The keyboard shortcut is displayed in the New shortcut box.

5. Click on Assign.

6. Confirm the change with OK.

Or: If the keyboard shortcuts are already assigned, a request for confirma-
tion is displayed:

 If the keyboard shortcut is to be assigned to the new command, select 
Yes and confirm the changes with OK.

 If the keyboard shortcut is to remain assigned to the old command, se-
lect No. 

Close the window by selecting Cancel. Or delete the keyboard short-
cut from the New shortcut box using the Esc key, and enter a different 
one.

6.27.3 Changing the user interface language

Description Which languages are available here depends on which languages were in-
stalled with WorkVisual.

Procedure 1. Select the menu sequence Extras > Options. The Options window is 
opened.

2. On the left of the window, select the Localization folder.

The corresponding settings are now displayed on the right of the window.

Parameter Description

Project folder direc-
tory:

A directory can be specified here in which the 
projects are to be saved by default.

Catalog directory: This specifies the directory in which the catalogs 
are saved.

If the catalogs are moved to a different directory, 
the directory given here must be changed.

Start application Here it is possible to specify whether a new proj-
ect, the most recently opened project or no proj-
ect is offered for opening when WorkVisual is 
started.
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3. Select the desired language from the Language box. Confirm with OK.

4. Close and restart the application.

6.27.4 Configuring additional editors

Description Additional editors are configured using this procedure. These editors can be 
used to open, compare and merge files. The first editor in the list is the default 
editor.

Procedure 1. Select the menu sequence Extras > Options.... The Options window is 
opened.

2. On the left of the window, in the Additional editors folder, select the de-
sired subitem.

The corresponding settings are now displayed on the right of the window.

3. Click on the + button at the top right. A new program is added.

4. Enter the name of the program in the Name box.

5. In the File extension box, enter the file formats that are to be opened with 
the program.

6. Click on the … button next to the Program box and select the EXE file of 
the program.

7. Optionally: Enter one or more parameters in the Parameter box. The 
Right arrow button displays an explanation of the parameters.

8. Confirm the changes made with OK.

9. If the editor is to be used as the default editor: Use the Up arrow button to 
move the editor to the top of the list.

6.28 Print functions

The procedure described here can be used to print the following:

 I/O connections

 Long texts

 Safety configuration

Procedure 1. Select the menu sequence File > Print. The Print window is opened. 

2. Select the desired printer in the Printer area. If required, change the print-
er settings.

3. In the Document area, select the relevant checkboxes to indicate what 
should be printed.

4. If required, first display the print preview: To do this, click on the Preview 
button.

Close the print preview again.

5. Click on the Print button to start printing.

It is also possible to print directly from the print preview, via the button with the 
printer symbol. In this case, the standard printer is used. Changes to the print-
er settings are not possible.

Various editors are already preconfigured by default. These are not 
included in the scope of supply of WorkVisual however. They can 
therefore only be used if they have been installed beforehand.

Further information about calling an external editor using the com-
mand line can be found in the vendor’s documentation for the external 
editor.
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Description Print window, Documents area:

Check box Description

Global This function is not yet assigned.

Cell If this checkbox is activated, all the robot control-
lers belonging to this cell are automatically acti-
vated. Individual controllers can be deactivated 
again manually.

Controller […] If this checkbox is activated, all the documents 
belonging to this robot controller are automati-
cally selected for printing. Individual documents 
can be deactivated again manually.

Documents:

Connection list Prints the I/O connections defined in the I/O 
Mappings window.

Long texts If long texts have been defined in various lan-
guages, it is also possible to select which lan-
guages should be printed.

Safety configuration The printout contains a date and signature box 
and can be used as a sign-off sheet for the 
safety acceptance procedure.
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7 Safety configuration

7.1 Safety configuration in WorkVisual

The safety configuration in WorkVisual comprises the following areas:

When a project is transferred to the real robot controller, the entire safety con-
figuration is always transferred at the same time.

7.2 Editing the local safety configuration

Description A newly added robot controller is without a local safety configuration in 
WorkVisual. A robot controller without a local safety configuration can be rec-
ognized by the fact that the text of the Safety controller node on the Hard-
ware tab in the Project structure window is in italics: Safety controller

The robot controller is automatically assigned a local safety configuration in 
WorkVisual when the Local safety configuration window is opened. The ro-
bot controller is assigned a local safety configuration during code generation, 
if none has been assigned already.

The local safety configuration can be edited in WorkVisual. The changes al-
ways apply to the robot controller which is currently set as active.

Precondition  The robot controller has been set as the active controller.

 A robot has been assigned to the robot controller.

Procedure 1. Double-click on the node Safety controller on the Hardware tab in the 
Project structure window. The Local safety configuration window is 
opened.

2. If a safety option, e.g. SafeOperation, is used: 

a. On the General tab, select the Global parameters area. 

b. Here, activate the Safe monitoring check box. Only then can the 
monitoring functions be edited.

3. Edit the parameters of the safety configuration as required.

4. Close the Local safety configuration window.

7.3 Parameters of the local safety configuration

 

f

t

y

 

f

Area Description

Local safety configura-
tion

The local safety configuration comprises the 
parameters in the Local safety configuration 
window. The parameters can be edited.

Safety-relevant com-
munication parameters

These include the parameters relevant to safe 
communication within a robot network.

The safety-relevant communication parameters 
cannot be displayed or edited directly. However, 
various actions in WorkVisual have an effect on 
the safety-relevant communication parameters, 
e.g. if a RoboTeam is configured.

The standard parameters are described here. Information about pa-
rameters which refer to a particular safety option can be found in the 
documentation for the specific safety option.
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7.3.1 “General” tab (8.2)

Hardware options

Change log Every modification to the local safety configuration and every saving operation 
are automatically logged. The log is displayed here.

Machine data The machine data of the safety controller are displayed here.

Parameter Description

Customer interface Select here which interface is used:

 ProfiSafe

 SIB

 SIB, Extended SIB

 SIB with operating mode output

 SIB with operating mode output, Extend-
ed SIB

This option is available with System Software 
version 8.2.4 or higher. 

The following interfaces are available with the 
controller variant “KR C4 compact”:

 ProfiSafe

 X11

Input signal for periph-
eral contactor (US2)

 Deactivated: The peripheral contactor is not 
used. (default)

 By external PLC: The peripheral contactor is 
switched by an external PLC via input US2.

 By KRC: The peripheral contactor is 
switched in accordance with the motion en-
able. If motion enable is present, the contac-
tor is energized.

Notes:

 For robot controllers with peripheral contac-
tors and the “UL” option, this parameter must 
be set to By KRC.

 For robot controllers with no peripheral con-
tactors, this parameter has no effect. 

Operator safety 
acknowledgement

If the “Operator Safety” signal is lost and set 
again in Automatic mode, it must be acknowl-
edged before operation can be continued.

 By acknowledgement button: Acknowl-
edgement is given e.g. by an acknowledge-
ment button (situated outside the cell). 
Acknowledgement is communicated to the 
safety controller. The safety controller re-en-
ables automatic operation only after acknowl-
edgement.

 External unit: Acknowledgement is given by 
the system PLC.

It is not necessary to press the Import machine data button. There 
are currently no applications in which this is necessary.
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Communication 

parameters

The Profinet Safety ID is displayed here. This is required if the robot controller 
is used as a PROFINET device. The ID can be changed when ProfiSafe is se-
lected as the customer interface.

7.3.2 “General” tab (8.3)

Hardware options

Change log Every modification to the local safety configuration and every saving operation 
are automatically logged. The log is displayed here.

Machine data The machine data of the safety controller are displayed here.

Communication 

parameters

The Profinet Safety ID is displayed here. This is required if the robot controller 
is used as a PROFINET device. The ID can be changed when the PROFINET 
Device Stack is activated.

7.3.3 “Axis monitoring” tab (8.3)

Editable param-

eters

The following parameters can be set for each axis. It is not generally neces-
sary to change the default values, however.

Parameter Description

Customer interface Select here which interface is used:

 Automatic

 SIB with operating mode output

Input signal for 
peripheral contactor 
(US2)

 Deactivated: The peripheral contactor is not used. (Default)

 By external PLC: The peripheral contactor is switched by an exter-
nal PLC via input US2.

 By KRC: The peripheral contactor is switched in accordance with the 
motion enable. If motion enable is present, the contactor is ener-
gized.

Notes:

 For robot controllers with peripheral contactors and the “UL” option, 
this parameter must be set to By KRC.

 For robot controllers with no peripheral contactors, this parameter 
has no effect. 

The system variable $US2_VOLTAGE_ON indicates the status of the 
peripheral voltage US2:

 TRUE: Voltage is switched on.

 FALSE: Voltage is switched off.

Operator safety 
acknowledgement

If the “Operator Safety” signal is lost and set again in Automatic mode, it 
must be acknowledged before operation can be continued.

 By acknowledgement button: Acknowledgement is given e.g. by 
an acknowledgement button (situated outside the cell). Acknowl-
edgement is communicated to the safety controller. The safety con-
troller re-enables automatic operation only after acknowledgement.

 External unit: Acknowledgement is given by the system PLC.

It is not necessary to press the Import machine data button. There 
are currently no applications in which this is necessary.
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7.3.3.1 Parameter: Braking time

Description If a safety stop 1 or 2 occurs, the safety controller monitors the braking pro-
cess. Among other things, it monitors whether the axis-specific velocity re-
mains below the braking ramp. If the velocity is too high, i.e. if the braking ramp 
is violated, then the safety controller triggers a safety stop 0.

The braking ramp can be specified using the parameter Braking time.

The parameter Braking time has no effect in T1, since it refers to the axis-
specific monitoring. In T1, however, there is another (non-configurable) moni-
toring function for the Cartesian velocity on the flange. This is stricter, which is 
why the axis-specific monitoring has no effect.

Parameter Description

Braking time Duration of the monitored axis-specific braking 
ramp for safety stop 1 and safety stop 2 

Default: 1,500 ms

 (>>> 7.3.3.1 "Parameter: Braking time" 
Page 66)

Maximum velocity T1 Maximum velocity in T1

 Rotational axes: 1.00 … 100.00 °/s

Default: 30 °/s

 Linear axes: 1.00 … 1,500.00 mm/s

Default: 250 mm/s

This parameter enables a servo gun, for exam-
ple, to be calibrated in T1 with a higher velocity 
than 250 mm/s.

Note: The Cartesian velocities at the flange and 
at the TCP are monitored independently of this 
parameter and cannot exceed 250 mm/s. 

Position tolerance Tolerance for standstill monitoring in the case of 
safe operational stop. The axis may still move 
within this tolerance when a safe operational 
stop is active. 

 Rotational axes: 0.001 … 1 °

Default: 0.01 °

 Linear axes: 0.003 … 3 mm

Default: 0.1 mm

The parameter Braking time modifies the braking ramp. It does not 
modify the actual time required by the kinematic system for braking.

Only alter the default time if it is necessary to do so. This 
might be required, for example, in the case of very heavy 

machines and/or very heavy loads as these cannot stop within the default 
time.
The safety recovery technician must check whether and to what extent the 
Braking time value needs to be modified in each specific application. He 
must also check whether the modification makes additional safety measures 
necessary, e.g. installation of a gate lock. 
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Value increased If the value Braking time is increased, this has the following conse-
quences: 

The braking ramp becomes longer and flatter, i.e. monitoring is now less strict. 
The same braking process is now less likely to violate the braking ramp than 
before.

The start velocity of the axis-specific braking ramp is always 106% of the rated 
speed of the axis. The ramp falls to 10.6%. The velocity then remains constant 
for 300 ms, before falling to 0%.

Value reduced If the value “Braking time” is reduced, this has the following consequenc-
es: 

The braking ramp becomes shorter and steeper, i.e. monitoring is now stricter. 
The same braking process is now more likely to violate the braking ramp than 
before.

Braking time can be entered separately for each axis; at the moment 
of braking, however, the value used for all axes is always the highest 
value entered. 

Recommendation: for greater transparency, enter the same value for all ax-
es.

Fig. 7-1: Example: value is increased

1 Velocity profile during braking (example)

2 Braking ramp (original value Braking time)

3 Braking ramp (higher value of Braking time)

v0 Velocity of the kinematic system at the moment when braking be-
gins

t0 Start time of the braking ramp

tend End of the braking ramp

tend' End of the braking ramp with a higher value for Braking time
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7.4 Importing the safety configuration (SCG import)

Precondition  The robot controller has been set as the active controller.

Procedure 1. Select the menu sequence File > Import / Export. A window opens.

2. Select Import local safety configuration and click on Next.

3. Navigate to the path where the SCG file is located and select it. Click on 
Open.

4. Click on Finish.

5. If the configuration was imported successfully, this is indicated by a mes-
sage. Close the window.

7.5 Exporting the safety configuration (SCG export)

Precondition  The robot controller has been set as the active controller.

Procedure 1. Select the menu sequence File > Import / Export. A window opens.

2. Select Export local safety configuration and click on Next.

3. Click on Browse… and specify a directory.

4. Specify a file name, select the file type SCG and click on Save.

5. Click on Finish.

6. If the configuration was exported successfully, this is indicated by a mes-
sage. Close the window.

7.6 Importing the safety configuration (XML import)

Description Certain parts of the local safety configuration can be imported as an XML file. 
These are:

 Cell configuration

 Monitoring spaces (Cartesian spaces and/or axis spaces)

 Properties of the tools

 Global parameters

In order to generate an XML file for importing, the user has the following op-
tions:

 Export the current safety configuration of the robot controller to an XML file 
and edit it. In this way it is possible to ensure that the format of the XML 
file is correct for a subsequent import  (>>> 7.7 "Exporting the safety con-
figuration (XML export)" Page 70).

After importing a safety configuration or parts thereof, the 
safety configuration must be checked! If this is not done, 

this can lead to the possibility of the robot being operated with incorrect data 
when the project is transferred to the real robot controller. Death to persons, 
severe injuries or considerable damage to property may result.
To avoid this, the current safety configuration on the robot controller can be 
compared with the safety configuration in the SCG file.
 (>>> 7.8 "Comparing the safety configuration" Page 71)

After importing a safety configuration or parts thereof, the 
safety configuration must be checked! If this is not done, 

this can lead to the possibility of the robot being operated with incorrect data 
when the project is transferred to the real robot controller. Death to persons, 
severe injuries or considerable damage to property may result.
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 Generate the XML file on the basis of the XML schema C:\Program 
Files (x86)\KUKA\WorkVisual [Version number]\Schemes\SafetyConfigIm-
port.xsd, e.g. using a script programmed by the user.

The following points must be observed when editing the XML files:

 The XML schema defines the structure of the XML file for the import. For 
individual parameters, the XML schema allows higher values than the in-
stalled version of the safety option.

 Parameters and values that are not supported by the current safety option 
are not imported. During the import, WorkVisual generates a message to 
this effect.

Precondition  The robot controller has been set as the active controller.

 The safety option SafeOperation or SafeRangeMonitoring is used.

Procedure 1. Save the project. (Do not close.)

2. Select the menu sequence File > Import / Export. A window opens.

3. Select Import local safety configuration and click on Next >.

4. Click on Search…. Navigate to the path where the XML file is located and 
select it. Click on Open.

5. Click on Next >. In the background, the window Local safety configura-
tion is opened, if not already open.

6. If errors are present: error messages are displayed in the Import window. 
The import cannot be carried out until these errors have been eliminated. 
Rectify the errors in the XML file, repeat the XML import and save the safe-
ty configuration.

7. If no errors are present: the differences between the existing values and 
those to be imported are displayed in the Import window before the import 
is carried out.  (>>> Fig. 7-2 ).

8. Check all values.

If not all of the required safety functions are configured correctly, or if the 
wrong XML file was selected, cancel the XML import.

 Rectify the error in the XML file and repeat the XML import.

 OR: Select the correct XML file and repeat the XML import.

9. Click on Import. The data are now imported.

10. When the import is finished, this is indicated by the following message: 
The local safety configuration was imported successfully.

Close the window.

11. Check the safety configuration. The modified values are displayed in blue 
in the Local safety configuration window.

12. Save the project to accept the imported data.

It is also possible to import safety configurations in the system soft-
ware. Information about this can be found in the documentation of the 
safety options (e.g. SafeOperation).

The imported data are only accepted when the project is saved.
This also means that imported data can be discarded by closing the 
project without saving.
69 / 185Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



70 / 185

WorkVisual 4.0
Parameter 

comparison view

If the Show import column check box is active, the Import value column is 
displayed. The values contained in the XML file are displayed in this column.

7.7 Exporting the safety configuration (XML export)

Description Certain parts of the local safety configuration can be exported as an XML file. 
These are:

 Cell configuration

 Monitoring spaces (Cartesian spaces and/or axis spaces)

 Properties of the tools

 Global parameters

The XML file always contains all the parameters which are contained in the ex-
ported parts of the safety configuration.

Exporting is always possible, irrespective of whether a safety option is in-
stalled or not. However, an export only makes sense if a safety option is in-
stalled.

The current safety configuration of the robot controller is exported. If the safety 
configuration contains unsaved changes, these are also exported.

If invalid values are entered in the safety configuration, the export is aborted 
with an error message (plausibility error).

Precondition  The robot controller has been set as the active controller.

Fig. 7-2: Example: Displaying the differences

Color Meaning

Blue With this element (or its child elements), the existing value dif-
fers from the value to be imported.

Black With this element (including all its child elements), the existing 
value is identical to the value to be imported.

It is also possible to export safety configurations in the system soft-
ware. Information about this can be found in the documentation of the 
safety options (e.g. SafeOperation).
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Procedure 1. Select the menu sequence File > Import / Export. A window opens.

2. Select Export local safety configuration and click on Next.

3. Click on Browse… and specify a directory.

4. Specify a file name, select the file type XML and click on Save.

5. Click on Finish.

6. If the configuration was exported successfully, this is indicated by a mes-
sage. Close the window.

7.8 Comparing the safety configuration

Description To avoid importing an undesired safety configuration, the current safety con-
figuration on the robot controller can be compared with the safety configuration 
in the SCG file.

Procedure 1. Load the active project from the robot controller in WorkVisual.

 (>>> 13.7 "Loading the project from the robot controller" Page 144)

2. Import the safety configuration (SCG file).

 (>>> 7.4 "Importing the safety configuration (SCG import)" Page 68)

3. Export parts of the safety configuration (XML file) out of the project.

 (>>> 7.7 "Exporting the safety configuration (XML export)" Page 70)

4. Close the project. (Do not transfer to the robot controller.)

5. Reload the active project from the robot controller.

6. Import the parts of the safety configuration from step 3 into the project.

 (>>> 7.6 "Importing the safety configuration (XML import)" Page 68)

7. Compare the parts of the safety configuration with one another.

8. If the parts of the safety configuration are as required, import the safety 
configuration (SCG file) and transfer it to the robot controller.

7.9 Resetting the safety configuration

Description This procedure can be used to reset the safety configuration. This may be nec-
essary, for example, if the system software is to be changed to a version 
whose safety configuration is not compatible with the current one. In this way, 
only the safety configuration is recreated – all other settings in the project are 
retained.

When the safety configuration is reset, all settings are reset to the default set-
tings and the project is automatically saved. This process cannot be undone.

Precondition  The robot controller has not been set as the active controller.

Procedure 1. Right-click on the node Safety controller on the Hardware tab in the 
Project structure window.

2. Select Reset in the context menu.

3. Answer the request for confirmation with Yes. The safety configuration is 
reset.
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8 Field bus configuration

8.1 Overview of field buses

The following field buses can be configured with WorkVisual:

8.2 Field bus set-up

8.2.1 Overview: field bus set-up

 

 

s

 

Field bus Description

PROFINET An Ethernet-based field bus. Data exchange is carried 
out on a client-server basis. PROFINET is installed on 
the robot controller.

PROFIBUS Universal field bus which enables communication 
between devices from different manufacturers without 
special interface adaptations. Data exchange is carried 
out on a master-slave basis.

DeviceNet CAN-based field bus used primarily in automation tech-
nology. Data exchange is carried out on a master-slave 
basis.

EtherNet/IP An Ethernet-based field bus. Data exchange is carried 
out on a client-server basis. EtherNet/IP is installed on 
the robot controller.

EtherCAT An Ethernet-based field bus suitable for real-time 
requirements.

VARAN slave Field bus that can be used to establish communication 
between a VARAN controller and a KR C4 controller.

For configuration of a field bus, the documentation of the field bus is 
required.

Step Description

1 Install the device description files on the PC.

 (>>> 6.8 "Importing device description files" Page 31)

2 Insert the DTM Catalog in the Catalogs window.

 (>>> 6.9.2 "Inserting a catalog in a project" Page 33)

3 Insert the field bus master in the project.

 (>>> 8.2.2 "Inserting a field bus master in a project" Page 74)

4 Configure the field bus master.

 (>>> 8.2.3 "Configuring the field bus master" Page 74)

5 Add the devices to the bus, i.e. insert them under the field bus 
master.

 (>>> 8.2.4 "Inserting devices manually into the bus" Page 74)

Or:

 (>>> 8.2.6 "Automatically inserting devices into the bus (Bus 
Scan)" Page 75)

6 Configure the devices.

 (>>> 8.2.5 "Configuring devices" Page 75)
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8.2.2 Inserting a field bus master in a project

Precondition  The device description files are inserted in the DTM Catalog (Catalog 
Scan).

 The robot controller has been added and set as active.

Procedure 1. Expand the tree structure on the Hardware tab in the Project structure 
window until the Bus structure node is visible.

2. Select the required field bus master in the DTM Catalog window and drag 
it onto the Bus structure node. 

8.2.3 Configuring the field bus master

Precondition  The field bus master is inserted in the project.

 The robot controller has been set as the active controller.

Procedure 1. Right-click on the field bus master on the Hardware tab in the Project 
structure window.

2. Select Settings… from the context menu. A window opens with device da-
ta.

3. Set the data as required and save with OK.

8.2.4 Inserting devices manually into the bus

Precondition  The devices are inserted in the DTM Catalog.

 The field bus master is inserted in the bus structure.

 The robot controller has been set as the active controller.

Procedure 1. Expand the tree structure on the Hardware tab in the Project structure 
window until the field bus master is visible.

2. Select the required device in the DTM Catalog and drag it onto the field 
bus master.

7 Edit the field bus signals

 (>>> 8.3 "Editing field bus signals" Page 76)

8 The bus I/Os can now be mapped.

 (>>> 8.4 "Mapping the bus I/Os" Page 81)

Step Description

The following address ranges are used by default by the 
robot controller for internal purposes. IP addresses from 

this range must not therefore be assigned by the user. 

 192.168.0.0 … 192.168.0.255

 172.16.0.0 … 172.16.255.255

 172.17.0.0 … 172.17.255.255

Information about settings for particular bus systems can be found in 
the documentation for these bus systems.

The inserted device must correspond to the actual de-
vice used in reality. Substantial damage to property may 

otherwise result.
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3. If necessary, repeat step 2 for further devices.

8.2.5 Configuring devices

Precondition  The device has been added to the bus.

 The robot controller has been set as the active controller.

Procedure 1. Right-click on the device on the Hardware tab in the Project structure 
window.

2. Select Settings… from the context menu. A window with the device data 
is opened.

3. Set the data as required and save with OK.

8.2.6 Automatically inserting devices into the bus (Bus Scan)

Description The bus scan is available for Interbus and EtherCAT.

The bus devices can be inserted automatically. For this, the user can start a 
scan in WorkVisual to determine which devices are connected to the real bus. 
The corresponding devices are then inserted automatically into the bus struc-
ture in WorkVisual.

In contrast to manual insertion, this procedure is faster and less susceptible to 
error.

Precondition  The devices are inserted in the DTM Catalog.

 The field bus master is inserted in the bus structure.

 The robot controller has been set as the active controller.

 Network connection to the real robot controller

 The devices are connected to the real robot controller.

Procedure 1. Expand the tree structure of the robot controller on the Hardware tab in 
the Project structure window.

2. Right-click on the field bus master. Select the option Scan Topology… 
and then select a channel. The Topology Scan Wizard window is 
opened.

3. Click on Continue to start the scan. When the scan is completed, WorkVi-
sual displays all the devices found in the window on the left. Each device 
is represented by a number (= product code).

4. Select a device. In the window on the right, WorkVisual displays a list of 
the device description files which have the same product code.

The following address ranges are used by default by the 
robot controller for internal purposes. IP addresses from 

this range must not therefore be assigned by the user. 

 192.168.0.0 … 192.168.0.255

 172.16.0.0 … 172.16.255.255

 172.17.0.0 … 172.17.255.255

Information about settings for particular bus systems can be found in 
the documentation for these bus systems.

There are further preconditions depending on the bus system used. 
Information about this is contained in the documentation for the differ-
ent bus systems.
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5. If the list contains a number of device description files, scroll down the list 
and check if the file of the device that is actually used is selected. If a dif-
ferent file is marked, select the option Manual selection and select the 
correct file.

6. Repeat steps 4 and 5 for all devices shown.

7. Click on Continue to confirm the assignment.

8. Click on Finish to assign the devices to the field bus master.

8.3 Editing field bus signals

Description Field bus signals can be edited in WorkVisual. For example, the signal width 
can be changed or the byte order can be swapped.

Precondition  The field bus devices are configured.

Procedure 1. Select the device on the Field buses tab in the I/O Mapping window.

2. In the I/O Mapping window, click on the Edit signals at the provider but-
ton. The Signal Editor window is opened. All inputs and outputs of the de-
vice are displayed.

 (>>> 8.3.1 "Signal Editor" Page 76)

3. Edit the signals as required.

4. Click on OK to save the changes and close the Signal Editor window.

8.3.1 Signal Editor

In the Signal Editor, the inputs of the selected device are displayed on the left 
and the outputs on the right.
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Fig. 8-1: Signal Editor

Item Description

1 The left-hand column displays the original configuration of the in-
puts or outputs. Each box represents 1 bit.

2 The right-hand column can be edited and always displays the cur-
rent configuration of the inputs or outputs. Each box represents 1 
bit.

3 Signal name

 (>>> 8.3.5 "Changing signal names" Page 80)

4 Start mark for swapping

 (>>> 8.3.3 "Swapping signals (reversing the byte order)" Page 78)

5 Address at which this signal starts

6 Signal width

 (>>> 8.3.2 "Changing the bit width of signals" Page 78)

7 Address to which this bit belongs, and number of the bit

8 The bar indicates that the byte order has been swapped.

9 Boundary between memory segments

10 Data type of this signal

 (>>> 8.3.4 "Changing the data type" Page 80)
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8.3.2 Changing the bit width of signals

Description This procedure can be used to change the width of signals. Signals can be 
split or grouped. It is also possible to split signals more than once.

The signal boundaries can be moved only as far as the boundaries of the 
memory segments. Signal boundaries cannot be moved beyond the boundar-
ies of swapped ranges.

Bits that are being edited are indicated in red.

Precondition  The Signal Editor is open.

 The signals that are to be edited are not mapped.

Procedure Moving a signal boundary:

1. In the right-hand column, position the mouse pointer over the boundary 
line between 2 signals. The mouse pointer changes into a vertical double 
arrow.

2. Click and hold down the mouse button and move the mouse pointer up or 
down. The boundary line is moved.

3. Drag the boundary line to the desired position and let go.

This procedure can be used to reduce a signal down to the size of 1 bit.

Splitting a signal:

1. In the right-hand column, position the mouse pointer over a bit.

2. Click and hold down the mouse button and move the mouse pointer up or 
down. A line is displayed over the output bit. 

3. Drag the mouse pointer to another bit and let go. A line is also displayed 
over this bit. The two lines are the boundaries of the new signal.

Grouping signals:

1. In the right-hand column, position the mouse pointer over the first (or last) 
bit of a signal.

2. Click and hold down the mouse button and move the mouse pointer down 
(or up).

3. Drag the mouse pointer across a signal boundary to another signal bound-
ary and let go. The intervening signal boundary disappears. The signals 
have been grouped.

8.3.3 Swapping signals (reversing the byte order)

Description The byte order of signals can be swapped. It is possible to swap 2, 4 or 8 bytes 
at once. Sub-ranges of signals cannot be swapped. Furthermore, it is not pos-
sible to swap across the boundaries of memory segments.

The bits within a byte always remain unchanged.

The (V)KR C4 robot controller uses the Intel data format. Field bus 
signals in Motorola format must be converted to Intel. This is done by 
means of swapping.
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It makes a difference whether a range is swapped as a whole or in parts:

Precondition  The Signal Editor is open.

Procedure 1. Position the mouse pointer over a start mark for swapping. The mouse 
pointer changes into a vertical double arrow.

2. Click and hold down the mouse button. Move the mouse pointer down-
wards to the signal boundary.

3. A bar is displayed. 

 Either: Release the mouse button. The byte order has now been 
swapped.

 Or: If a larger range is to be swapped, keep moving the mouse pointer 
without letting go. A longer bar is displayed. Release the mouse but-
ton. The byte order has now been swapped.

An end mark for swapping is displayed.

To undo the swapping:

1. Position the mouse pointer over an end mark for swapping. The mouse 
pointer changes into a vertical double arrow.

2. Click and hold down the mouse button. Move the mouse pointer up to-
wards the start mark.

3. The bar disappears. The swapping has been undone. 

It is not always clear from the manufacturer’s data sheets whether a 
signal needs to be swapped or not. The signals of Siemens devices 
generally need to be swapped. The following procedure can provide 

information about whether it is necessary to swap an input:

1. Change the voltage on the input slowly and evenly.

2. Observe the values for this signal in the Analog I/O window on the KU-
KA.smartHMI.

If the values change abruptly and unevenly or in different directions, this is 
an indication that swapping is necessary.

Fig. 8-2: Example 1: Swapping the byte order

Item Description

1 Original order

2 Result of swapping the bytes in two groups (i.e. the first two bytes 
are swapped and the second two bytes are swapped separately.)

Fig. 8-3: Example 2: Swapping the byte order

Item Description

1 Original order

2 Result of swapping all the bytes at once
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8.3.4 Changing the data type

Description In the Signal Editor, the data type is displayed by an icon.

(The exact data type of a signal is displayed in the I/O Mapping window.)

The data type must changed e.g. if a signal needs to be used as an analog 
output or input but is only designated as a digital data type in the device de-
scription file.

Precondition  The Signal Editor is open.

Procedure 1. Click on the icon for the sign on the right-hand side of the input or output 
column. The icon changes. 

2. Click until the desired symbol is displayed.

8.3.5 Changing signal names

Precondition  The Signal Editor is open.

Procedure 1. Click on the name of the input or output in the right-hand column. The 
name can now be edited.

2. Enter the desired name and confirm with the Enter key.

The name must be unambiguous within the current view of the Signal Ed-
itor.

The changed name is displayed in the I/O Mapping window.

Icon Description

Integer data type with sign (depending on the length: 
SINT, INT, LINT or DINT)

Integer data type without sign (depending on the 
length: USINT, UINT, ULINT or UDINT)

Digital data type (depending on the length: BYTE, 
WORD, DWORD or LWORD)
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8.4 Mapping the bus I/Os

8.4.1 I/O Mapping window

Overview

Mapped signals are indicated by green symbols. 

Multiply mapped signals are indicated by double arrows: 

 (>>> 8.4.2 "Buttons in the I/O Mapping window" Page 82)

Tabs:

Fig. 8-4: I/O Mapping window

Item Description

1 Display of the input/output types and field bus devices. The two ar-
eas to be connected are selected on the left and right via tabs.

The signals in the areas selected here are displayed in the win-
dows lower down.

2 Display of the mapped signals.

3 Display of all signals. The inputs/outputs can be mapped here.

 (>>> 8.4.3 "Mapping input to output" Page 83)

4 This allows the two signal displays to be collapsed and expanded 
independently of one another.

5 Displays how many bits the selected signals contain.
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8.4.2 Buttons in the I/O Mapping window

Filter/ Search Some of these buttons are displayed in several places. In such cases, they re-
fer to the side of the I/O Mapping window on which they are located.

With some buttons, the tool tip changes depending on whether the signals 
they refer to are shown or hidden.

Name Description

KR C I/Os Here the analog and digital inputs/outputs of the robot 
controller are displayed. There is a KR C I/Os tab on 
the left and on the right. This makes it possible to map 
inputs and outputs of the robot controller with each 
other.

PLC These tabs are only relevant if Multiprog is used.

KR C signals Here the other signals of the robot controller are dis-
played.

Field buses Here the inputs/outputs of the field bus devices are dis-
played. There is a Field buses tab on the left and on 
the right. Only bus inputs are displayed on the left, and 
only bus outputs are displayed on the right.

From System Software version 8.3, these tabs can be 
used to map the inputs and outputs of 2 field buses.

Button Name / description

Filter inputs/Display all input signals: Shows and hides the 
inputs.

Filter outputs/Display all outputs: Shows and hides the out-
puts.

Filter dialog: The Filter signals window is opened. Enter fil-
ter criteria (name, data type and/or signal range) and click on 
the Filter button. Signals that conform to these criteria are 
displayed.

When a filter is set, the button displays a green check mark at 
bottom right. To remove a filter that has been set, click on the 
button and, in the Signals window, click on the Reset button 
and then on Filter.

Buttons above the “connected signals” window:

Search for the connected signal: Only available if a 
mapped signal is selected. 

 (>>> 8.4.7 "Searching for assigned signals" Page 86)

Button below the “all signals” window:

Search text: Displays a search box. Here it is possible to 
search the signal displays for signal names (or parts of 
names), either upwards or downwards.

When the search box is displayed, the button displays a cross 
at bottom right. To hide the search box again, click on the but-
ton.

Filter connected signals/Display all connected signals

Shows and hides the connected signals.

Filter disconnected signals/Display all unconnected sig-
nals

Shows and hides the unconnected signals.
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Mapping

Edit

8.4.3 Mapping input to output

Description This procedure is used to assign the inputs and outputs of the devices to the 
inputs and outputs of the robot controller.

By the same principle, it is also possible to map inputs and outputs of the robot 
controller to each other. (In this case, the KR C I/Os tab must be used in both 
halves of the window.)

Precondition  The robot controller has been set as the active controller.

 The bus configuration in WorkVisual corresponds to the real bus configu-
ration.

 The field bus devices are configured.

Procedure 1. Click on the Mapping editor button. The I/O Mapping window is opened.

2. On the KR C I/Os tab in the left-hand half of the window, select the area 
of the robot controller that is to be mapped, e.g. Digital inputs. 

The signals are displayed in the bottom area of the I/O Mapping window.

3. Select the device on the Field buses tab in the right-hand half of the win-
dow. 

The signals of the device are displayed in the bottom area of the I/O Map-
ping window.

4. Drag the signal of the robot controller onto the input or output of the device. 
(Or alternatively, drag the input or output of the device onto the signal of 
the robot controller.)

The signals are now mapped.

Alternative procedure for mapping:

Button Name / description

Disconnect: Disconnects the selected mapped signals. It is 
possible to select and disconnect a number of connections 
simultaneously.

Connect: Connects signals which are selected in the “all sig-
nals” display. It is possible to select a number of signals on 
both sides and connect them at one go. (Only possible if the 
same number of signals is selected on both sides.)

Button Name / description

Creates signals at the provider

Only relevant if Multiprog is used.

Edit signals at the provider

For field bus signals: opens an editor in which the bit assign-
ment of the signals can be edited.

 (>>> 8.3 "Editing field bus signals" Page 76)

Editing options are also available here for the analog inputs/
outputs of the KRC and for Multiprog signals.

 (>>> 8.4.9 "Editing analog KRC signals" Page 87)

Deletes signals at the provider

Only relevant if Multiprog is used.

Information about Multiprog is contained in the KUKA.PLC Multiprog 
documentation.
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 Select the signals to be mapped and click on the Connect button. 

 Or: Select the signals to be mapped and select the Connect option from 
the context menu.

Multiple mapping:

It is possible to select a number of signals simultaneously (on both sides) and 
connect them at one go. A further possibility is as follows: 

1. Select a number of signals on one side and one signal on the other side. 

2. Select the option Connect continuously from the context menu. The sig-
nals are connected (counting upwards), starting from the one selected sig-
nal.

8.4.4 Mapping bus inputs to bus outputs by means of I/O linking (8.2)

Description With I/O linking, a bus input can be mapped to a bus output (in the same or a 
different bus). This is done indirectly. A total of 3 mappings are required for 
this.

Procedure 1. Map the bus input to an input of the robot controller.

2. Map the robot controller input to a robot controller output.

3. Map the robot controller output to a bus output.

The input and output of the robot controller are thus multiply mapped in this 
case.

Schematic

8.4.5 Mapping bus inputs to bus outputs using the transfer application (8.3)

Description With the transfer application, a bus input can be mapped directly to one or 
more bus outputs (in the same or a different bus). For this, the Field buses 
tab is used in both halves of the window.

A maximum of 2048 bus inputs can be mapped to bus outputs. If one bus input 
is mapped to multiple bus outputs, the number of bus outputs is the determin-
ing factor.

If more than 512 bus inputs are to be mapped to bus outputs, the connections 
must be made in blocks. With block mapping, both the bus inputs and the bus 
outputs of a block must be adjacent, i.e. there must not be any gaps in be-
tween. Furthermore, the bus inputs and outputs of a block must be within one 
slot.

Example: In the PROFINET field bus, the signal names contain slots and index 
numbers. The index numbers stand for the bits, i.e. index number 0001 = bit 
1, index number 0002 = bit 2, etc. If 2 adjacent bits within the same slot are 
mapped (e.g. bit 1 and bit 2 of slot 2), this results in 1 block mapping. However, 

Fig. 8-5: Schematic: Mapping bus input to bus output
Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



8 Field bus configuration
if 2 non-adjacent bits or 2 bits from different slots are mapped (e.g. bit 4 of slot 
1 and bit 5 of slot 3), no block mapping results.

Schematic

8.4.6 Multiple mapping or reverse mapping of signals via I/O linking

Possible Signals can be multiply mapped via I/O linking. Multiply mapped signals are 

indicated in the I/O Mapping window by a double arrow: 

The following multiple mapping is possible:

 Map an input (robot controller) to an input (bus).

 Map the same input (robot controller) to one or more outputs (robot con-
troller).

The following reverse mapping is possible:

 Map an output (bus) to an input (robot controller).

Not possible The following multiple mappings are not possible:

 Map an input (robot controller) to several inputs (bus).

In System Software version 8.3 and higher, safe outputs have a yel-
low background. These outputs must not be mapped!

Fig. 8-6: Schematic: Mapping a bus input to bus outputs

It is possible to use a WorkVisual project with direct bus mappings 
with a lower System Software version. However, the mappings have 
no effect in the lower version.

Fig. 8-7: Multiple mapping possible

Fig. 8-8: Reverse mapping possible
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 Map an output (robot controller) to several outputs (bus).

8.4.7 Searching for assigned signals

Procedure 1. Select a mapped signal.

2. In the part of the window in which the signal was selected (left-hand or 
right-hand half), click on the button Searches for the connected signal.

 If a signal is mapped once: the assigned signal is now highlighted in 
the other half of the “all signals” window.

 If a signal is multiply mapped: the Search for signal window opens. 
All signals connected with the selected signal are shown. 

Select a signal and confirm with OK.

8.4.8 Grouping signals

Description 8 digital inputs or outputs of the robot controller can be grouped together to a 
signal of the data type BYTE. Grouped signals can be recognized by the name 
extension #G.

Precondition  The signals that are to be grouped are not mapped.

Procedure 1. Below the KR C I/Os tab, select 8 consecutive signals and right-click on 
them.

2. Select Group.

The signals are grouped to a signal of type BYTE. The name with the low-
est index number is taken for the new signal.

To undo the grouping:

1. Right-click on a signal with the name extension #G.

2. Select Ungroup. 

Fig. 8-9: Multiple mapping not possible

Fig. 8-10: Example: Multiply mapped signal
Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



8 Field bus configuration
Example

8.4.9 Editing analog KRC signals

Procedure 1. Select the analog signal on the left-hand KR C I/Os tab in the I/O Mapping 
window. 

It is also possible to select and edit several signals at once: Consecutive 
signals can be selected using SHIFT + click. A number of individual signals 
can be selected using CTRL + click.

2. At the bottom left of the I/O Mapping window, click on the button Edit sig-
nals at the provider. A window opens.

3. Enter the required calibration factor and change the data type if necessary.

4. Click on OK to save the data and close the window.

8.5 Exporting the bus configuration

Description The bus-specific configuration can be exported in the form of XML files. This 
export makes it possible to check the configuration files if required.

Precondition  The robot controller has been set as the active controller.

Procedure 1. Select the menu sequence File > Import / Export. A window opens.

2. Select Export I/O configuration to .XML files and click on Next.

3. Specify a directory. Click on Next.

4. Click on Finish.

5. The configuration is exported to the specified directory. If the configuration 
was successfully completed, this is indicated by a message. Close the 
window.

Fig. 8-11: Group signals

Fig. 8-12: A grouped signal

Box Description

Calibration fac-
tor

The required calibration factor can be entered here.

Type Only signals of the same type can be connected. The 
data type can be changed here.
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9 Long texts
9 Long texts

9.1 Displaying / editing long texts

Precondition  A robot controller has been added and set as active.

Procedure 1. Select the menu sequence Editors > Symbol Table Editor.

2. The long texts are sorted thematically. In the left-hand column, select 
which long texts are to be displayed, e.g. Digital inputs.

3. In the other columns, select the language or languages that are to be dis-
played.

4. Edit the long texts, if necessary.

Description

9.2 Importing long texts

Description The following file formats can be imported:

 .TXT

 .CSV

Precondition  A robot controller has been added and set as active.

Procedure 1. Select the menu sequence File > Import / Export. A window opens.

2. Select Import Symbol Table and click on Next.

3. Select the file to be imported and the language of the contained long texts.

4. If a signal already has a name and the file to be imported does not contain 
a name for this signal, the check box Delete existing entries determines 
what happens to the existing name.

 Activated: The name is deleted.

 Not activated The name is retained.

 

 

t

x

t

s

Fig. 9-1: Symbol Table Editor

The long texts of the digital inputs/outputs can also be edited in the I/
O Mapping window via the Edit signals at the provider button.

Imported long texts overwrite existing long texts.
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5. Click on Finish.

6. If the import was successful, this is indicated by a message. Close the win-
dow.

9.3 Exporting long texts

Description Long texts can be exported in the following file formats:

 .TXT

 .CSV

Precondition  A robot controller has been added and set as active.

Procedure 1. Select the menu sequence File > Import / Export. A window opens.

2. Select Export SymbolTable and click on Next.

3. Specify the path name and format of the file which is to be generated. Also 
select the language. Click on Finish.

4. If the export was successful, this is indicated by a message in the window. 
Close the window.

Fig. 9-2: Importing long texts

Fig. 9-3: Exporting long texts
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10 Configuring KUKA buses: controller bus, system bus, exten-
sion bus

10.1 Overview

Description The KUKA buses must be adapted in WorkVisual to the real bus configuration 
in the following cases:

 A device has been replaced by a device of a different type, e.g. a KPP0 by 
a KPP2.

 More than one device has been replaced by a device of a different type.

 One or more devices have been removed.

 One or more devices have been added.

Procedure 1. Load the active project from the robot controller.

2. Carry out the relevant configuration work.

3. Transfer the project to the robot controller and activate it there.

10.2 Configuring the KUKA bus (8.3)

Controller Bus Using the Configuration proposal functionality, the controller bus can be set 
up or updated automatically in WorkVisual. Insertion of individual devices, 
connection of devices, insertion of wagon driver files, etc., is no longer neces-
sary.

 (>>> 6.18 "Inserting hardware components" Page 40)

The controller bus can still be edited manually if required. The procedure is the 
same as for the controller version 8.2.

 (>>> 10.3.1 "Inserting devices on the KUKA bus (8.2)" Page 91)

System Bus

Extension Bus

The procedure is the same as for the controller version 8.2.

 (>>> 10.3.1 "Inserting devices on the KUKA bus (8.2)" Page 91)

10.3 Configuring the KUKA bus (8.2)

10.3.1 Inserting devices on the KUKA bus (8.2)

 

f

 

Information about exchanging devices and about the possible device 
combinations is contained in the operating instructions or assembly 
instructions for the robot controller.

If settings have already been made in a project in WorkVisual which 
are to be transferred subsequently to the robot controller together 
with the bus configuration, then the active project must be transferred 

to WorkVisual using a comparison.
 (>>> 13.8 "Comparing projects (and accepting differences)" Page 145)

Recommendation: Arrange the devices in the buses in the same or-
der as they are arranged in reality.
The arrangement has no effect on its functionality of the bus, but it is 

easier to edit the connections on the Topology tab if the arrangement al-
ready corresponds to reality.
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Preparation Only if devices are to be inserted into the Extension Bus and the node KUKA 
Extension Bus (SYS-X44) is not yet present:

1. Right-click on the node Bus structure on the Hardware tab in the Project 
structure window.

2. Select Add from the context menu. The DTM selection window is opened.

3. Select the entry KUKA Extension Bus (SYS-X44) and confirm with OK. 

Precondition  The device description files are present.

 If devices are to be inserted into the Extension Bus, the files must be 
imported beforehand.

 (>>> 6.8 "Importing device description files" Page 31)

 The files for the controller bus and the system bus are present in 
WorkVisual. 

 The robot controller has been set as the active controller.

Procedure 1. Right-click on the KUKA bus in the Bus structure node on the Hardware 
tab in the Project structure window.

2. Select Add from the context menu. The DTM selection window is opened.

3. Select the device used and confirm with OK. The device is inserted in the 
tree structure.

4. If required: Right-click on the device in the tree structure and select Re-
name from the context menu. Rename the device.

5. Repeat steps 1 and 4 for all devices used in the real bus.

6. Check the device settings and change if necessary.

 (>>> 10.3.2 "Checking the device settings" Page 93)

7. Check the device connections and change if necessary.

 (>>> 10.3.3 "Connecting devices on the KUKA bus" Page 94)

8. Only if the change in the controller bus affects a KPP, or if the controller 
bus has been complete reconfigured: Insert the wagon driver configura-
tion.

 (>>> 10.3.5 "Inserting the wagon driver configuration" Page 96)

In a bus, more than one device of the same type may be present. To 
distinguish them in the bus structure, WorkVisual automatically ap-
pends a number to the name. It is recommended, however, to give 

the devices meaningful names, e.g. by including the abbreviation for the in-
stallation position of the devices.
The names that the devices have here in the bus structure are the names 
used in error messages.
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10.3.2 Checking the device settings

Procedure 1. Right-click on the device on the Hardware tab in the Project structure 
window.

2. Select Settings… from the context menu. The Settings … window opens.

3. Select the General tab.

4. Check that the following settings have been made. If not, correct the set-
tings.

 Check vendor ID: active

 Check product code: active

 Check revision number: OFF

 Check serial number: inactive

5. Close the window by clicking on OK.

Fig. 10-1: Example of a controller bus

Fig. 10-2: Device settings, “General” tab
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10.3.3 Connecting devices on the KUKA bus

Description If devices are inserted into the bus, WorkVisual connects the devices automat-
ically. As WorkVisual does not know the real bus configuration, the connec-
tions must be checked and changed where necessary.

Procedure 1. Right-click on the bus on the Hardware tab in the Project structure win-
dow.

2. Select Settings… from the context menu. The Settings… window is 
opened.

3. Select the Topology tab.

 (>>> 10.3.4 "“Topology” tab" Page 95)

4. Select and delete invalid connections. To do this, either press the Del key, 
or right-click and select Delete.

5. Insert missing connections. To do this, click on a connection and hold 
down the mouse button. Drag the mouse pointer to another connection 
and release the mouse button.

6. Mark temporary connections as such. To do this, right-click on the connec-
tion and select Disconnectable from the context menu. The connection is 
displayed as a broken line.

A temporary connection is e.g. with the controller bus, the connection to 
the Electronic Mastering Device (EMD), because the EMD is not perma-
nently connected.

7. Click on devices for which the address or alias address is not yet correct. 
A window appears. Enter the correct address.

All temporarily connected devices require an alias address. For the EMD, 
the alias address 2001 must be entered!

8. If required: Rearrange the devices using Drag&Drop. This serves to in-
crease the clarity of the Topology tab. It has no effect on the bus.

9. Click on OK at bottom right.

Information about the connector pin allocation of the devices can be 
found in the operating instructions for the robot controller.
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10.3.4 “Topology” tab

Properties of the “Topology” tab:

 Each device in the bus is represented by 1 rectangle.

 The numbers of the devices specify their physical address.

 To display the name of a device:

Move the mouse pointer onto the device. A tool tip is displayed with the 
name of the device.

Or alternatively, select the device. The window on the right displays the 
properties of this device, e.g. the name.

The devices in the figure:

 To display the name of a connection:

Move the mouse pointer onto the connection. A tool tip is displayed with 
the name of the connection.

 Lines shows the connections between the devices.

Solid lines indicate permanent connections. Broken lines indicate tempo-
rary connections.

 The devices can be reordered using Drag&Drop. This serves to increase 
the clarity of the Topology tab. It has no effect on the bus.

Fig. 10-3: “Topology” tab – example of a controller bus

Device Name

1001 Cabinet Interface Board (CIB)

1002 Resolver Digital Converter (RDC)

1003 KUKA Power Pack 2 Axes (KPP2) (G1)

1004 KUKA Servo Pack Wrist Axes (KSP) (T1)

1005 KUKA Servo Pack Main Axes (KSP) (T2)

1006 Electronic Mastering Device (EMD)
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 The window on the right displays the properties of the selected device, e.g. 
the address and alias address. Some of the properties can be changed.

All temporarily connected devices require an alias address. For the EMD, 
the alias address 2001 must be entered!

 The message area below the graphic shows if a device has an invalid ad-
dress or alias address.

Editing connections:

 Select and delete invalid connections. 

To do this, either press the Del key, or right-click and select Delete.

 Insert missing connections. 

To do this, click on a connection and hold down the mouse button. Drag 
the mouse pointer to another connection and release the mouse button.

 Mark temporary connections as such.

To do this, right-click on the connection and select Disconnectable from 
the context menu. A temporary connection is e.g. the connection to the 
Electronic Mastering Device (EMD), because the EMD is not permanently 
connected.

10.3.5 Inserting the wagon driver configuration

Description The wagon driver configuration must be inserted into the WorkVisual project 
in the following cases:

 If the controller bus has been completely reconfigured.

 Or if a change has been made to the controller bus which affects a KPP.

For this, the following configuration files are required:

 CFCoreWaggonDriverConfig.xml

 EAWaggonDriverConfig.xml

These files are automatically installed together with WorkVisual. They are lo-
cated in the directory: C:\Program Files (x86)\KUKA\WorkVisual[…]\Waggon-
DriverConfigurations. They can be found there in the subdirectory for the 
relevant controller bus variant.

Which wagon driver configuration should be used for which controller 
bus?

Precondition  The robot controller has been set as the active controller.

Controller bus with … Directory

KPP without external axis KPP 600-20

KPP with 1 external axis KPP 600-20-1x40 (1x64)

KPP with 2 external axes KPP 600-20-2x40

KPP with 1 external axis and ServoGun FC 
Sensor Box

KPP 600-20-1x40 + SDC

KPP with 2 external axes and ServoGun FC 
Sensor Box

KPP 600-20-2x40 + SDC

4-axis palletizer with external axis 4Ax_PA_mit_ZA

4-axis palletizer without external axis 4Ax_PA_ohne_ZA

5-axis palletizer with external axis 5Ax_PA_mit_ZA

5-axis palletizer without external axis 5Ax_PA_ohne_ZA

AGILUS sixx 6Ax_CIBsr_KPPsr_KSP
sr
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Procedure 1. Expand the node of the robot controller on the Files tab in the Project 
structure window.

2. Then expand the following subordinate nodes: Config > User > Common 
> Mada.

3. Only if there are already wagon driver files in the Mada directory and these 
need to be removed:

 Right-click on a file and select Delete from the context menu. 

 Repeat for the second file.

4. Right-click on the Mada folder and select Add external file from the con-
text menu.

5. A window opens. In the File type box, select the entry All files (*.*).

6. Navigate to the directory in which the files for the wagon driver configura-
tion are located, select the files and confirm with Open.

The files are now displayed in the tree structure below the Mada folder. (If 
not: collapse and expand all the folders in order to refresh the display.)

10.4 Assigning FSoE slave addresses (≥ 8.2.21 and 8.3)

Description The robot controller is supplied with preconfigured FSoE addresses. The user 
needs to assign the addresses via WorkVisual only in the following cases:

 More than 1 RDC is connected.

On delivery, RDCs are preconfigured with the FSoE address “2”. An ad-
dress must not be used more than once on a robot controller. 

 Several devices of the same type have been replaced at the same time.

Preparation  Determine the KUKA serial number of the real device. 

 With KSPs and KPPs, the serial number is given on the rating plate.

There may be several serial numbers on the Lenze modules. The 
KUKA number is the relevant one.

 (>>> 10.4.2 "Determining the serial number for the Lenze KSP/KPP" 
Page 100)

 RDCs have a label with a barcode on the board. The serial number is 
specified in encrypted form.

 (>>> 10.4.3 "Determining the serial number of the RDC" Page 100)

 Determine the IP address of the interface via which the WorkVisual PC is 
connected to the robot controller:

a. On the robot controller, select Diagnosis > Diagnostic monitor from 
the main menu. 

b. Select the interface in the Module box: Network interface (Service) 
(for KSI) or Network interface (KLI). 

The relevant data for the interface, including the IP address, are now 
displayed.

Precondition WorkVisual:

 The IP address of the WorkVisual PC is in the same subnet as the IP ad-
dress of the interface to which it is connected (KSI or KLI).

This description is valid for the controller variant (V)KR C4. For 
KR C4 compact, please contact KUKA.
 (>>> 15 "KUKA Service" Page 173)

The assignment of addresses to devices is predefined. 
 (>>> 10.4.1 "FSoE addresses" Page 99)
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 Network connection to the real robot controller

 The configuration in WorkVisual is identical to the real bus architecture.

This can be achieved most reliably by loading the active project of the real 
robot controller in WorkVisual.

 The robot controller has been set as the active controller.

 The affected devices support address assignment by software. 

This is defined in the device description file. In certain cases, this feature 
may be present in the latest device description file, although the device 
was inserted into the bus structure in WorkVisual with an older version of 
the file. The new file must then be imported in WorkVisual and the device 
must be removed from the bus structure and then reinserted.

Real robot controller:

 User group Expert or higher

 Operating mode T1

 The safety controller does not give a drives enable signal.

 This status can be brought about in the following way: trigger an 
EMERGENCY STOP.

 This status can be checked as follows: In the status bar, click on the 
Drives status indicator. The Motion conditions window opens. The 
box Drives enabled from Safety must be gray. It must not be green.

Procedure 1. Double-click on the KUKA Controller Bus (KCB) node on the Hardware 
tab in the Project structure window. The Settings … window opens.

2. Enter the IP address (KSI or KLI) determined during the preparation stage. 
Click on OK to save the entries and close the window.

3. Right-click on the KUKA Controller Bus (KCB) node and select Connect 
from the context menu.

The node is now displayed in green italics.

4. Right-click on the relevant device under the KUKA Controller Bus (KCB) 
node and select Connect from the context menu.

The device description is now displayed in green italics.

5. Right-click again on the device and select Functions > Assign FSoE 
slave address... from the context menu. The FSoE slave address as-
signment window opens and the currently set FSoE address is displayed.

6. Enter the serial number and the new FSoE address. Leading zeros may 
be omitted. 

WorkVisual recognizes whether the serial number is correct: If it is not, a 
red exclamation mark is displayed to the left of the box. This is also the 
case during entry, while the number is still incomplete and thus incorrect. 

The red exclamation point disappears as soon as the number is complete 
and correct.

If DHCP is used, a suitable IP address is assigned automatically.
If a fixed IP address is used in conjunction with a connection via the 
KLI, the address depends on the interface setting that is configured 

as a Windows interface in the KLI. (Default: “virtual5” with the IP address 
172.31.1.147 and the subnet mask 255.255.0.0)
If a fixed IP address is used in conjunction with a connection via the KSI, the 
area of the suitable IP address depends on the settings of the non-real-time 
communication. (Default: IP address 172.17.x.x with subnet mask 
255.255.0.0)

Information about the status bar can be found in the operating and 
programming instructions for the system software.
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7. If the serial number is correct, click on Accept. Then click on OK. The win-
dow closes.

8. Right-click again on the device and select Disconnect from the context 
menu. 

The data are now saved on the real device. The real controller bus cannot 
yet access the device, however.

9. Right-click on the KUKA Controller Bus (KCB) node and select Discon-
nect from the context menu.

10. Reconfigure the I/O drivers on the real robot controller. 

Once the reconfiguration is complete, the controller bus once again has 
access to its devices and to the current addresses.

10.4.1 FSoE addresses

KSP and KPP

RDC The following tables display common topologies and how the FSoE addresses 
must be assigned to them.

 RDC-Rob = RDC of a KUKA robot (except KR 1000 titan)

 RDC-Titan = RDC of a KR 1000 titan

 RDC-ExAx = RDC for external axes or CKs

The KR 1000 titan has 2 RDCs. These must always have the FSoE addresses 
“2” and “3”.

Controller variant with 1 row of drive modules

KSP, left

Address: 1022

KSP, middle

Address: 1021

KPP, right

Address: 1020

Controller variant with 2 rows of drive modules

KSP, top left

Address: 1032

KSP, top center

Address: 1031

KPP, top right

Address: 1030

KSP, bottom left

Address: 1022

KSP, bottom center

Address: 1021

KPP, bottom right

Address: 1020

X21, cascaded X21 X21.1, cascaded X21.1

RDC-Rob

Address: 2

--- --- ---

RDC-ExAx

Address: 3

---

RDC-ExAx

Address: 3

RDC-ExAx

Address: 4

X21, cascaded X21 X21.1, cascaded X21.1

RDC-Titan

Address: 2

RDC-Titan

Address: 3

--- ---

RDC-ExAx

Address: 4

---

RDC-ExAx

Address: 4

RDC-ExAx

Address: 5
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Additional 

components

It is possible to assign FSoE addresses to the following components. In prac-
tice, however, it is not necessary, as they only occur once per robot controller. 

10.4.2 Determining the serial number for the Lenze KSP/KPP

10.4.3 Determining the serial number of the RDC

Description RDCs have a label with a barcode on the board. The serial number is specified 
in encrypted form. There are 2 types of barcode. The length of the serial num-
ber depends on the type.

If the RDC is located in the RDC box, the box must be opened in order to read 
the label. 

X21, cascaded X21 X21.1, cascaded X21.1

RDC-ExAx

Address: 2

RDC-Rob

Address: 3

--- ---

RDC-ExAx

Address: 4

---

RDC-ExAx

Address: 4

RDC-ExAx

Address: 5

Component Address

smartPAD 13330

SIB 13331

Extended SIB 13332

CIB 1

The addresses for smartPAD, SIB, Extended SIB and CIB must never 
be assigned to other components.

Fig. 10-4: Example: Labels on the Lenze KSP/KPP

Item Description

1 KUKA Ser.-Nr.: This is the the relevant number.

2 Ser.-Nr.: This number is not relevant.

Information about the RDC and opening the RDC box can be found 
in the operating instructions for the robot controller.
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Label on the RDC

Encrypted serial 

number

Fig. 10-5: Example: open box with RDC

Item Description

1 The relevant label is located in the center of the board. 

2 The labels on the EDS memory strip are not relevant.

Fig. 10-6: Example: label on an RDC

Item Description

1 The two leftmost digits specify the type. Possible values are:

 Type 20 (in the example)

 Type 26

2 The two rightmost digits specify the check digit. The check digit it-
self is not relevant.

3 To the left of the check digit is the serial number. The number of 
figures it comprises is dependent on the type:

 With type 20: 6 digits (in the example: 012406)

 With type 26: 7 digits
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10.5 Assigning FSoE slave addresses (≤ 8.2.20)

Description The robot controller is supplied with preconfigured FSoE addresses. Only 
when a device is replaced must the user assign it an address in WorkVisual.

It is not possible to replace more than one device of the same type at the same 
time.

Preparation  Determine the KUKA serial number of the real device. 

 With KSPs and KPPs, the serial number is given on the rating plate.

There may be several serial numbers on the Lenze modules. The 
KUKA number is the relevant one.

 (>>> 10.4.2 "Determining the serial number for the Lenze KSP/KPP" 
Page 100)

 RDCs have a label with a barcode on the board. The serial number is 
specified in encrypted form.

 (>>> 10.4.3 "Determining the serial number of the RDC" Page 100)

 Determine the IP address of the interface via which the WorkVisual PC is 
connected to the robot controller:

a. On the robot controller, select Diagnosis > Diagnostic monitor from 
the main menu. 

b. In the Module box, select the entry Networkinterface (KLI). 

The relevant data for the interface, including the IP address, are now 
displayed.

Precondition WorkVisual:

 The IP address of the WorkVisual PC is in the same subnet as the IP ad-
dress of the interface to which it is connected (KLI).

 Network connection to the real robot controller

 The configuration in WorkVisual is identical to the real bus architecture.

This can be achieved most reliably by loading the active project of the real 
robot controller in WorkVisual.

 The robot controller has been set as the active controller.

 The affected devices support address assignment by software. 

This is defined in the device description file. In certain cases, this feature 
may be present in the latest device description file, although the device 
was inserted into the bus structure in WorkVisual with an older version of 
the file. The new file must then be imported in WorkVisual and the device 
must be removed from the bus structure and then reinserted.

Real robot controller:

 User group Expert or higher

 Operating mode T1

 $USER_SAF == TRUE 

$USER_SAF == 

TRUE

The conditions under which $USER_SAF is TRUE depend on the controller 
variant and the operating mode:

This description is valid for the controller variant (V)KR C4. For 
KR C4 compact, please contact KUKA.
 (>>> 15 "KUKA Service" Page 173)

The assignment of addresses to devices is predefined. 
 (>>> 10.4.1 "FSoE addresses" Page 99)
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Procedure 1. Double-click on the KUKA Controller Bus (KCB) node on the Hardware 
tab in the Project structure window. The Settings … window opens.

2. Enter the IP address of the KLI determined during the preparation stage. 
Click on OK to save the entries and close the window.

3. Right-click on the KUKA Controller Bus (KCB) node and select Connect 
from the context menu.

The node is now displayed in green italics.

4. Right-click on the relevant device under the KUKA Controller Bus (KCB) 
node and select Connect from the context menu.

The device description is now displayed in green italics.

5. Right-click again on the device and select Functions > Assign FSoE 
slave address... from the context menu. The FSoE slave address as-
signment window opens and the currently set FSoE is displayed.

6. Enter the serial number and the new FSoE address. Leading zeros may 
be omitted. 

WorkVisual recognizes whether the serial number is correct: If it is not, a 
red exclamation mark is displayed to the left of the box. This is also the 
case during entry, while the number is still incomplete and thus incorrect. 

The red exclamation point disappears as soon as the number is complete 
and correct.

7. If the serial number is correct, click on Accept. Then click on OK. The win-
dow closes.

8. Right-click again on the device and select Disconnect from the context 
menu. 

The data are now saved on the real device. The real controller bus cannot 
yet access the device, however.

9. Right-click on the KUKA Controller Bus (KCB) node and select Discon-
nect from the context menu.

10. Select Shutdown from the main menu on the robot controller and select 
the options Cold start and Reload files.

The controller is rebooted. The controller bus now has access to its devic-
es and to the current addresses again.

Controller
Operating 

mode
Condition

KR C4 T1, T2  The enabling switch is pressed.

AUT, AUT EXT  The physical safeguard is 
closed.

VKR C4 T1  The enabling switch is pressed.

 E2 is closed.

T2  The enabling switch is pressed.

 E2 and E7 are closed.

AUT EXT  The physical safeguard is 
closed.

 E2 and E7 are open.
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11 RoboTeam

11.1 Creating a RoboTeam

11.1.1 Creating a new RoboTeam project

Description WorkVisual provides templates which enable creation of a new project con-
taining one or more RoboTeams. A wizard, the Cell Configuration Wizard, 
guides the user through the creation process.

Templates Templates for projects containing RoboTeams:

Procedure 1. Click on the New… button. The Project Explorer is opened. On the left, 
the Create
project tab is selected.

2. Select one of the templates for a RoboTeam project in the Available tem-
plates area of the tab.

 

T

This documentation describes how RoboTeams can be configured 
offline with WorkVisual. Basic information about RobotTeam and 
about installation and programming on the robot controller can be 

found in the documentation KUKA.RoboTeam.

The “RoboTeam” functionality is not available for projects with VKR 
C4 robot controllers.

Template Description

Generic RoboTeam 
project

Creates a project in which the number of 
RoboTeams and independent robots is specified 
by the user. The user also specifies the number 
of robots and external axes in each RoboTeam.

Simple RoboTeam 
project

Creates a project with 1 RoboTeam. The 
RoboTeam contains 2 robots and 1 external axis.

Project with two 
RoboTeams

Creates a project with 2 RoboTeams. Each 
RoboTeam contains 2 robots and 1 external axis. 
The project also contains a handling robot.

Fig. 11-1: Example screen: Cell Configuration Wizard
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3. Enter a name for the project in the File name box.

4. The default directory for projects is given in the Location box. If required, 
select a different directory.

5. Click on the New button. The Cell Configuration Wizard opens. 

6. Make the required settings in the wizard, e.g. select the robot type. Click-
ing on Next takes you to the next screen.

7. Once all the relevant settings have been made, click on Finish and then, 
in the next screen, on Close.

8. The robot network is now displayed on the Hardware tab of the Project 
structure window, and also in the Cell configuration window. The robot 
network is displayed in a tree structure on the Hardware tab and graphi-
cally on the Cell configuration tab.

Fig. 11-2: Example: RoboTeam on the Hardware tab
Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



11 RoboTeam
11.1.2 Inserting a RoboTeam in an existing project

Description A RoboTeam can be inserted in an existing project. This can be done via the 
Project structure or Cell configuration window.

Precondition  The catalogs KukaControllers and KUKARobots[…] are available.

 If the RoboTeam is to contain external axes: The catalog KukaExter-
nalKinematics[…] is available.

Procedure: 

Project structure

1. Right-click on the node of the cell on the Hardware tab in the Project 
structure window and select the option Add RoboTeam from the context 
menu.

The node Robot network and the subnode RoboTeam are inserted. The 
nodes are numbered by default. They can be renamed.

2. Add the required number of robot controllers to the RoboTeam node.

3. Assign robots to the robot controllers.

4. If required, assign external axes to the robot controllers.

5. If required, a further RoboTeam can be added to the network. 

To do this, right-click on the Robot network node and select the option 
Add RoboTeam from the context menu. Then repeat steps 2 to 5.

Procedure: Cell 

configuration

1. Right-click in the empty space in the Cell configuration window and se-
lect the option Add RoboTeam from the context menu.

A new RoboTeam is added. The name can be changed.

2. Add the required number of robot controllers to the new RoboTeam.

Fig. 11-3: Example: RoboTeam in the Cell configuration window

If the RoboTeam is to be inserted in a new project, specific templates 
are available for project creation. This is quicker and easier than first 
creating an ordinary project and then inserting the RoboTeam.

 (>>> 11.1.1 "Creating a new RoboTeam project" Page 105)
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3. Assign robots to the robot controllers.

4. If required, assign external axes to the robot controllers.

5. If required, a further RoboTeam can be added to the network.

Right-click in the empty space and select the option Add RoboTeam from 
the context menu. Then repeat steps 2 to 5.

11.2 Configuring the RoboTeam

11.2.1 Defining the time master

Description Once a robot network has been created, the first robot controller in the tree 
structure is defined by default as the time master by WorkVisual. This assign-
ment can be changed.

In the Cell configuration window, the time master is indicated by a small an-
alog clock icon. There can be only 1 time master per network.

On the real robot controller, the time master is not visible and cannot be 
changed.

Precondition  The Cell configuration window is open.

Procedure 1. Right-click on the robot controller that is to be set as the new time master.

2. Select RoboTeam > Set as time master in the context menu.

The new time master is now indicated by the analog clock icon. The clock 
has now disappeared from the previous time master.

Fig. 11-4: Display of the time master

Item Description

1 The clock indicates the time master.
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11.2.2 Defining the motion master

Description This procedure is used to define which kinematic system should be able to fol-
low the motions of another kinematic system. The second kinematic system is 
then the motion master. This procedure therefore does not define which kine-
matic systems actually follow the motions of others, but merely which possibil-
ities should apply. Only those kinematic systems that have been defined here 
in WorkVisual as master and/or slave can be used as such in the program.

Multiple connections and bidirectional connections are possible, as kinematic 
systems may be motion master and/or slave during program execution.

When a connection is created, the required BASE and TOOL coordinate sys-
tems are automatically created. These are identified by the names REF_PIN 
and LK_BASE and an icon. In the case of a robot that is to follow another ro-
bot, a reference to the TOOL and BASE coordinate systems of the other robot 
is created. The coordinate systems are marked in red in the Tool/base man-
agement editor, as they are not yet assigned to any number.

Precondition  The Cell configuration window is open.

Procedure 1. Click on a kinematic system (robot or external axis) and hold down the 
mouse button.

2. Drag the mouse pointer to another kinematic system and release the 
mouse button. The pop-up window {Kinematic1} should follow 
{Kinematic2} opens.

3. Click on the pop-up window.

The first kinematic system can now follow the other kinematic system. This 
is indicated by a dotted arrow. The arrow is red if the root points have not 
yet been calibrated. A green arrow indicates that the root points have al-
ready been calibrated.

4. Repeat steps 1 to 3 until every kinematic system is connected to at least 
one other kinematic system.

5. Open the Tool/base management editor and assign numbers as desired 
to the BASE and TOOL coordinate systems that have not yet been as-
signed.

It is advisable to create only those connections which are actually re-
quired in the program. Do not connect every kinematic system to ev-
ery other kinematic system in both directions, as this would take up 

TOOL and BASE coordinate systems unnecessarily. These would then be 
unavailable for other purposes.
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Fig. 11-5: Display of the motion master

Item Description

1 Robot 2 is the motion master of Robot 1. The arrow is blue instead 
of red because the mouse pointer is positioned on it.

2 Robot 2 is the motion master of Robot 3.

3 Positioning the mouse pointer on an arrow opens an info box.

Fig. 11-6: TOOL and BASE coordinate systems in the RoboTeam
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11.2.3 Deleting a master/slave link

Description Links which define motion masters can be deleted if they are no longer need-
ed.

Procedure 1. Click on the arrow to be deleted. The color of the arrow changes to blue.

2. Right-click and select Delete from the context menu. The arrow is deleted.

11.2.4 Creating and configuring semaphores

Description The semaphore is used to defined the order in which the robots are allowed to 
enter the workspace.

Precondition  The RoboTeam has been created.

 The Cell configuration window is open.

Procedure 1. Right-click on a robot controller and select RoboTeam > Create sema-
phore from the context menu.

2. A semaphore is inserted. The default name is Semaphore [consecutive 
no.]. The default name can be changed.

3. The robot controller selected on creation has the priority 1. The priority can 
be changed:

a. Click on the down arrow next to the semaphore.

b. In the Priority list area, define the order using the arrows.

4. One robot controller is defined as the semaphore master. The semaphore 
master can be changed:

a. Click on the down arrow next to the semaphore.

b. Select the desired robot controller in the Master area.

Item Description

1 TOOL coordinate system that is not assigned to any number

2 Indicates that the coordinate system belongs to a connection of 
two robots

3 BASE coordinate system that is not assigned to any number

In the KUKA.RoboTeam technology package, the semaphores are la-
beled as workspaces. These workspaces are specific to RoboTeam 
and have nothing to do with the geometric workspaces derived from 

the individual axis ranges of the robot.
If KUKA.RoboTeam is installed on the robot controller, the semaphores can 
be displayed on the KUKA smartHMI via Display > Workspace.
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Fig. 11-7: Configuring semaphores

Item Description

1 Semaphore display

2 Priority list

This order can be changed using the arrows.

3 Semaphore master
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12.1 Creating a program

Precondition  With use of a KR C4 controller: the KRL Templates catalog has been in-
serted in the Catalogs window.

 With use of a VKR C4 controller: the VW Templates catalog has been in-
serted in the Catalogs window.

Procedure 1. Expand the tree structure of the robot controller on the Files tab in the 
Project structure window.

2. Select the required template in the KRL Templates or VW Templates cat-
alog and drag it onto a node in the tree structure. The program file is in-
serted in the tree structure.

The file can now be edited with the KRL Editor.

12.2 Importing a program

Description Files in the formats SRC, DAT, SUB and KRL can be imported.

Procedure 1. Expand the tree structure of the robot controller on the Files tab in the 
Project structure window.

2. Right-click on the node in which the program is to be created and select 
Add external file from the context menu. 

3. Navigate to the directory where the file is located that is to be imported.

4. Select the file and confirm with Open. The file is inserted in the tree struc-
ture.

The file can now be edited with the KRL Editor.

12.3 Displaying the variable declarations in a file

All the KRL variables that are declared in a particular file can be displayed in 
a list overview. With SRC files, the variables from the corresponding DAT file 
are always displayed at the same time, and vice versa. 

Procedure 1. Only if the Variable list window is not yet displayed: Display it by selecting 
the menu sequence Window > Variable list.

2. Open the file in the KRL Editor, or, if it is already open, click on the tab for 
the file.

3. The variable list now displays all the variables that are declared in this 
module (SRC file and corresponding DAT file).

4. If necessary, a variable can be selected in the KRL Editor as follows:

 Double-click on the line in the search results.

 Or: Right-click on the line and select Go to… from the context menu.

 Or: Select the line and press the Enter key.

A search function is available in the Variable list window, which allows a 
search to be carried out for local variables within the current file:

 Enter the variable name or part of the name in the search box. The search 
results are displayed immediately.

If the cursor is positioned in the search box, this can be emptied by pressing 
ESC.

2
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Description

Clicking on a column sorts the list by this column.

12.4 Searching and replacing within files

Description WorkVisual provides a search function which allows the text of all files in the 
entire project to be searched. It is also possible to search an individual file or 
a selected area within a file. The range of the search can be selected in the 
search window. 

Instead of searching, it is also possible to search and replace.

The search (or search and replace) function can be called from any place in 
the project, whatever workspace or editor is currently in focus.

Procedure 1. If an individual file is to be searched, this should be opened.

2. If an area within the file is to be searched, this should be selected.

3. Open the Search window: Ctrl+F

Or: Open the window for Search and Replace: Ctrl+H

4. Make the desired settings and click on Search, or on Replace or Replace 
all.

12.5 KRL Editor

12.5.1 Opening a file in the KRL Editor

Precondition  This is a file format that can be edited with the KRL Editor.

 (>>>  "File formats" Page 115)

Procedure 1. Double-click on a file on the Files tab in the Project structure window.

Or: Select the file and click on the KRL Editor button.

Or: Select the file and select the menu sequence Editors > KRL Editor. 

2. To close the file: Click on the “X” at top right.

The KRL Editor allows more than one file to be open simultaneously. If re-
quired, they can be displayed side by side or one above the other. This pro-
vides a convenient way of comparing contents, for example.

To display the files side by side:

1. Right-click in the title bar of the file in the KRL Editor. Select New Vertical 
Tab Group from the context menu.

Fig. 12-1: “Variable list” window

Button Name / description

Groups the variables by local subfunctions

Button is pressed: The display is sorted by file type. (Within 
this sort mode, it is also possible to sort by column.)

Button is not pressed: The display is not sorted by file type.
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2. To display the files one behind the other again: Right-click in the title bar 
of a file in the KRL Editor. Select Move Next or Move Previous from the 
context menu.

To display the files one above the other:

1. Right-click in the title bar of the file in the KRL Editor. Select New Horizon-
tal Tab Group from the context menu.

2. To display the files one behind the other again: Right-click in the title bar 
of a file in the KRL Editor. Select Move Next or Move Previous from the 
context menu.

File formats The KRL Editor is used primarily to edit files containing KRL code:

 SRC

 DAT

 SUB

In addition, the KRL Editor can be used to edit the following file formats:

 ADD

 BAT

 CONFIG

 CMD

 DEL

 INI

 KFD

 KXR

 LOG

 REG

 TXT

 XML

12.5.2 KRL Editor user interface

Fig. 12-2: KRL Editor user interface
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12.5.3 Zooming in/out

Procedure 1. Click anywhere in the KRL Editor.

2. Hold down the CTRL key and move the mouse wheel.

 Mouse wheel up: zoom in

 Mouse wheel down: zoom out

12.5.4 Configuring KRL Editor

Preparation Only necessary if it is desirable to see a preview of the effect of the settings:

1. Open a file in the KRL Editor.

2. To see a preview of the colors for the marks: select any point in the file.

(Nothing can be selected in the file while the Options window is open.)

Procedure 1. Select the menu sequence Extras > Options. The Options window is 
opened.

2. On the left of the window, open the Text editor folder. In the folder, select 
a subitem.

The corresponding settings are now displayed on the right of the window.

3. Make the desired changes.

Item Description

1 Program area

The code is entered and edited here. The KRL Editor provides nu-
merous functions to support the programmer with this.

2 List of the subprograms in this file

To go to a subprogram, select it from the list: the cursor then jumps 
to the DEF line of this subprogram.

If the file does not contain any subprograms, the list is empty.

3 List of variable declarations

This list always refers to the subprogram that is currently selected 
in the list of subprograms. To go to a declaration, select the vari-
able from the list: the cursor then jumps to the line containing the 
declaration of these variables.

If there are no variable declarations, the list is empty.

4 Analysis bar

The marks indicate errors or discrepancies in the code. 

 Hovering with the mouse over a mark displays a tool tip with a 
description of the error.

 Clicking on the mark makes the cursor jump to the relevant 
place in the program. An automatic correction is offered for 
some errors/discrepancies.

 (>>> 12.5.9 "Quickfix correction" Page 120)

5 The square has the color of the most serious error currently pres-
ent.

If there are no errors/discrepancies, the square is green.

If the mouse pointer is moved over a field, a description is displayed 
for this field at the bottom of the window.
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The changes can be seen immediately if a file is currently open in the KRL 
Editor (e.g. if spaces are revealed or hidden).

4. Confirm with OK. The changes are saved.

Or discard the changes with Cancel.

The color settings can be reset to the default settings at any time. The Reset 
button for this is situated on the corresponding page in the Options window. 
(At the bottom of the page; scrolling is required.)

12.5.5 Edit functions

12.5.5.1 General edit functions

Select  To select an area: click where the selection should begin and hold down 
the left-hand mouse button. Drag the mouse until the desired area is se-
lected, and then release the mouse button.

 To select a line: click on the line number.

Edit Standard edit functions can be called via the context menu. These include:

 Cut, Paste, Copy, Delete

 Undo, Redo

 Search …  (>>> 12.4 "Searching and replacing within files" Page 114)

In addition, the following commands are available in the context menu.

If the ALT key is additionally held down during selection, it is possible 
to select a rectangular area. 

Not all commands are available for every file format.

Commands which refer to a selected area affect the whole file if no 
area is selected.

Menu item Description

Edit > Make upper case Converts all the lower-case letters in the selected string into 
upper-case letters.

Edit > Make lower case Converts all the upper-case letters in the selected string 
into lower-case letters.

Edit > Title case Converts all the initial letters in the selected string into 
upper-case letters.

Edit > Convert tabs into spaces Replaces the tabs in the selected string with spaces. 

Note: The number of spaces corresponding to one tab can 
be configured in the parameter Indent size.

Edit > Convert spaces into tabs Replaces the spaces in the selected string with tabs.

Edit > Indent Inserts additional spaces at the beginning of every line in 
the selected area.

Note: The number of spaces inserted can be configured in 
the parameter Indent size.

Edit > Remove leading 
whitespace

Removes all the leading spaces from the lines in the 
selected area.

Folds > Expand all Opens all folds in the currently displayed file.

Folds > Collapse all Closes all folds in the currently displayed file.
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12.5.5.2 Renaming a variable

Description A variable name can be changed in a single action at all points where it occurs.

This is also possible if the variable is declared in a DAT file and used in various 
SRC files.

Precondition  The files in which the variable name occurs do not contain any syntax er-
rors.

Automatic renaming cannot be executed in a file containing syntax errors.

Procedure 1. Select the desired variable at any point.

2. Right-click and select Rename from the context menu.

3. A window opens. Change the name and confirm with OK.

12.5.5.3 Auto-complete

An auto-complete function is available in the KRL Editor. 

When entering code, a list containing the following elements is displayed au-
tomatically:

 KRL keywords

 Known variable names

 Known function names

 Known user-specific data types (STRUC or ENUM)

 Snippets  (>>> 12.5.5.4 "Snippets – Fast entry of KRL instructions" 
Page 119)

Those elements that are compatible with the characters already entered are 
shown at the top of the list. These elements are also prioritized according to 
their frequency of use, i.e. the selection is dynamically adapted to the user’s 
actions.

If required, an element in the list can be selected and inserted in the program 
text using the Enter key. This makes it unnecessary to type complex variable 
names, for example.

Format Indentations, line breaks, etc., are adapted throughout the 
file to conform to the standard. The applicable standard 
depends on the file format.

Comment selection Uncomments the line.

Uncomment selection Comments the line out.

Rename  (>>> 12.5.5.2 "Renaming a variable" Page 118)

Go to declaration  (>>> 12.5.7 "Jumping to the declaration of a variable" 
Page 120)

Insert snippet  (>>> 12.5.5.4 "Snippets – Fast entry of KRL instructions" 
Page 119)

Menu item Description

Navigation in the “Auto-complete” list:

Scroll

Or: Type the first letter of the desired element. The marker jumps to 
the relevant position.
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12.5.5.4 Snippets – Fast entry of KRL instructions

Description A fast entry function is available in the KRL Editor for common KRL instruc-
tions.

To program a FOR loop, for example, it is not necessary to enter the entire 
syntax FOR … = … TO … STEP …. Instead, the instruction can be selected 
from the “Auto-complete” list. All that is then required is to fill out the variable 
positions in the syntax manually.

Procedure On starting to type the code, the “Auto-complete” list is shown. The required 
instruction is generally already selected.

1. Accept the selected instruction from the “Auto-complete” list using the En-
ter key. Or double-click on a different instruction.

2. The KRL syntax is inserted automatically. The first variable position is 
highlighted in blue. Enter the desired value.

3. Press the TAB key to jump to the next variable position. Enter the desired 
value.

4. Repeat step 3 for all other variable positions.

5. To finish editing, press the Enter key.

The snippet list can also be called separately: Right-click and select Insert 
snippet from the context menu.

It is also possible to enter a snippet as follows: Type in the abbreviation and 
press the TAB key.

(The abbreviation can be determined by calling the snippet list. Select the in-
struction. A tool tip is displayed. The 2nd line contains the possible abbrevia-
tions.)

12.5.6 Folds

Description The content of the KRL Editor can be structured with folds just like any normal 
KRL program. 

Fig. 12-3: Accept with the Enter key, or double-click

Fig. 12-4: The first variable position is highlighted in blue
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Procedure To open a fold:

 Double-click on the box of the closed fold.

 Or: Click on the plus sign.

To close a fold:

 Click on the minus sign.

To open or close all folds:

 Context menu: Folds > Expand all or Collapse all

12.5.7 Jumping to the declaration of a variable

Procedure 1. Place the cursor in the variable name, or directly in front of the first letter 
or directly after the last letter.

2. Right-click and select Go to declaration from the context menu.

12.5.8 Displaying all uses of a variable

Procedure 1. Only if the Find uses window is not yet displayed:

Select the menu sequence Window > Find uses.

2. Place the cursor in the variable name, or directly in front of the first letter 
or directly after the last letter.

3. Right-click and select Find uses from the context menu.

A tab with the name Uses of [Variable name] appears in the Find uses win-
dow. All uses are listed there in detail (file with path, line number, etc.)

4. If required: Double-click on a line in the list. The corresponding position in 
the program is highlighted. 

Rename, for example, is now possible.

12.5.9 Quickfix correction

Wavy red lines in the code and marks in the analysis bar indicate errors or dis-
crepancies in the code.

For some of these errors/discrepancies, an automatic correction function – the 
“Quickfix” – is offered. A Quickfix light bulb is displayed. Via the arrow button 

Fig. 12-5: Closed fold

Fig. 12-6: Opened fold
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next to the light bulb, the user can display various possible solutions and select 
one. 

12.5.9.1 Correcting or automatically declaring undeclared variables

Description Undeclared variables are displayed as follows:

 With a wavy red line in the code

 With a red mark in the analysis bar

The red color can also refer to a different error, however. If it refers to an un-
declared variable, the following tool tip is displayed if you hover with the mouse 
over the wavy line or mark: The declaration of variable [name] was not found.

Procedure 1. Place the cursor in the name underlined with the wavy line, or directly in 
front of the first letter or directly after the last letter.

Or: Click on the mark in the analysis bar.

The Quickfix light bulb is now displayed next to the variable name. 

2. Check if the variable name has been written incorrectly (differently from in 
the declaration).

 If so: correct. The wavy red line / mark disappears. No further steps are 
necessary.

 If not: continue with the next step.

3. Move the mouse pointer onto the Quickfix light bulb. An arrow is displayed 
next to the light bulb.

Click on the arrow. The following options are displayed:

 Declare the variable locally

 Declare the variable in the data list

4. Click on the desired option.

5. Only with Declare the variable in the data list: The data list is opened. 

Open the fold BASISTECH EXT.

6. A snippet for the variable declaration has been automatically inserted. The 
expected data type is highlighted in blue. The declaration is followed by 
the comment: ; This variable is for ....

 Accept or change the data type, as required. 

 Press the TAB key to jump to the comment. Edit the comment if re-
quired.

12.5.9.2 Removing unused variables

Description Unused variables are displayed as follows:

 With a wavy blue line in the code

 With a blue mark in the analysis bar

Hovering with the mouse over the wavy line or mark displays a tool tip with a 
description.

Fig. 12-7: Quickfix light bulb

This comment is displayed in the tool tip of the “Auto-complete” list if 
the variable is selected there.
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Procedure 1. Place the cursor in the name underlined with the wavy line, or directly in 
front of the first letter or directly after the last letter.

Or: Click on the mark in the analysis bar.

The Quickfix light bulb is now displayed next to the variable name. 

2. Move the mouse pointer onto the Quickfix light bulb. An arrow is displayed 
next to the light bulb.

Click on the arrow. The following options are displayed:

 Remove declaration

 Comment out declaration

3. Click on the desired option.

12.5.9.3 Standardizing the upper/lower case in a variable name

Description If the use of upper/lower case in a variable name is not uniform in the declara-
tion and in its other occurrences, this is displayed as follows:

 With a light blue wavy line in the code

 With a light blue mark in the analysis bar

Hovering with the mouse over the wavy line or mark displays a tool tip with a 
description.

Procedure 1. Place the cursor in the name underlined with the wavy line, or directly in 
front of the first letter or directly after the last letter.

Or: Click on the mark in the analysis bar.

The Quickfix light bulb is now displayed next to the variable name. 

2. Move the mouse pointer onto the Quickfix light bulb. An arrow is displayed 
next to the light bulb.

Click on the arrow. The following options are displayed:

 Change this use to [name as in declaration]

 Change declaration to [name as at this point in the program]

3. Click on the desired option.

12.5.10 Creating user-specific snippets

Description Users can create their own snippets. For this, the required properties must be 
saved in a file with the SNIPPET format. This file must then be imported in 
WorkVisual. The snippet is then available in the KRL Editor.

A template for a SNIPPET file is provided on the WorkVisual CD in the DOC 
directory. 

Procedure Once the SNIPPET file has been created, it must be imported as follows:

1. Select the menu sequence Extras > Import snippet from file …. A win-
dow opens.

2. Navigate to the directory where the SNIPPET file is located and select it. 
Click on Open.

The snippet is now available in the KRL Editor.

Example 1 A snippet is to be created to insert the following code structure:

A snippet that has been imported into WorkVisual is also available in 
OptionPackageEditor and vice versa. A precondition for this is that 
WorkVisual and OptionPackageEditor are running on the same PC 

and the same user is logged on.
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The snippet is to have the name “User” in the snippet list, and the tool tip 
should contain the information shown here: 

The SNIPPET file must have the following format:

Fig. 12-8: Code to be inserted by the snippet

Fig. 12-9: Desired snippet
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Fig. 12-10: Structure of the SNIPPET file

Line Description

3 … 48 Section for 1 snippet

A SNIPPET file may contain a number of these sections, i.e. a number of different 
snippets.

7 Title displayed in the tool tip

10 Name displayed in the snippet list

Note: The “Auto-complete” function reacts to this character string, i.e. if this string is 
entered in the program, the “Auto-complete” list is shown and the corresponding snip-
pet is selected.

13 … 15 Shortcuts for this snippet

18 The snippet is only displayed in the list in files with this extension

21 Description displayed in the tool tip

24 Name of the author displayed in the tool tip
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Example 2 An example of the <Snippet> section only:

12.6 Working online with the KRC Explorer

With the KRC Explorer, changes can be made directly on the file system of the 
robot controller without a project having to be transferred for this purpose.

27 … 30 This defines the ways in which the snippet can be inserted.

 Expansion: The snippet is inserted at the current cursor position.

 SurroundsWith: Before the snippet is inserted, program lines can be selected 
in the KRL Editor. The snippet is then automatically inserted so that it surrounds 
these lines. The exact position of these lines within the snippet is defined by the 
placeholder $selection$.

37 Placeholder occurring in lines 43 … 45, to which lines 38 and 39 refer

38 Tool tip displayed for this placeholder

39 Default value for the placeholder

43 … 45 Program text inserted by the snippet

The text consists of hard text and/or placeholders.

 $selection$: See description for SurroundsWith.

 $end$: This placeholder defines the position of the cursor after insertion of the 
snippet has been completed with the Enter key.

Line Description

Fig. 12-11: Code inserted by the snippet

Fig. 12-12: Structure of the SNIPPET file

This functionality is only available for robot controllers with KUKA 
System Software version 8.3.15 or higher or with VW System Soft-
ware version 8.3.11 or higher.
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For the editing procedure, WorkVisual creates a local copy of the file system; 
this is where the changes are carried out. The changes can be synchronized 
with the robot controller at any time; this includes individual changes.

The file system of the robot controller is referred to below as the working di-
rectory.

12.6.1 Opening the working directory in the KRC Explorer

Precondition  Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

 Programming and diagnosis workspace

Procedure 1. Click on the Create connection button.

Alternatively: Right-click in the empty space in the KRC Explorer and se-
lect Create connection from the context menu.

A window for selecting the robot controller is opened. In this window, it is 
possible to filter by type and version of the controller. There is also a 
search function available, which allows a search for the name of the con-
troller to be carried out.

2. Select the desired robot controller and confirm with OK. The working di-
rectory of the robot controller is loaded and displayed in the KRC Explorer.

12.6.2 KRC Explorer user interface

Fig. 12-13: KRC Explorer user interface
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12.6.2.1 Button bar in KRC Explorer

12.6.2.2 Icons in KRC Explorer

Item Description

1 Working directory of the robot controller

2 The icon indicates the current status of the folder or file. Hovering 
with the mouse over the icon displays a tool tip with a description 
of the status. Additional information is displayed for certain status-
es. If a file has been moved, for example, the original path is dis-
played in the tool tip.

 (>>> 12.6.2.2 "Icons in KRC Explorer" Page 127)

3 Button bar

 (>>> 12.6.2.1 "Button bar in KRC Explorer" Page 127)

4 The search box can be used to search for file and folder names.

Button Description

Shows or hides deleted files and folders.

Monitors changes on the file system of the robot controller. This 
icon is displayed after the name of modified files.

Module view

Shows SRC and DAT files combined as a module, like on the 
robot controller.

Shows all subprograms of a module in the working directory. 
Double-clicking on a subprogram shows the point in the editor 
at which the subprogram was defined.

Expands the selected node and all subnodes.

Collapses the selected node and all subnodes.

Icon Description

The file has been changed.

Module containing an SRC file and/or a DAT file.

Subprogram in an SRC file

The file or folder is unchanged.

The file or folder has been renamed.

The file has been renamed and changed.

The file or folder has been moved.

This icon is also displayed if the file was renamed before or 
after being moved.

The file or folder has been deleted.

A file that has been deleted can no longer be changed.

The file or folder has been added to the working directory.

This icon is also displayed if the file was changed, renamed or 
moved after being added.
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Icons in the module view:

Icons in the debugging mode:

12.6.3 Configuring KRC Explorer

Procedure 1. Select the menu sequence Extras > Options.... The Options window is 
opened.

2. On the left of the window, in the Online workspace folder, select the subi-
tem KRC Explorer.

The corresponding settings are now displayed on the right of the window.

3. Select the directory in which working directories are to be saved by default.

4. Click on OK to confirm. The settings are saved.

12.6.4 General edit functions

Standard edit functions can be called via the context menu. These include:

The file has been changed.

The file has been moved and changed.

Icon Description

The module has been changed and moved.

The module has been changed and renamed.

The SRC or DAT file has been changed and the other one has 
been deleted.

The SRC or DAT file has been changed and the other one 
remains unchanged.

The SRC or DAT file has been deleted and the other one 
remains unchanged.

The SRC or DAT file has been moved and the other one 
remains unchanged.

The SRC or DAT file has been renamed and the other one 
remains unchanged.

The SRC or DAT file has been changed and the other one has 
been renamed and changed.

The SRC or DAT file has been changed and renamed and the 
other one remains unchanged.

Icon Description

The program is linked.

The program is not selected.

The program has been selected and terminated.

The program has been selected and is being executed.

The program has been selected and stopped.

The program has been selected and reset.

Icon Description
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 Cut, Copy, Paste, Rename, Delete

In addition, the following commands are available in the context menu.

12.6.5 Creating a new file with template

Procedure 1. In the working directory, right-click on the folder in which the file is to be 
created.

2. Select Add... from the context menu. The Select template window opens.

3. Select the desired template.

The KUKA templates, templates from installed option packages and the 
templates of the current robot controller are available for choice as the 
template.

4. Enter a name in the Name box and confirm with OK.

12.6.6 Transferring changes to the robot controller

Description This procedure is used to transfer all changes or only selected changes in the 
working directory from WorkVisual to the real robot controller.

Precondition  Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

 “Expert” user group

 T1 or T2 mode

 Programming and diagnosis workspace

Procedure 1. To transfer all changes: Select the root node of the working directory.

To transfer selected changes: Select the file or folder that is to be trans-
ferred.

2. Click on the Transfer changes to the controller. button.

Alternatively: Right-click and select Transfer changes from the context 
menu.

The changes are checked for conflicts. A message is displayed if conflicts 
are detected. Conflicts must be resolved; otherwise, the changes cannot 

Menu item Description

Editor Opens the file in the KRL Editor.

Open with... Opens the file in the selected program.

Start debugging Starts the debugging mode.

Stop debugging Ends the debugging mode.

Open in Windows 
Explorer

Opens the selected directory or the directory of 
the selected file in Windows Explorer.

Add... Creates a file in the format of the selected tem-
plate under the selected folder.

 (>>> 12.6.5 "Creating a new file with tem-
plate" Page 129)

Save as template Saves the selected file as a template.

Disconnect VRC Terminates the connection to the robot control-
ler. The working directory is deleted.

New folder... Creates a new folder under the selected folder.

Compare with control-
ler version

Compares the selected file with the file on the 
robot controller.

Compare with...  (>>> 12.6.9 "Comparing files" Page 131)
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be transferred. If there are no conflicts, the changes are shown in an over-
view.

3. If you do not wish to transfer all the displayed changes: Deactivate the 
check boxes of the relevant changes.

4. Confirm with OK. The KUKA smartHMI displays the request for confirma-
tion The user […] has requested remote access to this controller. Do you want to 
allow remote access?.

5. Confirm the request with Yes. The changes will be transferred. The mes-
sage The user […] has remote access to this controller. is displayed on the sm-
artHMI. This access remains active until the message is acknowledged 
with Revoke.

12.6.7 Loading changes from the robot controller

Description This procedure is used to load all changes or only selected changes from the 
robot controller. Changes in the working directory that have not yet been trans-
ferred to the robot controller are displayed and can be undone.

Precondition  Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

 Programming and diagnosis workspace

Procedure 1. Either: Right-click on the root node of the working directory and select 
Load files from controller. All the changes are shown in an overview.

Or: Right-click on a folder in the working directory and select Load files 
from controller. The selected folder, the files contained in it and the 
changes to them are shown in an overview.

2. Activate or deactivate the check boxes of the changes as desired and con-
firm with OK. The selected changes will be carried out.

12.6.8 Restoring the state of the robot controller

Description This procedure is used to discard all local changes in the working directory and 
to restore the state of the robot controller.

Precondition  Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

 Programming and diagnosis workspace

Procedure 1. Right-click on the root node of the working directory and select Establish 
controller state.

If a file contains different changes in the working directory in WorkVi-
sual and on the real robot controller, there are 3 possibilities:

Make no changes

 Overwrite the file on the real robot controller with the file in the working 
directory

 Merge the files

An external editor is required to merge the files.
 (>>> 6.27.4 "Configuring additional editors" Page 61)

After changes have been transferred, all programs must 
be tested in T1 mode. Damage to property may other-

wise result.
This applies particularly if the transfer procedure was interrupted and not all 
changes were carried out.
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2. Answer the request for confirmation with Yes. The state of the real robot 
controller is restored and all changes are overwritten.

12.6.9 Comparing files

Description This procedure is used to compare a file in the working directory in WorkVisual 
with the same file on the robot controller. The file can also be compared with 
a file on the local hard drive.

Precondition  Programming and diagnosis workspace

Only for comparison with the robot controller:

 Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

Procedure Comparison with the file on the robot controller:

 Either: Right-click on the file in the working directory and select Compare 
with controller version from the context menu. The files are opened with 
the editor that has been configured as the default editor for comparisons.

 Or: Select Compare with... > File on controller from the context menu 
and select the desired editor. The files are opened with the desired editor.

Comparison with a file on the local hard drive:

1. Right-click on the file in the working directory, select Compare with... > 
Local file from the context menu and select the desired editor. A window 
opens.

2. Navigate to the path where the file for comparison is located.

3. Select the file and confirm with Open. The files are opened with the de-
sired editor.

12.7 Debugging programs

WorkVisual provides a debugging mode with which errors can be found in run-
ning programs. Programs with subprograms can also be debugged.

Any appropriate software can be used for the comparison. It must be 
installed and configured in WorkVisual, however.
 (>>> 6.27.4 "Configuring additional editors" Page 61)
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12.7.1 Overview of the debugging mode

Fig. 12-14: Debugging mode

Item Description

1 Working directory in the debugging mode

2 Program running in the debugging mode

3 Current position of the block pointer

4 Current position of the advance run pointer

5 Monitoring window

 (>>> 12.7.3 "Monitoring variables" Page 134)

6 Debugging window

 (>>> 12.7.2 "Starting the debugging mode" Page 133)

Point-
er

Description

Block pointer

The end point is being approached.

Advance run pointer

The block pointer is located in a subprogram.

The block pointer and advance run pointer are located in the 
same line. The end point has been reached with exact position-
ing.
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The following buttons are only available when an OPS is used:

12.7.2 Starting the debugging mode

Precondition  Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

 “Expert” user group

 T1 or T2 mode

 Programming and diagnosis workspace

 The working directory is open in the KRC Explorer and the state corre-
sponds to that of the real robot controller.

Procedure 1. Only if the Debugging window is not yet displayed: Display it by selecting 
the menu sequence Window > Debugging.

2. Right-click on the working directory in the KRC Explorer and select Start 
debugging.

Alternatively: Click on the  button.

3. Select and start the desired program on the smartHMI.

The block pointer and advance run pointer are located in the 
same line. The end point is being approached.

Block pointer

The end point has been reached with exact positioning.

The block pointer is located in a program line higher up in the 
program.

The block pointer is located in a program line lower down in the 
program.

The block pointer is located in a subprogram. The current pro-
gram line is located higher up in the program.

The block pointer is located in a subprogram. The current pro-
gram line is located lower down in the program.

Button Description

Starts the debugging mode.

Ends the debugging mode.

Button Description

Starts the program.

Stops the program.

Resets the program.

Point-
er

Description
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12.7.3 Monitoring variables

Description During debugging, the state of variables in the program can be monitored. 
There are 2 monitoring windows available for this. Mathematical calculations 
(e.g. variable + 5) and expressions as well as nested structures and arrays are 
also evaluated in these windows. If a value changes, it is displayed in red for 
a few seconds in the monitoring window.

The following variables can be monitored:

Fig. 12-15: “Debugging” window

Item Description

1 The robot controllers whose working directory has been loaded 
into WorkVisual are displayed here.

2 The current program run mode is displayed here. A different pro-
gram run mode can be selected. This setting is only relevant if an 
OPS is used.

3 These lines indicate the programs and lines in which the block 
pointer and advance run pointer are currently located.

4 List of calls

These lines indicate which programs or functions within programs 
are called. Double-clicking on a line jumps directly to the relevant 
point in the program. 

In this example, a function is called in line 283 in the program 
h50.SRC. From this function, a function or a program in the pro-
gram palette.SRC is called in line 338.

Button Description

Starts the debugging mode.

Ends the debugging mode.

Indicates the block pointer in the editor.

Indicates the advance run pointer in the editor.

Indicates in the editor that the block pointer is located in a sub-
program.

Scrolls automatically to the point in the program at which the 
block pointer is located.

Indicates subprograms already opened in the foreground if the 
block pointer is located in them.

Opens an editor for each subprogram called.
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 Variables that have been declared globally (in the file $CONFIG.DAT or in 
a DAT file containing the keyword PUBLIC)

 Variables that have been declared locally in the DAT file (globally for the 
module)

 Variables that have been declared locally in the SRC file while the ad-
vance run pointer is located in the same program as the declaration (run-
time data)

Precondition  The debugging mode has been started.

Procedure 1. Display the monitoring window by selecting the menu sequence Window 
> Monitoring window 1 or Monitoring window 2.

2. Right-click on the desired variable in the program and select Monitor.

Alternatively: Click on an empty row in the Name column and enter the 
name of the desired variable. During entry, variables are suggested that 
are contained in the current program or have been globally defined.

12.7.4 Ending the debugging mode

Procedure  Right-click on the working directory in the KRC Explorer and select Stop 
debugging.

Alternatively: Click on the  button.

Fig. 12-16: Monitoring window

Item Description

1 The robot controllers for which the debugging mode has been 
started are displayed here.

2 All the groups of variables present in the monitoring window are 
displayed here. A filter can be set for each group.

Button Description

Loads variables in the ConfigMon.INI format

Saves variables in the ConfigMon.INI format

Icon Description

Variables that have been declared in either the DAT file or the 
SRC file

Signals (e.g. inputs and outputs)

Mathematical calculations and expressions
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13 Transferring and activating the pro...
13 Transferring and activating the project

13.1 Generating code

Description When a project is transferred to the robot controller, the code is always gener-
ated first. This procedure can be used to generate the code separately and 
thus to check in advance whether generation runs without error.

The code is displayed on the Files tab of the Project structure window.

Automatically generated code is displayed in pale gray.

Procedure  Select the menu sequence Extras > Generate code.

The code is generated. When the process is finished, the following messages 
are displayed in the message window: The project <"{0}" V{1}> has been 
compiled. The results can be seen in the file tree.

13.2 Pinning a project

Description Projects that are present on the robot controller can be pinned. A project can 
be pinned directly on the robot controller or in WorkVisual.

Pinned projects cannot be changed, activated or deleted. They can be copied 
or unpinned, however. A project can thus be pinned e.g. to prevent it from be-
ing accidentally deleted.

Procedure Pinning in WorkVisual:

1. Select the menu sequence: File > Browse for project. The Project Ex-
plorer is opened. On the left, the Search tab is selected.

2. In the Available cells area, expand the node of the desired cell. All the ro-
bot controllers of this cell are displayed.

 

T

s

f

Fig. 13-1: Example of code generation: before – after
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3. Expand the node of the desired robot controller. All projects are displayed. 
Pinned projects are indicated by a pin symbol.

4. Select the desired project and click on the Pin project button. The project 
is pinned and labeled with a pin symbol in the project list.

13.3 Assigning the robot controller to the real robot controller

Description This procedure is used to assign every robot controller in the project to a real 
robot controller. The project can then be transferred from WorkVisual to the 
real robot controller.

Precondition  A robot controller has been added in WorkVisual.

 Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

If the project is subsequently to be transferred and also activated:

 The user group “Expert” or higher is selected on the real robot controller.

Restriction: If the activation would cause changes in the area Safety-rel-
evant communication parameters, the user group “Safety recovery” or 
higher must be selected.

 If the operating mode AUT or AUT EXT is selected on the real robot con-
troller: The project contains only settings that affect KRL programs. If the 
project contains settings that would cause other changes, it cannot be ac-
tivated. 

Procedure 1. Click on the Deploy… button in the menu bar. The WorkVisual Project 
Deployment window is opened. The virtual robot controller from the proj-
ect is displayed on the left-hand side. The target controller is displayed on 
the right-hand side. It is grayed out when a controller has not yet been se-
lected.

2. On the left, activate the virtual cell by means of the check box. This cell 
must now be assigned to the real robot controller.

Information about pinning on the robot controller can be found in the 
Operating and Programming Instructions for System Integrators 
for the KUKA System Software.

Fig. 13-2: Assigning the robot controller to the cell
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3. Click on the … button. A window opens. The filter is automatically set to 
only display controllers of the same type and version as the virtual control-
ler. This setting can be changed.

4. Select the real robot controller and click on the Ok button. The real robot 
controller is assigned to the virtual robot controller. Once it is assigned, the 
real robot controller is displayed in color and with its name and IP address.

5. If the project contains more than one robot controller, repeat steps 3 and 
4 for the other robot controllers.

6. Click on Next. The assignment is checked for conflicts. A message is dis-
played if conflicts are detected. Conflicts must be resolved; otherwise, the 
project cannot be transferred. If no conflicts are present, the code is gen-
erated automatically.

7. The project can now be transferred to the robot controller.

Fig. 13-3: Assigning a real robot controller to the virtual controller

Fig. 13-4: Overview
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Alternatively, the project can be transferred at a later point in time. To do 
this, click on Cancel: The assignment is saved and the WorkVisual Proj-
ect Deployment window is closed.

13.4 Transferring the project to the robot controller

Description This procedure is used to transfer the project from WorkVisual to the real robot 
controller.

Precondition  The project has been assigned to the real robot controller.

 Assignment conflicts have been resolved.

 Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

If the project is also to be activated:

 The user group Expert or higher is selected on the real robot controller.

Restriction: If the activation would cause changes in the area Safety-rel-
evant communication parameters, the user group “Safety recovery” or 
higher must be selected.

 If the operating mode AUT or AUT EXT is selected on the real robot con-
troller: The project contains only settings that affect KRL programs. If the 
project contains settings that would cause other changes, it cannot be ac-
tivated. 

Procedure 1. Click on the Deploy… button in the menu bar. The WorkVisual Project 
Deployment window is opened.

If a project was transferred to the real robot controller at an earlier 
time and has not yet been activated then this will be overwritten if a 
further project is transferred.

Transferring and activating a project overwrites a project of the same name 
that already exists on the real robot controller (after a request for confirma-
tion).

If one of the options KUKA.SafeOperation or KUKA.SafeRangeMon-
itoring is installed on the robot controller, different user groups may 
apply. Information can be found in the documentation for these op-

tions.

If a project is transferred containing an option package that has been 
inserted into the project without a window showing the changes being 
displayed, then the following procedure must be observed:

1. Transfer the project to the robot controller, but DO NOT activate it!

2. Install the option package on the robot controller.

Installation is performed in the normal manner. Information about this can 
be found in the documentation for the option package.

3. Transfer the active project from the robot controller to WorkVisual and 
carry out the user configuration.

4. Transfer the project back to the robot controller.

5. Activate the project on the robot controller.
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2. Click on Next. Program generation begins.

3. Click on Next. The project is transferred.

4. Click on Next.

5. Only in operating modes T1 and T2: The KUKA smartHMI displays the re-
quest for confirmation Do you want to activate the project […]?. In addition, a 
message is displayed as to whether the activation would overwrite a proj-
ect, and if so, which.

If no relevant project will be overwritten: Confirm with Yes within 30 min-
utes.

6. An overview is displayed of the changes which will be made in comparison 
to the project that is still active on the robot controller. The check box De-
tails can be used to display details about the changes.

7. The overview displays the request for confirmation Do you want to continue?. 
Confirm with Yes. The project is activated on the robot controller. A confir-
mation is displayed in WorkVisual.

Fig. 13-5: Overview

If a project has been transferred containing an option package that 
was inserted into the project without a window showing the changes 
being displayed:

Do not activate the project, i.e. do not continue with the next step! Observe 
the note about projects with option packages at the beginning of this section!

In the operating modes AUT and AUT EXT, the project is 
activated without any request for confirmation if there are 

only program changes.

If changes are listed in the overview under the heading 
Safety-relevant communication parameters, this 

means that the behavior of the Emergency Stop and “Operator safety” signal 
may have changed compared with the previous project. 
After activation of the project, the Emergency Stop and the “Operator safety” 
signal must be checked for safe functioning. If the project is activated on sev-
eral robot controllers, this check must be carried out for every robot control-
ler. Failure to carry out this check may result in death, injuries or damage to 
property.
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8. Close the WorkVisual Project Deployment window by selecting Finish.

9. If the request for confirmation on the robot controller is not answered within 
30 minutes, the project is still transferred, but is not activated on the robot 
controller. The project can then be activated separately.

 (>>> 13.5 "Activating a project" Page 142)

13.5 Activating a project

 A project can be activated on the robot controller from within WorkVisual.

 (>>> 13.5.1 "Activating a project (in WorkVisual)" Page 142)

 A project can be activated directly on the robot controller.

13.5.1 Activating a project (in WorkVisual)

Precondition  Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

Fig. 13-6: Confirmation in WorkVisual

After activation of a project on the robot controller, the 
safety configuration must be checked there! If this is not 

done, the robot will possibly be operated with incorrect data. Death, injuries 
or damage to property may result.
 (>>> 13.6 "Checking the safety configuration of the robot controller" 
Page 144)

If the activation of a project fails, an error message is dis-
played in WorkVisual. In this case, one of the following 

measures must be carried out:

 Rectify the fault and restart the activation by clicking on the  button.

 Or activate a different project.

 Or: Reboot the robot controller with a cold restart.

Information about activation on the robot controller can be found in 
the Operating and Programming Instructions for System Integra-
tors for the KUKA System Software.
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 The user group “Expert” or higher is selected on the real robot controller.

Restriction: If the activation would cause changes in the area Safety-rel-
evant communication parameters, the user group “Safety recovery” or 
higher must be selected.

 If the operating mode AUT or AUT EXT is selected on the real robot con-
troller: The project can only be activated if this affects only KRL programs. 
If the project contains settings that would cause other changes, it cannot 
be activated. 

Procedure 1. Select the menu sequence: File > Browse for project. The Project Ex-
plorer is opened. On the left, the Browse tab is selected.

2. In the Available cells area, expand the node of the desired cell. All the ro-
bot controllers of this cell are displayed.

3. Expand the node of the desired robot controller. All projects are displayed. 
The active project is indicated by a small green arrow.

4. Select the desired project and click on the Activate project button. The 
Deploy Project window is opened.

5. Click on Next.

6. Only in operating modes T1 and T2: The KUKA smartHMI displays the re-
quest for confirmation Do you want to activate the project […]?. In addition, a 
message is displayed as to whether the activation would overwrite a proj-
ect, and if so, which.

If no relevant project will be overwritten: Confirm with Yes within 30 min-
utes.

7. On the KUKA smartHMI, an overview is displayed of the changes which 
will be made in comparison to the project that is still active on the robot 
controller. The check box Details can be used to display details about the 
changes.

If one of the options KUKA.SafeOperation or KUKA.SafeRangeMon-
itoring is installed on the robot controller, different user groups may 
apply. Information can be found in the documentation for these op-

tions.

If a project has been transferred containing an option package that 
was inserted into the project without a window showing the changes 
being displayed:

Do not activate the project! For such projects, the procedure differs from the 
usual procedure for transfer and activation. Further information can be found 
in the section on project deployment. 
 (>>> 13.4 "Transferring the project to the robot controller" Page 140)

In the operating modes AUT and AUT EXT, the project is 
activated without any request for confirmation if there are 

only program changes.

If changes are listed in the overview under the heading 
Safety-relevant communication parameters, this 

means that the behavior of the Emergency Stop and “Operator safety” signal 
may have changed compared with the previous project. 
After activation of the project, the Emergency Stop and the “Operator safety” 
signal must be checked for safe functioning. If the project is activated on sev-
eral robot controllers, this check must be carried out for every robot control-
ler. Failure to carry out this check may result in death, injuries or damage to 
property.
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8.  The overview displays the request for confirmation Do you want to conti-
nue?. Confirm with Yes. The project is activated on the robot controller. A 
confirmation is displayed in WorkVisual.

9. In WorkVisual, close the Project deployment window by selecting Exit.

10.  Click on Refresh in the Project Explorer. The active project is now indi-
cated by a small green arrow. (The small green arrow disappears from the 
project that was active before.)

13.6 Checking the safety configuration of the robot controller

Description The safety configuration of the robot controller must be checked in the follow-
ing cases:

 After activation of a WorkVisual project on the robot controller

 Generally after changes to the machine data (independent of WorkVisual).

13.7 Loading the project from the robot controller

Description On every robot controller to which a network connection is established, a proj-
ect can be selected and loaded in WorkVisual. This is also possible if this proj-
ect is not yet present on this PC.

The project is saved in the directory: …\WorkVisual Projects\Download-
ed Projects.

Precondition  Network connection to the real robot controller

Procedure 1. Select the menu sequence: File > Browse for project. The Project Ex-
plorer is opened. On the left, the Search tab is selected.

2. In the Available cells area, expand the node of the desired cell. All the ro-
bot controllers of this cell are displayed.

3. Expand the node of the desired robot controller. All projects are displayed.

4. Select the desired project and click on Open. The project is opened in 
WorkVisual.

After activation of a project on the robot controller, the 
safety configuration must be checked there! If this is not 

done, the robot will possibly be operated with incorrect data. Death, injuries 
or damage to property may result.
 (>>> 13.6 "Checking the safety configuration of the robot controller" 
Page 144)

If the activation of a project fails, an error message is dis-
played in WorkVisual. In this case, one of the following 

measures must be carried out:

 Either: Activate a project again (the same one or a different one).

 Or: Reboot the robot controller with a cold restart.

If the safety configuration is not checked and updated 
where necessary, it may contain incorrect data. Death, 

injuries or damage to property may result.

Information about checking the safety configuration and the safe axis 
monitoring functions is contained in the Operating and Programming 
Instructions for System Integrators.
Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



13 Transferring and activating the pro...
13.8 Comparing projects (and accepting differences)

Description A project in WorkVisual can be compared with another project. This can be a 
project on a robot controller or a locally saved project. The differences are 
clearly listed. The user can decide for each individual difference whether to 
leave the state as in the current project or to transfer the state from the other 
project.

Precondition  The project that is to be compared is open in WorkVisual.

If the other project to be compared is located on a robot controller:

 The real robot controller is running.

 Network connection to the real robot controller

Procedure 1. In WorkVisual, select the menu sequence Extras > Compare projects. 
The Compare projects window is opened.

2. Select the project with which the current WorkVisual project should be 
compared, e.g. the project of the same name on the real robot controller.

3. Click on Next. A progress bar is displayed. (If the project contains more 
than one controller, a bar is displayed for each one.)

 (>>>  "Progress bars" Page 146)

4. When the progress bar is full and the message Status: Ready for merge 
is displayed: Click on Show differences. The differences between the 
projects are displayed in an overview.

 (>>>  "Comparison" Page 146)

If no differences were determined, this is indicated in the message win-
dow. Continue with step 8. After this, no further steps are necessary.

5. For each difference, select whether to retain the state of the current project 
or to adopt the state of the comparison project. This does not have to be 
done for all the differences at one go.

If suitable, the default selection can also be accepted.

6. Press Merge to transfer the changes to WorkVisual.

7. Repeat steps 5 to 6 as required. This makes it possible to work through 
the different areas bit by bit.

Once all the differences have been reconciled, the following message is 
displayed: No further differences were detected.

8. Close the Compare projects window.

9. Save the project.

Fig. 13-7: Selecting a project for “Compare”
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Progress bars

This view shows all the robot controllers which are contained in the project. A 
separate bar is displayed for each of these robot controllers. For each bar, the 
real robot controller to which the project was last transferred is also specified. 
The check boxes are used to select for which robot controllers the comparison 
should be carried out.

If additional robot controllers were added or removed in WorkVisual after de-
ployment, these robot controllers are also displayed here. They are marked as 
invalid, however, and cannot be selected.

Comparison The differences between the projects are displayed in an overview. For each 
difference, the user can select which state to accept. The default setting is as 
follows:

 For all elements that are present in the open project, the state of this proj-
ect is selected.

 For all elements that are not present in the open project, the state of the 
comparison project is selected.

Fig. 13-8: Example: progress bar

Exception: For projects with a VKRC 4 controller, the state of the 
comparison project is always selected for the long texts.
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Fig. 13-9: Example: overview of differences

Item Description

1 The node for the robot controller. The various project areas are represented by sub-
nodes. The nodes can be expanded to display the comparisons.

If several robot controllers are present, these are listed one after the other.

 In each line, place a check mark in the box for the value that should be transferred. 

 A check mark next to Not available means that the element will not be transferred, 
or that it will be deleted from the project if already present.

 If a check box is activated for a node, the check boxes for all subordinate elements 
are also automatically activated.

If a check box is deactivated for a node, the check boxes for all subordinated ele-
ments are also automatically deactivated.

The subordinate elements can also be edited individually, however.

 A filled-in box means: at least one of the subordinate elements is selected, but not 
all.

2 State of the project that is open in WorkVisual

3 State of the comparison project

4 Back arrow: The focus in the display jumps to the previous difference.

Forward arrow: The focus in the display jumps to the next difference.

Collapsed nodes are automatically expanded.

5 TRUE: Detailed information is shown for the selected line in the overview.

6 Filter

7 Transfers the selected changes to the open project.
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14 Diagnosis

14.1 Project analysis

14.1.1 Analyzing a project automatically for errors

Description In WorkVisual, it is possible to analyze the current project continuously in the 
background. If configuration errors are detected, WorkVisual alerts the user. 
In addition, an automatic correction is offered for many errors.

An icon in the bottom right corner of the user interface indicates the status of 
the project analysis.

Precondition  Project analysis is activated.

Procedure 1. Depending on the configuration: 

 The WorkVisual project analysis window opens automatically if the 
icon is red or yellow. 

 Or: Click on the icon to open the WorkVisual project analysis win-
dow.

2. The window displays a brief description of the error. Often one or more 
possibilities for correction are displayed beneath the description.

Click on the desired correction proposal. 

14.1.2 Configuring the project analysis function

Procedure 1. Select the menu sequence Extras > Options. The Options window is 
opened.

4

 

s

s

Icon Color Description

Green WorkVisual has not detected any errors.

Yellow WorkVisual has detected a discrepancy. The discrep-
ancy will not prevent the project from running on a real 
robot controller. However, the discrepancy is probably 
not intended or desired by the user.

Red WorkVisual has detected an error. The project is 
unable to run on a real robot controller in this state. The 
error would come to light during code generation or, at 
the very latest, on the real robot controller.

Gray The analysis is deactivated.

The project analysis detects a wide range of errors and gives the user 
valuable support. A green icon cannot guarantee that the project is 
free from configuration errors, however. 

Fig. 14-1: Example: WorkVisual project analysis, with correction propos-
al
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2. On the left of the window, select the Project analysis folder.

The corresponding settings are now displayed on the right of the window.

3. Make the desired settings. Confirm with OK.

Description Setting options in the Project analysis folder:

14.2 Trace

Trace recordings are an important diagnostic tool during start-up of the indus-
trial robot and during troubleshooting. They are also used for optimization of 
the machine data. The trace function can be used to record different variables 
with the program running, e.g. actual current, setpoint current, states of inputs 
and outputs, etc. The recording can then be displayed using the oscilloscope.

In WorkVisual it is possible to configure trace recordings and transfer them to 
the robot controller. The recording can also be started in WorkVisual. In addi-
tion, trace configurations can be imported from the robot controller to WorkVi-
sual. The results of trace recordings can also be imported to WorkVisual. The 
oscilloscope function is also available here for display and evaluation.

14.2.1 Configuring and starting the trace recording

Description During configuration, the data to be recorded are specified. The robot control-
ler saves the recording in the directory: C:\KRC\ROBOTER\TRACE.

Precondition  Programming and diagnosis workspace

Procedure 1. Select the menu sequence Editors > Trace configuration. The Trace 
configuration window opens.

2. Select a configuration or create a new configuration on the General tab. 
Edit the configuration if required.

 (>>> 14.2.4 "“Trace configuration” window" Page 152)

3. In the Cell view window, select the robot controllers to which the configu-
ration is to be transferred.

4. On the General tab, click on the Save configuration on controller but-
ton.

5. Respond to the request for confirmation asking whether the configuration 
should be activated by pressing Yes.

6. Click on the Start trace button to start the recording. The recording is start-
ed in accordance with the defined trigger.

Or: Click on Trigger. The recording starts immediately.

The State box jumps from #T_END to either #T_WAIT or #TRIGGERED.

Item Description

Analysis activated  Check box active: The project is analyzed 
continuously. If errors or discrepancies are 
detected, these are displayed in the WorkVi-
sual project analysis window.

 Without: The project is not analyzed and no 
messages are displayed.

Automatic notifica-
tion activated

 Check box active: The WorkVisual project 
analysis window opens automatically when-
ever an error or discrepancy is detected.

 Without: The WorkVisual project analysis 
window opens only when the icon is clicked.
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7. The recording is ended when the State box displays the value #T_END 
again.

14.2.2 Importing a trace configuration

Description Trace configurations can be imported. They are then available under local in 
the Source box of the Trace configuration window.

Procedure 1. The import/export function can be accessed in one of the following ways:

 Select the menu sequence Editors > Trace configuration. The 
Trace configuration window is opened.

On the General tab, click on the Import/export of trace configura-
tions button.

Or:

 Select the menu sequence File > Import / Export. A window opens.

Select Import/export trace configurations and click on Next.

2. Select the Import option.

3. If the desired directory is not displayed in the Source directory box:

Click on Browse and navigate to the directory where the configuration is 
located. Select the directory and confirm selection with OK.

The configurations located in the directory are displayed.

4. Specify whether existing data are to be overwritten.

5. Click on Finish.

6. The data are imported. If the import was successful, this is indicated by a 
message in the window. Close the window.

14.2.3 Exporting a trace configuration

Procedure 1. The import/export function can be accessed in one of the following ways:

 Select the menu sequence Editors > Trace configuration. The 
Trace configuration window is opened.

On the General tab, click on the Import/export of trace configura-
tions button.

Or:

 Select the menu sequence File > Import / Export. A window opens.

Select Import/export trace configurations and click on Next.

2. Select the Export option. All configurations stored locally are displayed.

3. If the desired directory is not displayed in the Target directory box:

Click on Browse and navigate to the desired directory. Select the directory 
and confirm selection with OK.

4. Specify whether existing data are to be overwritten.

5. Click on Finish.

6. The data are exported. If the export was successful, this is indicated by a 
message in the window. Close the window.
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14.2.4 “Trace configuration” window

14.2.4.1 “General” tab

Fig. 14-2: “General” tab

Item Description

1  local: The predefined and the locally saved configurations are available for selection 
in the Configuration box.

 [Robot controller]: All the configurations saved on this robot controller are available for 
selection in the Configuration box. (In addition to those under local.) 

Robot controllers are only displayed in the Source box if they are selected in the Cell 
view window.

2 A configuration can be selected here. The configuration can be edited on the tabs and 
then saved locally or on a robot controller.

3 Opens a window in which a name for a new configuration can be entered. An existing 
local configuration can be selected as a template for the new configuration. On confirm-
ing the entries with OK, the new configuration is inserted in the list under local.

This button is only displayed if the entry local is selected in the Source box.

4 Deletes the configuration displayed in the Configuration box.

5 Saves locally the configuration displayed in the Configuration box. The settings on the 
tabs are accepted.

6 Opens a window for the import/export of trace configurations.

7 Activates the configuration displayed in the Configuration box on the robot controllers 
selected in the Cell view window.

If the request for confirmation is answered with No, the configuration is still saved on the 
robot controller, but is not activated there.
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14.2.4.2 “Trigger” tab

Triggers can be selected here. Triggers control when data is recorded.

Strictly speaking, data are recorded as soon as the Start trace button is 
pressed. The trigger merely controls which time phase of the recording is then 
displayed in the trace files.

8 Name for the recording. The name can be changed. The robot controller adds extensions 
to the end of the name, indicating what data have been recorded.

9 Duration of the recording. Only whole numbers can be entered. Maximum value: 9999 s

10 The position of the time phase displayed in the recording relative to the trigger. The % 
value refers to the duration of the recording.

Examples:

 0%: The displayed time phase starts at the trigger.

 30%: 30% of the displayed time phase comes before the trigger, 70% after the trig-
ger.

 100%: The displayed time phase ends at the trigger.

All of the following elements are only displayed if a robot controller is selected in the Source box.

11 Trace configuration that is currently active on the robot controller.

12  #T_START: Recording is running.

 #T_STOP: Recording is not running.

13 State of the recording

 #T_WAIT: The recording is started and is waiting for the trigger.

 #TRIGGERED: The recording continues for the time defined by the trace length and 
trigger.

 #T_END: No recording is running.

14 Starts the recording with the configuration displayed under Trace file. This button is only 
displayed if no recording has been started yet.

15 Stops the recording. This button is only displayed if a recording has been started.

16 Starts the recording. This button is only displayed if a recording has already been started.

Strictly speaking, data are recorded as soon as the Start trace button is pressed. The 
trigger merely controls which time phase of the recording is then displayed in the trace 
files.

Item Description
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14.2.4.3 “I/O” tab

Here you can select which inputs or outputs are to be recorded.

Fig. 14-3: “Trigger” tab

Item Description

1 A module can be selected here. The modules contain numerous predefined triggers.

2 This box is only displayed if the selected module refers to the robot axes. It is possible to 
select the axes to which the triggers are to refer.

3 All the triggers for this module are displayed here.

RIGHT ARROW copies triggers selected here to the Selected trigger box. (Alternatively: 
double-click on a trigger.)

4 Depending on the entry selected under available triggers, filters are available here for 
this entry.

5 Here the triggers are inserted that are to be used for the current configuration.

LEFT ARROW removes the triggers selected here. (Alternatively: double-click on a trig-
ger.)

DOUBLE LEFT ARROW clears this box.

Group combines all entries of the same type into a single entry. This gives greater clarity 
to the display. It has no effect on the recording.

Ungroup undoes the grouping.
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14.2.4.4 “Configuration” tab

The settings on the Extended configuration tab are also displayed on the 
Configuration tab, and vice versa.

Fig. 14-4: “I/O” tab

Item Description

1 All the available inputs/outputs are displayed here.

2 Here a number range can be specified from the entry selected under Available chan-
nels.

3 Select the desired recording rate.

4 Here the inputs/outputs are inserted that are to be recorded with the current configura-
tion.

RIGHT ARROW transfers all the inputs/outputs selected via Available channels and 
From ID […] to ID […] to this box. LEFT ARROW removes the inputs/outputs selected 
here. (Alternative to these arrow keys: double-click on a channel.)

DOUBLE LEFT ARROW clears this box.

5 Group combines all entries of the same type into a single entry. This gives greater clarity 
to the display. It has no effect on the recording.

Ungroup undoes the grouping.
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14.2.4.5 “Extended configuration” tab

The Extended configuration tab contains the same modules as the Config-
uration tab, but with more channels and more detailed selection options. Ex-
tended configuration is particularly suitable for expert users. 

The settings on the Extended configuration tab are also displayed on the 
Configuration tab, and vice versa.

Fig. 14-5: “Configuration” tab

Item Description

1 It is possible to select here how many axes are displayed in the Available channels dis-
play. 

2 The version of the system software to which the entries on this tab refer must be selected 
here. 

Note: First select the correct version here, then make the other settings on this tab! Is 
the version is changed, any channels that have been selected are discarded. 

3 Here you can select the channels that are to be recorded.

 To select a channel for individual axes, check the box for the relevant axes.

 To check or uncheck all the boxes in one row, double-click on the row.

Channels that are not axis-specific have only one check box.

4 All the selected channels are displayed here. 

Note: It is possible that channels may be displayed here which cannot be selected on the 
Configuration tab. This is the case if these channels have been selected on the Extend-
ed configuration tab.
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14.2.5 Importing a trace recording

Description To be able to display a trace recording in WorkVisual, it must first be imported.

Precondition  The recording was created with KSS or VSS 8.1 or higher, or with 5.4.

Procedure 1. Select the menu sequence File > Import / Export. A window opens.

2. Select Import trace results and click on Next.

3. Click on Browse and navigate to the directory where the results are locat-
ed. Select the directory and confirm selection with OK.

All trace files located in the directory are displayed.

4. Select the traces to be imported.

Fig. 14-6: “Extended configuration” tab

Item Description

1 A module can be selected here. The modules contain different channels.

2 This box is only displayed if the selected module refers to the robot axes. It is possible to 
select the axes to which the channels are to refer.

3 All the channels for the selected module are displayed here.

4 Here the channels are inserted that are to be recorded with the current configuration.

RIGHT ARROW transfers all the entries selected under Available channels to this box. 
LEFT ARROW removes the entries selected here. (Alternative to these arrow keys: dou-
ble-click on an entry.)

DOUBLE LEFT ARROW clears this box.

5 Select the desired recording rate.

6 Group combines all entries of the same type into a single entry. This gives greater clarity 
to the display. It has no effect on the recording.

Ungroup undoes the grouping.
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5. Specify whether existing data are to be overwritten.

6. Select the appropriate entry in the Format box.

7. Click on Finish.

8. The data are imported. If the import was successful, this is indicated by a 
message in the window. Close the window.

14.2.6 Displaying a trace recording

Precondition  Programming and diagnosis workspace

 The recording has been imported to WorkVisual.

Procedure 1. Select the menu sequence Editors > Trace Analysis (Oscilloscope). 
The Trace Analysis (Oscilloscope) window opens.

2. On the Channels tab, select a recording.

 (>>> 14.2.7.1 "“Channels” tab" Page 158)

3. Select the channels to be displayed.

4. The channels are displayed on the Oscilloscope tab. Adapt the display, 
if necessary. (E.g. zoom or change the colors of the traces.)

14.2.7 “Trace Analysis” window

14.2.7.1 “Channels” tab

Fig. 14-7: “Channels” tab
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14.2.7.2 “Oscilloscope” tab

Item Description

1  Local: All the locally saved recordings are available for selection in the Trace re-
cording box.

 [Robot controller]: All the recordings saved on this robot controller are available for se-
lection in the Trace recording box. (In addition to those under local.) 

Robot controllers are only displayed in the Source box if they are selected in the Cell 
view window.

2 A recording can be selected here.

3 Detailed information regarding the selected recording is displayed here.

4 Only active if the entry Local is selected in the Source box:

Deletes the recording selected in the Trace recording box.

5 Only active if a robot controller is selected in the Source box:

Creates a local copy of the selected recording.

6 All the channels contained in the selected recording are displayed here.

7 Here the channels are inserted that are to be displayed in the oscilloscope. It is possible 
to insert entries from different recordings in this box.

RIGHT ARROW moves all the entries selected under Available channels to this box. 
LEFT ARROW removes the entries selected here. (Alternative to these arrow keys: dou-
ble-click on the entry.)

DOUBLE LEFT ARROW clears this box.

Fig. 14-8: “Oscilloscope” tab
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Check box Description

Show settings Activated: The columns Active, Trace name, etc., are displayed.

Display cursor coor-
dinates

Activated: The X and Y coordinates of the mouse pointer position are 
displayed in the diagram.

Scale automatically Activated: The curves are adapted to one another in size so that they 
are easier to compare visually.

The proportions between the curves then usually no longer correspond 
to reality. The current factor is displayed under Autoscale factor, how-
ever.

Move automatically Activated: The midpoints of the curves are aligned.

This option makes it possible to compare curves which lie far apart on 
the Y axis. The Y values then usually no longer correspond to reality. 
The current factor is displayed under Move factor, however.

Show legend Activated: The diagram displays which channel name belongs to which 
trace color.

Column Description

Active Activated: The curve is displayed in the oscilloscope.

Deactivated: The curve is displayed in the oscilloscope.

Trace name Name of recording

Module name Name of the module

Channel name Name of channel

Unit Unit for the Y axis of the oscilloscope display (can be different for each 
curve)

MathFunc Mathematical functions that can be applied to the curve. The graph for 
the function is displayed in a similar color to that of the curve.

Thickness Line thickness of the curve (unit: point)

Scaling This selection box allows the amplitude to be increased or decreased in 
steps. In this way, it is also possible to make curves more visible which 
only have a low amplitude or which are hidden by other curves.

Autoscale factor Factor resulting from the option Scale automatically.

Move factor Factor resulting from the option Move automatically.

Color Color of the curve

Points Activated: The motion blocks of the robot are displayed. Start and end 
are shown for each block.

Values Activated: The individual values which make up the curve are displayed 
as points.

RMS Activated: The RMS value is shown. Note: The RMS value refers to the 
phase of the recording represented in the oscilloscope.

In electrical engineering, the RMS value is the root-mean-square value 
of a signal that changes over time.

RMS = Root Mean Square

Stairs Activated: The curve runs horizontally on the X plane from one value 
until it reaches the Y value of the next value. From there it runs vertically 
up to this Y value.

Deactivated: The curve takes the shortest path from one value to the 
next.

Offset X axis Offsets this curve on the X axis by the specified value.

Offset Y axis Offsets this curve on the Y axis by the specified value.
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14.2.8 Panning and zooming the oscilloscope display

Procedure Panning:

1. Click in the display and hold down the mouse button.

2. Drag with the mouse. The display moves with the mouse. 

Zooming:

1. Click into the display.

2. Scroll with the mouse wheel. 

Scroll down: Zoom gets smaller. Scroll up: Zoom gets larger.

Enlarging a section:

1. Hold down the SHIFT key.

2. Click in the display and hold down the mouse button.

3. Move the mouse over the desired section. A gray rectangle is displayed. 
The size can be changed by moving the mouse. (The aspect ratio cannot 
be changed.)

4. Release the mouse button. The contents of the gray rectangle are dis-
played in enlarged form.

In this procedure, the aspect ratio of the selected section is adapted to the os-
cilloscope display:

1. Hold down the CTRL key.

2. Click in the display and hold down the mouse button.

3. Move the mouse over the desired section. A gray rectangle is displayed. 
The size and the aspect ratio can be changed by moving the mouse.

4. Release the mouse button. The contents of the gray rectangle are dis-
played in enlarged form.

Restoring the default view:

1. Right-click in the display.

2. Select Fit to view from the context menu.

14.2.9 Creating a screenshot of the oscilloscope display

Procedure Creating a screenshot in the clipboard:

1. Right-click in the display.

2. Select Copy screenshot from the context menu.

Creating and saving the screenshot:

1. Right-click in the display.

2. Select Save screenshot from the context menu. A window opens in which 
the target directory can be selected. The screenshot is saved there as a 
PNG file.

Min. The minimum value of the curve, with reference to the currently visible 
segment

Max. The maximum value of the curve, with reference to the currently visible 
segment

Column Description
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14.3 Recording network traffic

Description WorkVisual can record the communication data of the Ethernet-based inter-
faces of the robot controller, e.g. PROFINET, EtherCAT and EtherNet/IP. 

WorkVisual saves the recording in a PCAP file. The default directory is C:\Us-
er\Username\My Documents. The directory and file name may be changed.

PCAP files can be displayed using software for the analysis of network com-
munication connections (“sniffer” software). Sniffer software is not included in 
the scope of supply of WorkVisual.

Precondition  Network connection to the real robot controller

 The active project has been loaded from the real robot controller.

 The robot controller has been set as the active controller in WorkVisual.

Procedure 1. If desired: in the bus structure of the project, select the element whose in-
terface data are to be recorded. The interface is then automatically prese-
lected later.

2. Click on the Perform network capture... button. The Select the network 
interface window is opened. 

 (>>> Fig. 14-9 )

3. Select the desired interface, if not already preselected.

4. If required: select the filter criteria.

5. Click on Next >.

6. To start recording, click on Start.

A progress bar and a counter display the quantity of data recorded. The 
memory capacity is limited to 5 MB. If more data are recorded, the ring buf-
fer is activated, i.e. the oldest data is progressively discarded and replaced 
by the newest incoming data.

 As the memory fills for the first time, the progress bar grows to visual-
ize how full the memory is. 

 When the ring buffer is activated, the text Ring buffer active is dis-
played. A green light now moves along the progress bar.

7. To stop recording, click on Stop.

If required, recording can be started again via Restart. The existing data 
are then discarded.

8. To save the recording, click on Next > after stopping. The target directory 
and file name are displayed. The directory and file name may be changed.

9. Click on Next >. The recording is saved and the text Import successful 
is displayed.

10. Click on Close.

This functionality is only available for robot controllers with version 
8.3.
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Select the 

network interface

14.4 Displaying messages and system logs of the robot controller

Description The messages displayed in the message window on the smartHMI can also 
be displayed in WorkVisual. Messages generated by PROFINET or its field 
bus devices contain links in WorkVisual. These so-called “diagnostic links” 
guide the user to other areas of WorkVisual and help to trace the cause of the 
message.

In addition, the system logs of the robot controller can be displayed, i.e. the 
entries in the log memory. A search function and numerous filters are available 
here.

Precondition  Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

 Programming and diagnosis workspace

Procedure 1. In the Cell view window, select the desired robot controller by activating 
the check box. It is also possible to select more than one controller.

2. Select the menu sequence Editors > Log view. The Log view window 
opens. An entry is displayed for each robot controller selected. 

3. Click on an entry to expand it. The following tabs are now displayed:

 MessageLogs: Displays the messages of this robot controller.

Fig. 14-9: “Select the network interface” window

Box Description

Network interface Select the interface whose communication data 
are to be recorded. 

Ethertype Here the data to be recorded can be limited to a 
particular type. If no limit is desired, select All.

Protocol This box is only displayed if either IPv4 or IPv6 
is selected under Ethertype.

Here the data to be recorded can be limited to a 
particular protocol. If no limit is desired, select 
All.

MAC address The data to be recorded can be limited to a par-
ticular MAC address. If no limit is desired, leave 
the box blank.

This functionality is only available for robot controllers with version 
8.3.
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 (>>> 14.4.1 "MessageLogs tab" Page 164)

 SystemLogs: Displays the log entries of this robot controller.

 (>>> 14.4.2 "“SystemLogs” tab" Page 165)

14.4.1 MessageLogs tab

Diagnostic links Messages generated by PROFINET or its field bus devices contain links in 
WorkVisual. These so-called “diagnostic links” guide the user to other areas of 
WorkVisual and help to trace the cause of the message.

Fig. 14-10: Log view with “MessageLogs” tab

Item Description

1 Click here (or on any part of the gray area) to expand or collapse 
the entry.

The MessageLogs and SystemLogs tabs are visible when the 
entry is expanded.

2 Message counter

The message counter indicates how many messages of each mes-
sage type are active.

3 Information about the robot controller and the active project

While the connection to the robot controller is being established, a 
lamp flashes next to the name of the active project. It disappears 
when the connection is established.

4 Status of the lamp:

 Green: A connection has been established to the real robot 
controller.

 Red: The connection to the real robot controller is terminated.

5 The messages displayed in the message window on the smartHMI 
are displayed here.

 If a message is acknowledged in the message window, it is 
also acknowledged here in MessageLogs.

 If a message is acknowledged here in MessageLogs, it is not 
acknowledged in the message window!

Messages may contain diagnostic links.
Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



14 Diagnosis
For the links Online device diagnosis and Profinet device list, the following 
applies: 

 If the active project has not yet been loaded from the robot controller, this 
is now done automatically. This is preceded by a request for confirmation.

 If another project is open, this is closed. If it contains unsaved changes, a 
dialog is displayed, asking whether these changes should be saved.

14.4.2 “SystemLogs” tab

Diagnostic link Description

Diagnostic monitor The link opens the diagnostic monitor. The device from which 
the message comes is automatically selected in the module 
overview.

Online device diagnosis The link sets the device causing the error to “Connected”, 
opens the Diagnosis… window and displays the Device diag-
nosis tab.

Profinet device list The link sets the PROFINET node to “Connected”, opens the 
Device list and PROFINET names... window and displays the 
Available devices tab.

Information about the above-mentioned windows can be found in the 
documentation KR C4 PROFINET.

Fig. 14-11: SystemLogs

Item Description

1 Here the system logs can be searched for one or more search 
terms. Upper and lower case are ignored. The order in which the 
search terms are entered in the search box is irrelevant. It is not 
necessary to search for complete words.

Examples:

 tick syst also finds entries containing system tick.

 tick tick also finds entries in which tick occurs only once.

2 Filter: severity of the entry

To set or remove a filter, expand the selection box and activate or 
deactivate the check boxes.

3 Filter: origin of the entry

To set or remove a filter, expand the selection box and activate or 
deactivate the check boxes.
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14.5 Displaying diagnostic data about the robot controller

Description The diagnostic functionality makes it possible to display a wide range of diag-
nostic data concerning numerous software modules of a robot controller. The 
parameters displayed depend on the selected module. The display includes 
states, fault counters, message counters, etc.

Examples of modules:

 Kcp3 driver (= drive for the smartPAD) 

 Network driver

“Lamps” indicate the status of the parameters, etc.:

 Green: Status OK

 Yellow: Status critical, could be faulty

 Red: Error

Precondition  Network connection to the real robot controller

 The real robot controller and the KUKA smartHMI are running.

 Programming and diagnosis workspace

Procedure 1. In the Cell view window, select the desired robot controller by activating 
the check box. It is also possible to select more than one controller.

2. Select the menu sequence Editors > Diagnostic monitor. The Diagnos-
tic monitor window opens. 

3. An entry is displayed for each robot controller selected. Click on an entry 
to expand it. The following tabs are now displayed:

 Module view  (>>> 14.5.1 "“Module view” tab" Page 167)

 Signal diagram  (>>> 14.5.2 "“Signal diagram” tab" Page 169)

4. Select a module in the Module view. Diagnostic data are displayed for the 
selected module.

4  Display none: Removes all filters.

 Show all: Sets all filters.

This button has no effect on the search box.

5 System logs of the robot controller

Item Description
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14.5.1 “Module view” tab

Fig. 14-12: Module view

Item Description

1 Click here (or on any part of the gray area) to expand or collapse the entry.

The Module view and Signal diagram tabs are visible when the entry is expanded.

2 Information about the robot controller and the active project

While the connection to the robot controller is being established, a lamp flashes next to 
the name of the active project. It disappears when the connection is established.

3 This lamp indicates the status of the robot controller:

 Red: When the status of at least one module is red.

 Yellow: When the status of at least one module is yellow and no module is red.

 Green: When the status of all modules is green.

4 Exports the chronological series of values to a LOG file. The values are sorted by time 
stamp. The time stamps start from the time at which the Diagnostic monitor was 
opened.

5 Module overview. Lamps indicate the status of the modules:

 Red: When the status of at least one parameter is red.

 Yellow: When the status of at least one parameter is yellow and no parameter is red.

 Green: When the status of all parameters is green.

Note: If the display refers to a robot controller with System Software 8.2, the module 
overview is not structured hierarchically.
167 / 185Issued: 29.05.2015 Version: KST WorkVisual 4.0 V3



168 / 185

WorkVisual 4.0
Diagnostic data:

6 Graphical representation of the topology for the following bus topologies:

 Controller bus

 KUKA Operator Panel Interface

The lamp on a device is gray if the device is not connected to the real robot controller.

7 Diagnostic data about the selected module. Lamps indicate the status of the parameters:

 Red: If the value lies outside of the range defined in the red box in the Limit values 
column.

 Yellow: If the value lies outside of the range defined in the yellow box in the Limit 
values column.

 Green: If the value lies within the range defined in the yellow box in the Limit values 
column.

Item Description

Column Description

Name Diagnosed parameter

Value Current value of the diagnosed parameter

Extreme val-
ues

 Upper value: Maximum diagnosed value

 Lower value: Minimum diagnosed value

The extreme values refer to the time since the diagnosis window was opened, 
unless the user clicks on the Refresh button (= green double arrow): determi-
nation of the extreme values then starts again.

Unit If there is a unit associated with a parameter, this is displayed here. In some 
cases, the units can be changed (e.g. from seconds to milliseconds).

Limit values This column partly contains default values. The values can be changed/speci-
fied by the user.

Yellow box:

 Upper value: If this value is exceeded, the parameter is marked yellow.

 Lower value: If the current value falls below this value, the parameter is 
marked yellow.

Red box:

 Upper value: If this value is exceeded, the parameter is marked red.

 Lower value: If the current value falls below this value, the parameter is 
marked red.

Color Color of the curve on the Signal diagram tab
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14.5.2 “Signal diagram” tab

On the Signal diagram tab, the chronological sequence of values can be dis-
played graphically. Values to which a color has been assigned are displayed. 
If a different module is marked, the curves of the previous module are retained 
in the diagram. This makes it possible to compare graphs from different mod-
ules.

The Clear all button resets all color settings to Transparent and removes all 
curves from the diagram.

If the mouse pointer is moved over the diagram, the X and Y coordinates of 
the mouse pointer position are displayed. A context menu is available in the 
diagram, allowing the following actions:

 Adapting the size of the diagram so that the entire curve is displayed

 Creating a screenshot in the clipboard

 Saving the screenshot

 Opening the help function

The help function contains useful information about zooming and key-
board shortcuts.

14.5.3 Diagnostic data for the transfer application module

Fig. 14-13: Signal diagram

Name Description

Initialized  Yes: The transfer application is connected to all con-
nected field buses. Data exchange is taking place.

 No: No configured field bus device is present.

Number of transferred bits Number of bits configured

Cycle time of the transfer data 
[ms]

Current cycle time of the transfer application

Processor load [%] CPU load caused by the transfer application

Driver name Name of the driver

Bus name Name of the field bus
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14.6 Displaying online system information

Precondition  Programming and diagnosis workspace

Procedure 1. In the Cell view window, select the desired robot controller by activating 
the check box. It is also possible to select more than one controller.

2. Select the menu sequence Editors > System information editor. The 
Online system information window opens. An entry is displayed for each 
robot controller selected.

Description

Device properties window:

Bus status  OK: Status OK

 Error: The field bus has an error

Bus connected  Yes: The connection to the field bus is established

 No: No connection to the field bus

Name Description

Fig. 14-14: “Online system information” window

Column Description

Controller Info Information about the robot controller is displayed here.

Robot info Information about the robot is displayed here.

Controller sta-
tus

Shows the status of the Submit interpreter and robot 
interpreter and the operating mode.

The status displays correspond to the status displays 
on the KUKA smartHMI. Information about this can be 
found in the operating and programming instructions 
for the KUKA System Software (KSS).

Project Info Information about the active project is displayed here.

commando Edit: Opens the Device properties window.

Create archive: Opens the Generate archives win-
dow. (The data for this robot controller can be 
archived.)

Button Description

Archive all Create archive: Opens the Generate archives win-
dow. (The data for all robot controllers selected in the 
Cell view window can be archived.)
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Generate archives window:

Fig. 14-15: “Device properties” window

Item Description

1 The name of the robot controller can be changed here.

2 The name of the robot can be changed here.

3 A description can be entered here for information purposes. The 
description is displayed in the following places in the Project de-
ployment window:

 In the Information area

 During activation in the lower window with the progress bar

4 Activated: If OK is pressed, the RDC data are transferred to the 
RDC memory from D:\BackupAll.zip.

Fig. 14-16: “Generate archives” window

Item Description

1 The name of the robot controller is displayed here.

If the window was opened via the Archive all button, the window 
displays all the robot controllers that are selected in the Cell view 
window.

2 Activated: The log data are also archived.

Deactivated: The log data are not archived.

3 A target directory for the archive can be selected here.

A ZIP file is generated as an archive for each robot controller. The 
name of ZIP file always contains the name of the robot and the ro-
bot controller.
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15 KUKA Service

15.1 Requesting support

Introduction This documentation provides information on operation and operator control, 
and provides assistance with troubleshooting. For further assistance, please 
contact your local KUKA subsidiary.

Information The following information is required for processing a support request:

 Description of the problem, including information about the duration and 
frequency of the fault

 As comprehensive information as possible about the hardware and soft-
ware components of the overall system

The following list gives an indication of the information which is relevant in 
many cases:

 Model and serial number of the kinematic system, e.g. the manipulator

 Model and serial number of the controller

 Model and serial number of the energy supply system

 Designation and version of the system software

 Designations and versions of other software components or modifica-
tions

 Diagnostic package KrcDiag:

Additionally for KUKA Sunrise: Existing projects including applications

For versions of KUKA System Software older than V8: Archive of the 
software (KrcDiag is not yet available here.)

 Application used

 External axes used

15.2 KUKA Customer Support

Availability KUKA Customer Support is available in many countries. Please do not hesi-
tate to contact us if you have any questions.

Argentina Ruben Costantini S.A. (Agency)

Luis Angel Huergo 13 20

Parque Industrial

2400 San Francisco (CBA)

Argentina

Tel. +54 3564 421033

Fax +54 3564 428877

ventas@costantini-sa.com

Australia KUKA Robotics Australia Pty Ltd

45 Fennell Street

Port Melbourne VIC 3207

Australia

Tel. +61 3 9939 9656

info@kuka-robotics.com.au

www.kuka-robotics.com.au

 

A

 

v
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Belgium KUKA Automatisering + Robots N.V.

Centrum Zuid 1031

3530 Houthalen

Belgium

Tel. +32 11 516160

Fax +32 11 526794

info@kuka.be

www.kuka.be

Brazil KUKA Roboter do Brasil Ltda.

Travessa Claudio Armando, nº 171

Bloco 5 - Galpões 51/52

Bairro Assunção

CEP 09861-7630 São Bernardo do Campo - SP

Brazil

Tel. +55 11 4942-8299

Fax +55 11 2201-7883

info@kuka-roboter.com.br

www.kuka-roboter.com.br

Chile Robotec S.A. (Agency)

Santiago de Chile

Chile

Tel. +56 2 331-5951

Fax +56 2 331-5952

robotec@robotec.cl

www.robotec.cl

China KUKA Robotics China Co., Ltd.

No. 889 Kungang Road

Xiaokunshan Town

Songjiang District

201614 Shanghai

P. R. China

Tel. +86 21 5707 2688

Fax +86 21 5707 2603

info@kuka-robotics.cn

www.kuka-robotics.com

Germany KUKA Roboter GmbH

Zugspitzstr. 140

86165 Augsburg

Germany

Tel. +49 821 797-4000

Fax +49 821 797-1616

info@kuka-roboter.de

www.kuka-roboter.de
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France KUKA Automatisme + Robotique SAS

Techvallée

6, Avenue du Parc

91140 Villebon S/Yvette

France

Tel. +33 1 6931660-0

Fax +33 1 6931660-1

commercial@kuka.fr

www.kuka.fr

India KUKA Robotics India Pvt. Ltd.

Office Number-7, German Centre,

Level 12, Building No. - 9B

DLF Cyber City Phase III

122 002 Gurgaon

Haryana

India

Tel. +91 124 4635774

Fax +91 124 4635773

info@kuka.in

www.kuka.in

Italy KUKA Roboter Italia S.p.A.

Via Pavia 9/a - int.6

10098 Rivoli (TO)

Italy

Tel. +39 011 959-5013

Fax +39 011 959-5141

kuka@kuka.it

www.kuka.it

Japan KUKA Robotics Japan K.K.

YBP Technical Center

134 Godo-cho, Hodogaya-ku

Yokohama, Kanagawa

240 0005

Japan

Tel. +81 45 744 7691

Fax +81 45 744 7696

info@kuka.co.jp

Canada KUKA Robotics Canada Ltd.

6710 Maritz Drive - Unit 4

Mississauga

L5W 0A1 

Ontario

Canada

Tel. +1 905 670-8600

Fax +1 905 670-8604

info@kukarobotics.com

www.kuka-robotics.com/canada
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Korea KUKA Robotics Korea Co. Ltd.

RIT Center 306, Gyeonggi Technopark

1271-11 Sa 3-dong, Sangnok-gu

Ansan City, Gyeonggi Do

426-901

Korea

Tel. +82 31 501-1451

Fax +82 31 501-1461

info@kukakorea.com

Malaysia KUKA Robot Automation (M) Sdn Bhd

South East Asia Regional Office

No. 7, Jalan TPP 6/6

Taman Perindustrian Puchong

47100 Puchong

Selangor

Malaysia

Tel. +60 (03) 8063-1792

Fax +60 (03) 8060-7386

info@kuka.com.my

Mexico KUKA de México S. de R.L. de C.V.

Progreso #8

Col. Centro Industrial Puente de Vigas

Tlalnepantla de Baz

54020 Estado de México

Mexico

Tel. +52 55 5203-8407

Fax +52 55 5203-8148

info@kuka.com.mx

www.kuka-robotics.com/mexico

Norway KUKA Sveiseanlegg + Roboter

Sentrumsvegen 5

2867 Hov

Norway

Tel. +47 61 18 91 30

Fax +47 61 18 62 00

info@kuka.no

Austria KUKA Roboter CEE GmbH

Gruberstraße 2-4

4020 Linz

Austria

Tel. +43 7 32 78 47 52

Fax +43 7 32 79 38 80

office@kuka-roboter.at

www.kuka.at
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Poland KUKA Roboter Austria GmbH

Spółka z ograniczoną odpowiedzialnością

Oddział w Polsce

Ul. Porcelanowa 10

40-246 Katowice

Poland

Tel. +48 327 30 32 13 or -14

Fax +48 327 30 32 26

ServicePL@kuka-roboter.de

Portugal KUKA Sistemas de Automatización S.A.

Rua do Alto da Guerra n° 50

Armazém 04

2910 011 Setúbal

Portugal

Tel. +351 265 729780

Fax +351 265 729782

kuka@mail.telepac.pt

Russia KUKA Robotics RUS

Werbnaja ul. 8A

107143 Moskau

Russia

Tel. +7 495 781-31-20

Fax +7 495 781-31-19

info@kuka-robotics.ru

www.kuka-robotics.ru

Sweden KUKA Svetsanläggningar + Robotar AB

A. Odhners gata 15

421 30 Västra Frölunda

Sweden

Tel. +46 31 7266-200

Fax +46 31 7266-201

info@kuka.se

Switzerland KUKA Roboter Schweiz AG

Industriestr. 9

5432 Neuenhof

Switzerland

Tel. +41 44 74490-90

Fax +41 44 74490-91

info@kuka-roboter.ch

www.kuka-roboter.ch
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Spain KUKA Robots IBÉRICA, S.A.

Pol. Industrial

Torrent de la Pastera

Carrer del Bages s/n

08800 Vilanova i la Geltrú (Barcelona)

Spain

Tel. +34 93 8142-353

Fax +34 93 8142-950

Comercial@kuka-e.com

www.kuka-e.com

South Africa Jendamark Automation LTD (Agency)

76a York Road

North End

6000 Port Elizabeth

South Africa

Tel. +27 41 391 4700

Fax +27 41 373 3869

www.jendamark.co.za

Taiwan KUKA Robot Automation Taiwan Co., Ltd.

No. 249 Pujong Road

Jungli City, Taoyuan County 320

Taiwan, R. O. C.

Tel. +886 3 4331988

Fax +886 3 4331948

info@kuka.com.tw

www.kuka.com.tw

Thailand KUKA Robot Automation (M)SdnBhd

Thailand Office

c/o Maccall System Co. Ltd.

49/9-10 Soi Kingkaew 30 Kingkaew Road

Tt. Rachatheva, A. Bangpli

Samutprakarn

10540 Thailand

Tel. +66 2 7502737

Fax +66 2 6612355

atika@ji-net.com

www.kuka-roboter.de

Czech Republic KUKA Roboter Austria GmbH

Organisation Tschechien und Slowakei

Sezemická 2757/2

193 00 Praha

Horní Počernice

Czech Republic

Tel. +420 22 62 12 27 2

Fax +420 22 62 12 27 0

support@kuka.cz
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Hungary KUKA Robotics Hungaria Kft.

Fö út 140

2335 Taksony

Hungary

Tel. +36 24 501609

Fax +36 24 477031

info@kuka-robotics.hu

USA KUKA Robotics Corporation

51870 Shelby Parkway

Shelby Township

48315-1787 

Michigan

USA

Tel. +1 866 873-5852

Fax +1 866 329-5852

info@kukarobotics.com

www.kukarobotics.com

UK KUKA Robotics UK Ltd

Great Western Street

Wednesbury West Midlands

WS10 7LL

UK

Tel. +44 121 505 9970

Fax +44 121 505 6589

service@kuka-robotics.co.uk

www.kuka-robotics.co.uk
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Index

Symbols
$US2_VOLTAGE_ON 65
$USER_SAF 102

A
Adding, devices from option package 57
Additional editors 61
Air conditioner, option 37
Anchor cross 20, 21
Anchor points 20
Auto-complete 118

B
BASE coordinate systems 49
BASE coordinate systems, changing the number 
39
BASE coordinate systems, editing 47
Brake test, forcing 39
Braking mode settings 37
Bus I/Os, mapping 81
Bus Scan 75
Button bar 23
Button bar, KRC Explorer 127
Button bars 19
Buttons, displaying/hiding 23

C
Catalog Scan 32
Catalog, adding 33
Catalog, inserting 33
Catalog, removing 33
Catalogs (window) 20
Cell configuration (window) 27
Cell definition, configuring 53
Cell definition, opening 53
Cells, editing 54
Changes, loading 130
Changes, transferring 129
Changing, language 60
CK 10
Close, project 31
Close, WorkVisual 31
Code generation 137
Communication parameters, safety-relevant 63
Comparison, safety configuration 71
Configuration, devices 75
Configuration, field bus master 74
Configuration, KRC Explorer 128
Configuring keyboard shortcuts 60
Configuring, KRL Editor 116
Controller bus 91
Copy, project 31

D
Data format 78
Debugging 131
Debugging mode 131
Debugging mode, ending 135

Debugging mode, overview 132
Debugging mode, starting 133
Defining cells online 53
Devices from option package, adding 57
Devices, configuration 75
Devices, inserting into bus 74, 75
Diagnosis 149
Displaying/hiding windows 20
DTM 10

E
Editing, long texts 89
EDS file 32
Element, inserting 34
Element, removing 35
Export, bus configuration 87
Export, long texts 90
Export, safety configuration (SCG) 68
Export, safety configuration (XML) 70
Export, subproject 59
Exporting, trace configuration 151
External axes 41

F
Fast entry, KRL 119
Fast Measurement inputs, option 37
Field bus master, add 74
Field bus master, configuration 74
Field bus, set-up 73
Files, comparing 131
Filtering, signals 82
Finding a declaration, variable 120
Finding uses, variable 120
Firmware version 36
Folds, KRL Editor 119
FSoE address 97, 102
FSoE slave address 97, 102

G
Graphical user interface 19
Graphical user interface, overview 19
Graphics card 15
Grouping, signals 86

H
Hardware, inserting 40
Help 19

I
I/O Mapping (window) 81, 82
ID, project 31
Import, device description files 31
Import, long texts 89
Import, safety configuration (SCG) 68
Importing, trace configuration 151
Importing, trace recording 157
Inserting, external axis 41
Inserting, robot 36
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Insertion, devices into bus 74, 75
Installation 15
Installation, WorkVisual 15
Intel, data format 78
Intended use 12
Introduction 9
IP addresses 74, 75

K
KCP 10
Keyboard shortcuts 60
Kinematic system, exporting 47
Kinematic systems, comparing 45
KLI 10
KRC Explorer, button bar 127
KRC Explorer, configuring 128
KRC Explorer, creating a file 129
KRC Explorer, edit functions 128
KRC Explorer, icons 127
KRL 10
KRL Editor 114
KRL Editor, configuring 116
KRL Editor, opening 114
KRL Editor, user interface 115
KRL Editor, zooming 116
KSI 10
KSS 10
KUKA Customer Support 173
KUKA smartHMI 10
KUKA smartPAD 10
KUKA.OptionPackageEditor 59

L
Language, changing 60
Language, user interface 16
Licenses 10
Loading, project 144
Long texts 89

M
Machine data, editing 42, 43
Machine data, parameters 45
Mapping, inputs/outputs 83
Measurement data, copying 52
Measurement data, pasting 52
Menu bar 19
Messages (window) 20, 26
Motion master 109
Motorola, data format 78
Multiprog 15, 82

N
Network traffic, recording 162
Number of I/Os 36

O
Object, exporting 51
Object, importing 52
Objects 49
Objects, repositioning 28
Open source 10

Operation 29
Operator safety acknowledgement 64, 65
OPS 10
Option packages 54
OptionPackageEditor 59
Oscilloscope 150
Overview, graphical user interface 19

P
Parameter display 45
Peripheral contactor 64, 65
Pinning 137
Printing, I/O connections 61
Printing, long texts 61
Printing, safety configuration 61
Processor 15
PROCONOS, inserting 39
Product description 11
Programming 113
Programs, debugging 131
Project analysis 20
Project Explorer 29
Project information, saving 30
Project structure (window) 19, 26
Project, new 30
Project, open 29
Project, saving 31
Project, transferring to the robot controller 140
Properties (window) 20

Q
Quickfix 120

R
RAM 15
Renaming, variable 118
Replacing, in files 114
Required knowledge and skills 9
Restoring, state 130
Retrofit 37
Robot controller, inserting 35
RoboTeam 105

S
Safety 13
Safety configuration 63
Safety configuration, components 63
Safety configuration, import (XML) 68
Safety configuration, local 63
Safety configuration, resetting 71
Safety instructions 9
Safety option, inserting 39
Safety options 10
Scan, bus 75
Searching, in files 114
Searching, signals 86
Semaphore master 111
Semaphores, RoboTeam 111
Service, KUKA Roboter 173
Setting to active, robot controller 35
Setting to inactive, robot controller 35
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smartHMI 10
smartPAD 10
Snippets 119
Snippets, user-specific 122
Standstill monitoring 66
Starting, WorkVisual 29
Subproject 59
Support request 173
System requirements, PC 15
System requirements, robot controller 15
System requirements, software 15

T
Target group 9
Template, for project 30
Template, for RoboTeam 105
Terms used 10
Time master 108
TOOL coordinate systems 49
TOOL coordinate systems, changing the number 
39
TOOL coordinate systems, editing 47
Tool/base management, configuring 48
Tool/base management, opening 47
Trace 150
Trace, configuration 150
Trace, displaying data 158
Trace, starting 150
Trace, state 153
Trademarks 9
Training 9
Transfer application, diagnostic data 169
Transfer application, setting the cycle time 38
Transformer, option 37

U
Uninstallation, WorkVisual 17
US2 65
User interface language 16
User interface, KRL Editor 115

V
Variable, finding a declaration 120
Variable, finding uses 120
Variable, renaming 118
Variables, monitoring 134
View (menu item) 22

W
Wagon driver 96
Warnings 9
Windows, displaying/hiding 20
Windows, repositioning 20
Working directory 126
Working directory, opening 126
Working online 125
Workspace Selection (window) 20, 22
WVPS 59
WVS 31

X
XML export 70
XML import 68

Z
Zooming, KRL Editor 116
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